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FDOT Roadway Design and 3D Modeling

Basic Training

CE-11-0138

Description

This is a 2-day training course to include Chapters 1, 2, 3, 4, 6, and 7 of the course guide. Participants will be
introduced to Bentley GEOPAK V8i SELECT Series4 (SS4) OpenRoads Technology tools for design and
modeling; specifically for Florida Department of Transportation (FDOT) projects using the FDOTSS4
Workspace. Several new technologies will be introduced including:

Terrain Elements, Terrain Tools, and Sub-Surface Terrain Modeling
Civil Elements, Civil Features, and Civil Geometry

Design Intent and Design Standards

Civil AccuDraw and Civil Cells

Project Explorer: Civil Model

Profile and Cross Section View Models

Task Menus and Cursor Context Menus

Objectives

o Create a Terrain Element from the existing surface to be used as a reference for the project.

o Develop Existing Feature Terrain Surfaces to be shown on cross sections and used in earthwork
calculations.

o Use Civil Geometry Elements in the design file to calculate and define a proposed centerline of
construction.

e Use Civil Geometry Elements in the design file to define the roadway features of the proposed
design.

o Apply Civil Cells delivered within the FDOTSS4 Civil Cell DGN library.

e Use Civil Geometry Elements in the design file to define the vertical profiles of a proposed
centerline.

e Create 3D Models of the existing and proposed Roadways.

e Add 2D Civil Geometry Elements as references to a Corridor Model for use as design model control
lines.

e View Dynamic Cross Sections for review, updates, and design checks along the project.

Audience
e FDOT Roadway Designers and Engineers

Prerequisites

Participants need to have a basic understanding of Computer Aided Drafting and Design (CADD) using
MicroStation, a basic understanding of GEOPAK concepts and a solid understanding of the engineering
necessary to design a Roadway.

Duration: 16 Hours
Professional Credit Hours: 16 PDHs







FDOT Roadway Design and 3D Modeling

Advanced Training

CE-11-0139

Description

This is a 2-day training course to include Chapters 8, 9, and 10 of the course guide. Participants will
continue to learn the Bentley GEOPAK V8i SELECT Series4 (SS4) OpenRoads Technology tools for design
and modeling within the FDOTSS4 workspace. Several advanced concepts and technologies will be introduced

including:
¢ Rule Based Superelevation Design Parameters
e Associating Template Points to Superelevation Lanes
e  Constructing 3D Elements
e Building Intersection Terrains from 3D Elements
o  Appling a Surface Depth to Terrain Elements

Placing 3D Civil Cells

e Configuring Advanced 2D and 3D Civil Cells

e Corridor and Terrain Model Clipping

e  Applying Linear Templates to 3D Elements

e Building DTM, XML Files for Construction Deliverables

Objectives
o Create a Superelevation Shape Model.
o Create Superelevation Sections and Lanes.
e Calculate and Assign Superelevation to a Corridor.
e Create an Intersection Terrain Model from 3D Elements.
e Create a Traffic Separator Nose Model on the Corridor Model.
e Create an Island Model on an Intersection.
e  Apply Linear Corridors along 3D Elements.
e Create 3D Driveway on a Corridor Model.
e Create 3D Sidewalk Ramps on Intersection Model.
e  Prepare the Files Necessary for Construction Deliverables.
Audience

o FDOT Roadway Designers and Engineers

Prerequisites

Participants need to have a basic understanding of Computer Aided Drafting and Design (CADD) using
MicroStation, a basic understanding of GEOPAK concepts and a solid understanding of the engineering
necessary to design a Roadway.

In addition to the above, the participant is required to complete:
FDOT Roadway Design and 3D Modeling - Basic Training.
Duration: 16 Hours
Professional Credit Hours: 16 PDHs







FDOT Roadway Design and 3D Modeling

Advanced Template Design Training

CE-11-0140

Description

This is a 1-day training course to include Chapters 5 of the course guide. Participants will learn basic
and advanced knowledge of the Create Template dialog within Bentley GEOPAK V8i SELECT Series4
(SS4) environment for design and modeling within the FDOTSS4 workspace. Most all of the Create Template
dialog capabilities are included as follows:

e Template Library Basics e Point and Component Properties

e Creating New Libraries, Folders and Templates e Constraint Types/ Labels

e Current Template Window e Horizontal Feature Constraints

e Template Preview Window e End Conditions/ Targets/ Priorities

e Current/Active Template Tab e Display Rules

e Dynamic Settings e Testing Window

e Create /Modify/ Delete Components, Points, etc. e Point Name and Component Name Overrides
Objectives

e Create a New Project Template Library and Project Folders.

Use Template Library Organizer to build Project Templates.

Build a Resurfacing Template from Basic Components.

Learn to Use the Variable Median PPM Templates.

Configure Templates for Superelevation.

Add and Test End Conditions.

Build a Special Condition Component Sets for Displaying Walls, Guard Rails, Sidewalks, etc.
Build a Special Condition Component Sets for Displaying Special Ditches with Variable Width and
Constant Slopes.

Adding Special Condition Component Sets to a Template.

e  Practice Building Project Templates from Sample Project Typical Sections

Audience
e FDOT Roadway Designers and Engineers

Prerequisites

Participants have a basic understanding of Computer Aided Drafting and Design (CADD) using MicroStation, a
basic understanding of GEOPAK concepts and a solid understanding of the engineering necessary to design a
Roadway.

In addition to the above, the participant is required to complete:
FDOT Roadway Design and 3D Modeling - Basic Training.
Duration: 8 Hours

Professional Credit Hours: 8 PDHs
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INTRODUCTION

This course was developed to introduce Roadway Designers to the VV8i SELECTSeries4 (SS4) OpenRoads
Technology tools for design and modeling on Florida Department of Transportation (FDOT) projects. The
curriculum was developed within the FDOTSS4 Workspace to provide sample exercises for most of the new
Civil Tools on a sample project data set.

COURSE OBJECTIVES

Participants of this course will be introduced to the newest OpenRoads Technology and a Workflow for
designing two dimensional (2D) Plans, Profiles, Cross Sections and three dimensional (3D) Models for
Construction Deliverables. At successful completion they will have learned how to:

Create a Terrain Element from the existing surface to be used as a reference for the project.
Develop Existing Feature Terrain Surfaces to be shown on cross sections and used in earthwork calculations.

Use Civil Geometry Elements in the design file to calculate and define a proposed centerline of construction
and while using the built in Design Standards Criteria checking.

Use Civil Geometry Elements in the design file to define the roadway features of the proposed design.
Apply Civil Cells delivered within the FDOTSS4 Civil Cell DGN library.

Use Civil Geometry Elements in the design file to define the vertical profiles of a proposed centerline.
Use the Standard Components and Templates within the FDOTSS4 Template library.

Create a 3D Model of the existing and proposed Roadways.

Reference 2D Civil Geometry Elements to a Corridor Model by adding the elements for use as designh model
control lines.

Apply varying Typical Section conditions along the project, including: variable medians, special ditches,
handrail checks, gravity wall placement, slope conditions, left and right turns, etc.

Define the Superelevation Standards along a corridor.

View Dynamic Cross Sections for review, updates, and design checks along the project before cross sections
are created for printing.

Create and display 3D Models for better designing and visualization.
Use the Milling Overbuild and Overlay Components on a project corridor.

Apply Corridor Modeling Techniques used for developing driveways and intersection, etc.
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EXPECTATIONS — WHAT THIS COURSE PROVIDES

This course provides a standard workflow for designing a project with Bentley Systems GEOPAK OpenRoads
Technology within the FDOTSS4 Workspace. Although the majority of tools are used throughout, this course
does not provide a description of every Bentley Systems GEOPAK OpenRoads Technology Civil Tool.
Integrated help for each of the tools can be found by selecting from the Main Menu in MicroStation: GEOPAK
> ROAD > Help.

GEOPAK | Window Subsurface Ltility Engineering  Help ~,'

BOAD k| ROAD Tools

LeanE ' Project Manager

DRAINAGE 3

LAMDSCAPE » Active Chain Control

WATER SEWER p| Bement Atributes
3PC AdHoc Aftribute Manager

Training

_ User Preferences

Activate Map Geometry N
Design & Computation Manager
CQuantity Manager
Plans Preparation ]
DTM Tools
30 Tools »
Cross Sections »
Lkilties b
Help

r@ Civil Help
= & B

Hide Back Prmt Options

Contents | Index | Search | Favorites|

<[] Bentley Road

[+-48 Getting Started g ‘Ben".eg

(-4 Introduction to GEOPAK
2] Setting Element Symbology
[+ 4% Command Referance

{23 Civil Tools Civil Tools Help
=1 Civil Tools
a Bentley Civil Powered by OpenRoads Technology Help update: February 2013
B} Civil Tools This help provides reference information on Bentley Civil Tools. The following main topic areas are provided:

a On-Screen Prompts

% Manipulators and Handlers
- [£] Civil Settings
% Design File Settings
% Workspace Preferences
- 2] Feature Defintions
- [£] Customizing Dialogs
- [2] Civil Message Center
5] Civil Variables
(I Project Explorer
(23 MX Supplement
(1] Glossary
118 Civil Temsin Modeling
-8 Civil Geometry
[H-(Z Civil GPS
-3 Survey
[-(Z7)] Comidor Modeling
=
E
=

(23 Civil Cells
(2] Civil Analysis and Reparts
122 Civil AccuDraw

Bentley Civil Powered by OpenRoads Technology
Analysis & Reporting

Geometry

Terrain Modeling

Corridor Modeling

Civil Cells

Survey
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DOCUMENT STYLE

Style conventions used throughout the course guide are shown in the following table.

Item Convention Example
Menu names Bold N e File>Open
and (Names separated i i
commands N p e File > ComSelect > Design
with > symbol)
Dialog box Bold e  Click the Apply button.
Actions .
e  Click the Graphic Select button to the right
of the Horizontal Alignment Include box.
e Inthe Segment Type list, click Lines.
Dialog box Italic e Keyin Hemfield Road in the Alignment
Field Names Name field.
e  Click the Graphic Select button to the right
of the Horizontal Alignment Include field.
e Inthe Segment Type list, click Lines.
Key-ins Bold e Keyin Hemfield Road in the Alignment
Name field.
File Names Italic e  Open the file Working Graphics.dgn in the
C:\Bentley Training\GEOPAK 101\Project
Setup\Practice\ folder.
File Paths Non italic e Open the file Working Graphics.dgn in the
C:\Bentley Training\GEOPAK 101\Project
Setup\Practice\ folder.
New Terms Italic e The Template Library contains templates,
or Emphasis which represent typical sections of the

proposed roadway.

FDOT Roadway Design and 3D Modeling
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FILE TYPES

The Bentley Systems GEOPAK OpenRoads Technology road design process now uses a single source file
type, the DGN file. All pertinent design data is stored in the design file. This information can be viewed through
the Project Explorer and reported on in the Civil Report Browser.

Below is a brief description of the legacy file types used in GEOPAK which can be imported or exported (i/0)
with OpenRoads Technology.

File Type Description

e Surface.tin (i/o) - A binary file, also known as a GEOPAK digital terrain model (DTM),that stores features
made up of random points, break lines, and boundary data along with triangulated surface model. The features
and the triangles together represent an existing ground surface.

e Surface.dat (i) - A binary (or ASCII) file containing string and point information that is used for digital terrain
model construction.

e Surface.dtm (i/0) — A binary file, also known as a Roadway Designer digital terrain model that stores features
made up of components, break lines, and boundary data along with triangulated surface model. The features
and the triangles together represent either existing ground surface or the proposed roadway corridor model.

o  Geometry Project.gpk (i/0) - A binary file (job###.gpk) created when starting a coordinate geometry (COGO)
session for the first time or created through Project Manager, that stores geometric data including points,
lines, curves, spirals, parcels, chains, and profiles. The file may be appended to during the design process.
Multiple users can access this file at the same time. Only one file should be created for each project. The
"###" is the only variable in this filename. It represents a job number (1 to 3 alphanumeric characters) unique
to a project and is user defined upon creation.

e CMJobxx.alg (i) — A binary file containing the imported Chain, Profiles, and MicroStation Plan Elements
necessary on a project in the Select Series 2 Version of GEOPAK Corridor Modeling.

o Template Library.itl (i) - Stores templates and template components. Different components can be assembled
to build templates, which define the typical sections of a roadway. Only one Template Library file may be
open for editing at a given time.

e Project.rdp — Stores the corridor modeling preferences imported geometry, DTM, and plan graphics in the
Select Series 2 Version of GEOPAK Corridor Modeling. This file is not used or imported in the Select Series
3 release.

e Project.ird (i) — Stores Corridor Definitions including; Limits, Template Drops, Parametric Constraints,
Superelevation, Point Controls, Key Stations, Etc. in the Select Series 2 Version of GEOPAK Corridor
Modeling. This file can be imported in the Select Series 3 release.
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LEARNING RESOURCES

There are several resources available for learning about the various Bentley Systems GEOPAK OpenRoads
Technology tools. Among them are:

e Bentley Communities:

http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-
technotes-fags.aspx

e Bentley Learn:

Bentley Institute site is for registered user and may require a Select Server site license to participate:
https://learn.bentley.com

e Bentley Product OpenRoads:
Videos are available on a variety of topics: https://www.Bentley.com
e YouTube:

Bentley OpenRoads Videos are available on a variety of topics:

http://www.youtube.com/user/BentleyCivil

e YouTube Search - Google:

Bentley OpenRoads returns several sites with videos for learning how to apply the technology on
project specific situations.

e Production Support Office | CADD (CADD) Website: http://www.fdot.gov/cadd/
Webinar training recordings are available on many of the subjects covered in this manual:
http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm

http://www.fdot.qov/cadd/downloads/webinars/Posted.shtm#loadSection
https://www.youtube.com/channel/UCgbY8kgZuXplpyYV6IIQw A

COURSE SUPPORTING FILES

The exercises for each chapter are independent of one another and can be used without having to complete the
exercises in previous modules. The exercise files are organized into separate comSelected zip files for each
chapter. All files used in this course are located also at this link:

http://www.fdot.gov/cadd/downloads/documentation/FDOTRDANd3DM/FDOTRDANd3DM.shtm
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http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
https://learn.bentley.com/
http://www.bentley.com/
http://www.youtube.com/user/BentleyCivil
http://www.fdot.gov/cadd/
http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm
http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection
https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A
http://www.fdot.gov/cadd/downloads/documentation/FDOTRDAnd3DM/FDOTRDAnd3DM.shtm

INTRODUCING A NEW WORKSPACE

Vi

FDOTSS4 PREDEFINED SETTINGS

DESIGN FILE SETTINGS:

Export Settings L
I Export To Native  Use Feature 7]

Coordinate Settings ~

Format XY
Precision 0.1234

Ratio Settings (Distance:Offset) A

Fotmat 1D
Precision 0.1234

Station Settings

Format ss+ss
Format Delimiter +
Precision 0.1234
Equation By Name

Radius Settings

Degree Of Curve Method Arc
Degree Of Curve Length  100.000000
Radius Toggle Char d

Profile Settings

Elevation Precision 0.1234
Slope Format Percentage
Slope Precision 0.1234
Ratio Format Run:Rise
Ratio Precision 0.1234
Vertical Curve Parameter Kvalue

Focus kem Description

Select category to view.
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EDOTSS4 WORKSPACE PREFERENCES:

Category Mame for preferences | Default Preferences
Databasze
Descartes Subsurface Utilities
Input

Look and Feel Manipulator Settings
Mouse Wheel
Operation Manipulator Size 10 Cancel

Pasition Mapping Mormal Colar [] [255.255.128]

Raster Manager Read-Only Color I:l [211.211.211] Defaults
Reference Selected In Property Pi[_] [255.255.255]

Spelling Selected Color [ [255.165.00

Tags Manipulator Faont Anial

Task Navigation Mampulator Font Scale 1

Tedt Manipulator Transpare 30

View Options - Civil Use Shaded Manipulat True
Wiew Options

Superelevation Settings
Fill Color Shaded Rl

Survey Locator
Maximum Errar Ellipse
Medium Error Ellipse

Minimum Error Ellipse

Focug tem Description

FDOTSS4 KEYBOARD SHORTCUTS

These will open the Civil Tasks on your cursor as shown below.

&~ Analysis & Beporting  Cii+Shift+A
&~ General Geometry Ctrl+5Shift+G
2+ Horzontal Geoometry  Cirl+Shift+J
&= Vertical Geometny Ctrl+5Shift -+
#~  Temain Model Ctr+Shift+T
»=  Comdor Modeling Ctrl+Shift-+M
&= Civil Cells Ctr+Shift+C
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EDOTSS4 FUNCTION KEYS

viii

F1

F2

F3

F4

F5

F6

F7

F8

F9

Opens the Civil Help. Ctrl+F1 Closes all Views except View 1

Open View 1 (2D Plan) and View 2 (3D Isometric) and fits both views.

Opens View 3 (2D Plan), closes all View 4, and arranges all Views.

Open View 1 (2D Plan) , View 2 (3D Isometric), View 1 (2D Plan), View 1 (2D Plan) & Fits All views
Toggles Dim References ON/OFF

Resets out of any ongoing commands.

Toggles the Construction view attribute off and on.

Toggles between MicroStation AccuDraw and Civil AccuDraw.

With 3D Model view active, Toggles Off 3D proposed model shapes and bottom lines.

F10 With 3D Model view active, Toggles On 3D proposed model shapes.

F11 Toggles (opens or closes) the Project Explorer dialog.

F12 Opens the Create Template dialog.

"Function Keys:
File
Function Keys
Cod [CA [] Shift

Key: F1
Action: | expand keyin %% "$(MS_HELPLOAD_SERVER)Civi_Tools_S54.chm”

Action:

expand keyin %3 "$(MS_HELPLOAD_SERVER)Civil_Tools_554 chm"
vba run [ViewSet] Module 1. TwoView3D

view an 3; view off 4; window amange

vba run [ViewSet] Module 1. FourView

vha mun [ViewSet] Module1_SetActive Maodel To Draw Last

choose none

vha mun [ViewSet] Module 1. ToggleViewConstnuctions;

vba run [Acculraw] Toggle. TogagleOnOff

level set display off "_mx" level set display off "bottom_pm™ level set display off "
level set display on " _px”

dialog project toggle

comdar templatelibrary open

vha mun [View5et] Module1. Bxaggerate £ Forfttachment
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e Function Key F1 — Civil Help

' ™
[ Civil Tools Vai SELECTseries 4 e[ )

S S /5 B B

Hide Back Forward Home Prirnt  QOptions

Contents I Index I Search I Favor'[tesl

T} Bentley Civil Powered by OpenRoads Tec!
|£] New and Revised in Civil Products Vi
@ Civil Waorkspace

= |Bentley

Getting Started .
B ot ares Bentley Civil Powered by OpenRoads
[£] Feature Definitions
@ Customizing Dialogs TEChﬂD|Ogy
[C3 Project Explorer Help last updated: July 06, 2015
2 Temain Model
R Civil Geometry OpenRoads is the common technology for Bentley Systems civil products
R Civil GPS that has been developed in partnership with our users who are the world's
“ S"'r‘fe“' T°°|59? leaders in transportation design, build, operate, maintain, and rehabilitation |z
@ Comidor Modeling R -
R Model Interoperability projects.
2 Civil Cells
@ Civil Analysis and Reporting OpenRoads combines data acquisition/survey, geometry corridor, terrain
] Glossary madeling, dynamic sections, and much more to create an immersive
interaction of features within a common footprint. OpenRoads technology
provides a shared workspace among our civil engineering design products
GEOPAEK, InRoads, MXROAD, and Power Civil for "Country™.
New and Revised in Civil Products V8i (SELECTseries 4)
Civil Workspace
Getting Started '
Civil Settings
Feature Definitions
1 LLJ ¢ Customizing Dialogs i
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Function Key F2 — Open and Fits Two Views Setup; View 1- 2D Plan, View 2-Isometric

B Viewl, Default — [ @] | ® View?, Default-30 =
= A ] B-oE-|ARQRNEHPO|PEE|HTRE

NEHY O DL FRE

Function Key F3 — Opens View 3; Closes View 4 and Arranges Views

5 Viewl, Default F=-|F=-][&Esa] | = View2 Default-3D o [ ][=
=R ARRREHG I DS RG FB-LE-ARRREHY O VLS 7EE

B View 3, Profile - CL2
G- AQHHEBE OB H -
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e Function Key F4 — Opens and fits Four View Setup; View 1- 2D Plan, View 2-Isometric, View 3,4 - custom

B View 1, Default = = £ u View 2, Default-3D = =] 2
BraE-ARRRBEIO OEHEE Broé- AR RERO|WRE|H 7 L6

B View 4, Cross Section - Complex Element: SR61Copy [E=nE=R ===
View Properties [v| |« = 2+00.00

e Function Key F5 — Toggle Dim References

FDOT Roadway Design and 3D Modeling ©2016 FDOT Xi



e Function Key F7 — Toggles On/Off Construction View Attributes

——

e Function Key F8 — Toggles Between MicroStation AccuDraw and Civil AccuDraw

i}

p
e
X | 2007504 601263

Y | 405759.814444

Xii ©2016 FDOT FDOT Roadway Design and 3D Modeling



e Function Key F10 — With 3D Model View Active, Toggles On 3D Shapes.

e Function Key F11 Toggles Project Explorer Dialog Open/Close.

' ™
% Project Explorer l a— et
|EEIS Links | F|Ie| B Sunrey| <. Civil Model |£E Civil Standard5|
=~ Civil Data

(-7, GOTMRDO2.DGN, Defautt
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Xiv

e Function Key F12 Corridor Modeling, Opens Create Template Dialog.

(=] Components
— Comidor Templates
= PPM EXHIBIT TYP-GA {Cur
B sre1
>={ SR61_4_2_TRANS
== SRE1_4_2_TRANS_SHLD
= SR98
= SR981
[ End Conditions
[ Linear Templates
- Surface Templates
= Concrete
= Pavement
2= Pavement_Surface

Fl T »

Library  Active Template

Preview:

A Create Template L[ B [t |
File Edit Add Tools
Template Library: Current Template Display ‘ﬁl
=5 C\e\projects\ 2204955520 1\roadw| Name: SR61 @) Components Constraints —
= Poirt Nams List Description: Display Foint Names ‘7He‘p |

L - e ] & g »

FDOTSS4 UserR CONFIGURATION VARIABLES

P

Configuration : User [FDOTS53]

File

Category =
All {Alphabetical)
Al {By Lewvel)

Cells

Clash Detection
Colars

Data Files
Database

Diesign Applications
Design History
Distributed DGN
DWG/DXF
Engineering Links
Extensions

File Saving

Levels

Markup

MDL Development
OLE

Operation

Primary Search Paths
Prirting

Pratection

Raster

Reference
Rendering/Images
Security

Seed Files

m

View/modify all configuration variables.

IVIL_CIVILCELLDGNLIBLIST User -l [ ok |
CIVIL_CONTENTMANAGEMENTDG...  User =
CIVIL_DEFAULT_CURVE_STROKING  User Cancel
CIVIL_DEFAULT_LINEAR_STROKING  User
CIVIL_DEFAULT_PROFILE_STROKING User
CIVIL_DEFAULT_STATION_LOCK User -

Expansion
CAFDOTSSIVRESOURCES DgnlibsCivil_Cells\" dgnlib

Description

For more options, click on the category list at left.
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FDOT SS4 DESIGN AND 3D MODELING OVERVIEW

Existing Features Cross Section

Terrain Tools Views

—Li’] 7

Centerlines Profiles Basic 3D Model

v

Corridor | ==
Geometry Tools Geometry Tools Modeling Tools

Horizontal > Vertical

Y_VYvwWw

A 4

2D Plans
Civil Geometry Model Details
Tools 3D Modeling

Tools

h 4

| 3 I Project Templates

Corridor Modeling
£ Tools
I
Superelevation

Corridor

Modeling Tools
8 I

3D Model for
Construction

GENERAL WORKFLOW AND CHAPTER OUTLINE

a. Existing Terrain and Existing Features

b. Design Centerlines Alignments and Prepare Station Annotations
c. Prepare 2D Plan Layout

d. Design Profiles

e. Define Project Templates

f.  Create 3D Design Model and add 2D References

g. Create Cross Section View

h. Define Superelevation and Assign to the Corridor Model

i. Detail Modeling for Intersections, Median Traffic Separator Nose, Side Roads, Driveways, Curbs
Ramps, etc.

j.  Prepare Construction Deliverables.
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RECOMMENDED MICROSTATION SETTINGS

Various tools and settings will be used throughout the workshop. Therefore for quick accessibility, several of the
dialogs are better docked on the sides the MicroStation view.

GETTING STARTED

1. (Optional) Extract the 22049555201(1).zip file in the Data Set folder to the c:\e\projects folder. If this is
a class environment, then this step has already been completed.

2. (Optional) Copy the 22049555201.pcf file in the Data Set folder to the c:\e\projects folder. If this is a
class environment, then this step has already been completed.

3. Click onthe FDOTSS4 icon 554() on the windows task bar <OR> double click on the FDOTSS4 icon
in the FDOTSS4 folder on the desktop to open the Workspace.

4. Inthe lower right corner of the File Open dialog, set the User to FDOTSS4, Project to 224049555201,
and Interface to FDOTSSA4.

7/15/2014 3:09 PM File fol
7/15/2014 3:09 PM File fol
7/16/2014 3:42 PM File fol

7/15/2014 3:08 PM File fol ™
L

- DOpen User: [FDOTSS3 -
(*.dan) - I I Cancel I Project: 122043555201 - I
Options Interface: IfdatSSB - I

5. Navigate to the Roadway folder, select TYPSRDO1.dgn and click Open.
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MENU DOCKING

B Ci\e\projects\22049555201\roadway\DSGNRDO3_SS3.DGN , Default (2D - V& DGN) - MicroStation - [Plot Scale= 50.0000, Units=English, AS= 1.0000, TX= 28000, L5= 1.0000, CLS= 1.00.. ‘ SRACE X

Fle Edit Hement Settings JTools Ltities Workspace GEOPAK Window Subsurface Uity Engineering Help

& - [P o~

A -E gy = 0 - f;] -~ @ % & l i ® m Stondard | CellApps | Actions | Design Apps | Drainage Roadway | % [ 1| [ | E]
L I T = T 2 hed | =

® Viewl, Default [ s | =
=~ | ARQRBY O BGE|HLGE - 2

S0 | o |40 -

syoe s

g - Ae

injdxg afory o

UDRELLIO U] JUBLLE|]

Civil Message Center

Q@ - © - = - [ mivode views = )| T |[1]2]3]2]5e] 78l i X [zo0s7sezazsen Y [425846.848026

Element Selection > Identify element to add to set * [Plot Scale=50.0000, Units=Engish, AS= 10 | od | & |Defaul a8 i

1. Verify that the Civil Message Center tool is already docked on the bottom; if not, select it from the
General Geometry Task group, dock and unpin.

il General Geometry BEEE A

d 51 %, “lp @ €] ©
T/ :)7 :’? V | Civil Message Center | v I
> ity

Wb o )
5 -t jJ hl Unpir
-

R .:-_,’..: :{f@ H

e
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2. Verify that the Project Explorer is docked on the left side; if not, from the main menu bar, select File >
Project Explorer, dock and unpin...Or use the F11 function key to toggle ON/OFF the dialog.

File | Edit Eement Settings Tools Lhilities Workspace GEOFPAK MHdn{ f,'_} Elen

1 New.. Ctri+N
" Open... Cir+0
Close Ctr+W
1 Save Ctr+S
Save As..
i Compress r
Save Settings Cir+F

f3 tem Browser
&) | Project Explorer

3. Verify that the Level Display is docked on the right side; if not, from the main menu bar, select Settings
> Levels > Display, dock and unpin.

File Edit Eement | Settings | Tools Lhtilities Workspace GEOPAK

Tool Settings . i
B-o-g > ® & 11 R

=} AccuDraw
Tasks Color Books... vEX B View
Tasks Color Table...
[ L Civil Tools Database

Design File

Eﬂ‘rﬂ?rﬁ ,/@) Display Styles

Drawing Scale

Analysis & Repo
% E (i) Element Irformation

't General Genm4| Levels

aﬂl'ﬁ%,ﬁ& Locks

Message Center

4. Verify that the Task Bar is docked on the left side; if not, from the main menu bar, select Tools > Tasks,
dock and unpin.

It Ci\e\projects\22049555201\roadwa, . v

Attribt
File Edit FEement Settings | Tools v Atributes ]
v Primary
=il - - - - - Et dard
il @ gj 3’3’ anda

Main

Product Add-Ins b Cv TEB "
B-@ %~ AR Q R B[ Tk |I:{ﬂprin_i
I

B View 1, Default

Animation b
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5. Verify that the Element Information is docked on the right side; if not, from the main menu bar, select
Settings > Element Information, dock and unpin.

s C\e\projects\22049555201\roadway\TYPSRDOL.L

File Edit Eement | Settings | Tools Lhilities Wear

v Tool Settings
- - 4
- =l

AccuDraw
B \fiew 1, Default Color Books...
|'_jI = ‘:‘Jv _F#_ S Color Table...
Database
Diesign File

&J Display Styles
Drawing Scale

(1) | Element Information

Levels

- g

-

Unpirﬁ

Hint  Many of the dialog settings are stored in user preferences defined in xml data files located in the users
data folders i.e. C:\Users\rd964vd\AppData\Local\Bentley.
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1 EXISTING TERRAIN AND FEATURES

INTRODUCTION

This chapter will introduce the OpenRoads Technology tools to use for viewing the existing terrain and
creating 3D existing features in design models in FDOTSS4.

CIVIL TERRAIN MODELING

As defined in the Bentley Civil Tools help files:

“A terrain model is a set of three-dimensional triangles mathematically computed from point
data collected on the surface being modeled. Models are used to define highly irregular surfaces,
particularly the surface of the earth, but can be generated for proposed surfaces, subsurface
geotechnical layers, and etcetera. Terrain models are also referred to as digital terrain models
(DTMs), triangulated irregular networks (TINS), or triangulated surfaces.

The MicroStation Terrain Model tools support importing and labeling terrain contours and
spots on terrain models. You can import a terrain model into a DGN to use its data. Terrain
models imported from the LandXML file format are supported within MicroStation. However,
any manipulation or importing from Civil products must be done within Bentley Civil.

Bentley Civil provides a robust set of tools to create, edit, analyze, and work with terrain models.

A terrain model is recognized as a MicroStation element type as of MicroStation Vi
(SELECTseries 4). When you select a terrain model, the Element Selection tool Element Type
tab indicates that it is a Terrain element type.”

Several terrain model civil features have been developed for the FDOTSS4 Workspace to be used on FDOT
projects. Terrain elements created in the design file can be selected from these features in the various Terrain
Model Tasks.

WORKFLOW INFORMATION

The workflow process for getting existing features to appear on cross sections has changed significantly in
FDOTSS4. No longer will the legacy existing features criteria be used. Instead the existing features will be
created in a 3D model following the steps outlined in the exercises to follow.

e Levels containing the existing features will be identified from the SURVRD01 OR TOPORDOL1 file and
copied into a GKLNRD file.

o Closed shapes will be created to contain areas representing the existing features. These are the features which
are typically required to be the on cross sections.
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Chapter 1 EXISTING TERRAIN AND FEATURES - Exercise Overview

The table below is a list of the Levels that contain these features.

Level Existing Feature
CGBack_ep Curb Back Line
CGep_ep Curb Edge of Pavement
ConcSlabs_ep Concrete Slabs
Driveway_ep Driveway Pavement
PavtAsphalt_ep Pavement (Roadway)
PavtMisc_ep Pavement (Miscellaneous)
ShldrPaved_ep Shoulder Pavement
SidewalkFront_ep Sidewalk Front Line *
SidewalkBack_ep Sidewalk Back Line
TrafSeparator_ep Traffic Separator
* A sidewalk front line may not be present when
the sidewalk is adjacent to curb.

e The existing Terrain will then be clipped by each shape individually to create separate existing feature
Terrains

o Asurface template is then applied to the terrain features to define the sub-surface depth to the terrain.
e For the non-uniform depth curb and gutter a linear template is applied.
o Anprofile is added to the R/W Existing lines in order to display the R/W line symbol in a cross section view

When finished, the file will contain 3D existing features developed from the original existing DTM terrain and
TOPORDO1 files. As a result of creating this file, any cross section created while the terrain elements are
displayed in the 3D model will show existing features below the surface.

EXERCISE OVERVIEW

1.1  Importing the Existing Terrain (disregard if SURVRDO1 exists)
1.2 Copy Reference File Elements from TOPORDOL1 to New File
1.3  Copy Reference File Elements from SURVRDO1 to New File
1.4  Create Shapes Around Existing Features

1.5 Create Existing Feature Terrains

1.6  Clipping Terrains within Terrain, i.e. Medians/Traffic Separators
1.7  Creating Existing Traffic Separator Terrains

1.8 Apply Surface Templates

1.9  Edit Existing Feature Depth

1.10 Adding Curbs to the Existing Features

1.11 View Existing Cross Sections

1.12 Add Existing R/W Lines for Cross Section Viewing

1.13 Add Existing Utility Lines for Cross Section Viewing
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Exercise 1.1  Importing the Existing Terrain (disregard if SURVRDOL1 exists)
In this exercise, the user will create a digital terrain model file and import the delivered TIN file from the surveyor.

Note If a SURVRD file exists for the project this step is not necessary because the terrain file will be
included

> Create a Terrain File

1. From the FDOTSS4 folder on the desktop, double click on the Create Files icon. This will open the
Create File Project application.

{74 ClearCrash
[#)) Create 3D Deliverables
@ﬁCreate Files
oloMeeting
[ |ECS0's Website
(7] |FDOT CADD Support Community
75 FDOT XML Signing
[##, FDOTSS4 for PowerGEOPAK
[3Hl FileChecker
& Key Sheets
5 LandXMLVisualizer
EﬂXML Quantity Rounder

2. Fromthe Create File/Project dialog, click on the Project Settings button. The Project Settings dialog
displays.

Project Settings ﬁ

Create Mew Project |

{ Select Active Project ,

b -

3. Click on the Select Active Project button. The Select Active Project dialog displays.

4. Click the Browse button and navigate to C:\E\Projects\22049555201\ and click Select. The Active
Project field populates with the selected path.

Select Active Project I&

Active Project: |E:'\E'&prﬂiects'\EEDdEEEEED'I Browse

Cancel

L

5. Click OK on the Select Active Project dialog and OK on the Project Settings dialog. The Project is
populated with the selected Project path and the Workspace is set to FDOTSS4.
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6. Complete the rest of the dialog as shown below.

Project: I C:hehprojects 22049855207 - Project Settings |

Whorkspace: IFDDTSS-'-1 LI

Control File:  [ROBDWAY.CTL | ﬁ
File Graup: ISuwe_l,J Degign Files [DGM] ;I
File T ppe:

DIGITAL TERRAIN MODEL 4 TIN MODEL - 30

DRAIMAGE STRUCTURES - EXISTING

SURYEY DEVELOPMEMT MODEL

SURVEY OF VERIFIED UTILITIES (3D VERSION OF UTE=RD.DGN]
SURYEY PROJECT METWORE. CONTROL SHEETS
TOPOGRAPHY - EXISTING

TREE SURVEY SHEET

UTILITIES - EXISTING

Output File:  [GDTMRDOZ

Output Falder: |Surve_l,l'\ Browse |
Seed File: Ifdotseede.dgn Browsze |

Seed Path; Ilesnurcesfseeda’
Action: Imdl | plotzcale plotscale et Apply A ction |
Create I Open File I

Active File for Open/Edit: GDTMRDO0Z DGM

0K |

7. Click Create to create the file, GDTMRDO02.dgn

8. Click OK to close the Create File/Project dialog.

9. Click onthe FDOTSS4 icon to Open File, GDTMRDO02.dgn. Set/Update Plot Scale displays. Use the
Default settings and click OK.

» Import TIN

1. Once the file is opened in PowerGEOPAK, set the sidebar tasks to Civil Tools.

: Flle Edit FElement Settings Tools LUtiites Workspace GEOP .
- : Hle Edt Hement Setings Tools Utiities Workspace GEOPAK Window Subsurface Uity

Al-D-E-8-E-S-2-R-{@-o-g-0-B-a-2-8-@ -0RaR

= e J;l x = R w View1 - Top, Default
— % Civil Tool - -l -
[sy.. FDOT Plans Development - ] [ il Toets ] Br-a¥- A1
= - 52 Tasks

M\ E»H?,Elg>ﬁw.»ﬁ< iﬁ;&i‘{—';eﬂl}.

J - ? § IQ r ?f - f, FDOT Plans Development
1 l‘l’-‘»i‘P 3 [0 “ Analysis &Reporting 4 Main Classic
then click here & Subsurace Lities
i General Geometry «J Drawing

R

1 Pemimsinn Mrmnnsitinn
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EXISTING TERRAIN AND FEATURES - Exercise Overview Chapter 1

2. Use the Terrain Model, Create From File tool to import the existing terrain file.

# Terrain Model EEEA

P =R A B A AR A
o ACcFeonFie) o Ry
E@Lﬁ:@.%%

o B A PR OB WYL oz

3. Select the GDTMRDOL.tin file in the Survey folder and click Done.

Hint  Ifthe file extensions are not shown, use Windows Search for Folder Options and uncheck Hide extensions

for known file types.

General | View | Search

Folder views
You can apply the view (such as Details or lcons) that
you are using for this folder to all folders of this type.

Apply to Folders [ Resct Folders

Advanced settings:
Display the full path in the tile bar (Classic theme only)  »
Hidden files and folders
Don't show hidden files., folders, or drives
@ Show hidden files, folders, and drives
lidg empty drives in the Computer folder
ensions for known file types
e protected operating system files (Recommended)
[] Launch folder windows in a separate process
[] Restore previous folder windows at logon
[¥1 Show drive letters

4. Onthe Import Terrain Model(s) dialog, under the Feature Definition section set the Feature Definition
to DtmExisting and set the Import Options to Import Terrain Only.

= ™
.\‘ Import Terrain Models) E‘M
- Options
CEE X B
Terrain Models ~

Append to existing Terrain Model
Terrain Mode! to append to

Filter ~
Source File Units Unknown [=]

Feature Definition -~
Feature Definition q El
Import Options Import Temain Only El i

_— —

Geographical Coordinate Systems -~
Source None =] | ------ & No Feature Definition
Source Description Comidor Components
Souree Unis Termain Display
Teraet Here 2 ...@ DtmBottomMesh
Target Description : —
Target Units = e DtmEXIStlng

-@ DtmProposed
i @ DtmTemporary
Ci\e\projects\22049555201\survey\GDTMRDOL.tin E @ DtmTopMesh

5. Click on the Import button.
6. Click the X to close the Import Terrain Model(s) dialog.
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7. Fit View and the existing terrain will be imported with the triangles turned OFF. To turn the triangles
ON, select the terrain border using the MicroStation Selector tool, hover over the highlighted border
until the popup menu displays and then select the Properties icon.

J Properties

8. Double click on the word Triangles <OR> select On in the pull down menu to toggle them On/Off.

Edge Method Slivers

Feature Name GDTMRDO
Feature Definition DtmBEdsting

Contours

Triangle Vertices
Flow Arrows

Low Points

High Points

Boundary
Spot

Cwerrnide Symbology

Note Many common features of the Terrain can be toggled on/off from the Properties Menu.
For most of the exercises the triangles are not necessary! Toggle them Off.

9. From the MicroStation menu select File > Save Settings or Ctrl + F on the keyboard.
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Exercise 1.2  Copy Reference File Elements from TOPORDOL1 to New File
Note Go to Exercise 1.3 if SURVRDO01 exists.

In this exercise, shapes are created based on the existing survey elements. First, only display the desired levels
of existing features for cross sections.

1. From the main Tasks bars, select the FDOT Plans Development Task.

Tasks - I X

[_q Tasks - ‘

= Civil Tools il
ﬂCTT I;Ians Development ; il
_Pla\n Classic - v
“{ Subsurface Utilities ]
\2 Drawing R4
[d Drawing Composition sl
'éf Solids Modeling -

2. Fromthe FDOT Plans Development, Roadway Plans Task, select the Create New File icon. The Create
File/Project dialog displays.

Roadway Plans e

d OB H =
W ﬂ Create NEWFiIEh All;l
e} JEEERR

3. Create a GKLNRDO1.dgn file with the Create File/Project dialog as shown below.

Project: [C:\e\proiects\22049555201 v] Project Settings

‘Warkspace: [FDDTSS4 ']
Control File: [ ROADWAY.CTL -
File Group: [Floadway Design Files [DGN) ']

File Type:

DIGITAL SIGMATURE [MULTI)

DIGITAL TERRAIN MODEL / TIM MODEL - 3D
DRAIMAGE DETAIL SHEET

DRAIMAGE FLOOD DATA FORM

DRAIMAGE MAP

DRAIMAGE OPTIONAL MATERIALS TABULATION
DRAIMAGE STRUCTURE XSECTIONS PATTERM LIMES & SHAPES
DRAIMAGE STRUCTURES - EXISTING
DRAIMAGE STRUCTURES - PHDPDSED
GEOPAE LIMES FOR NG FEATLIRES
INTERSECTION/INTERCHANGE DETAILS
INTERSECTION/INTERCHANGE PROFILES

KE'Y SHEET

LATERAL DITCH CROSS SECTIONS

LATERAL DITCH PLAN / PROFILE SHEET
MITIGATION AREAS

MOTIF FILE FOR PLAN SHEETS

MOTIF FILE FOR PROFILE SHEETS

PLAM AMD PROFILE SHEETS

Pl &M SHEFT

Output File: GKLMRDO

Output Folder:  Roadwaps
Seed File: fdotseed2d dan

Seed Path: resounces/sead/

Action: rndl | plotscale:plotscale set Apply Action

[ Create ] [ Open File ]
Active File for Dpen/Edit GEKLMRDOT.DGN
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4. Click Create to create the file, GKLNRDO1.dgn. Click Open File, GKLNRDOl.dgn displays.
Set/Update Plot Scale displays. Use the default settings and click OK.

5. Click OK to close the Create File/Project dialog.

6. From the MicroStation menu select File > References and attach the following files:
C:/lelprojects/survey/GDTMRDO02.dgn
C:/lelprojects/survey/TOPORDO1.dgn
C:/lelprojects/rwmap/RWDTRDO01.dgn

7. Select MicroStation Fit View to see the
project files.

8. From the Level Display dialog, select the
TOPORDO1 file, right click on the level list

and select All Off.
Level Display - View 1
= . i = set level filter to
D & (owDaly ) All Levels
= A AlLleve~ [Leveis ~] B

=8 GKLNRDO1.DGN

v N
u TOPORDO1.0GN
v N

Jump To Active Level

Create Display Set

Al On
A1 Off
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EXISTING TERRAIN AND FEATURES - Exercise Overview Chapter 1

9. Select On the following TOPORDOL1 levels in the Level Display dialog.

Level
CGBack_ep
CGep_ep
CGFace_ep
Driveway_ep
PavtAsphalt_ep
ShldrPaved_ep

Note For this dataset exercise; the existing sidewalks, traffic separators, concrete slabs and
miscellaneous pavement are not included. All projects including these items should include these
levels as well.

10. From the References file manager, right click on the TOPORDOL1 file and select Merge Into Master to
copy the elements on the levels above into the active file.

T References (3 of 3 unique, 3 displayed) (]

Tools  Settings

BB £96 R0 BB 37 @ x et GEmEms)

Hierarchy (] ¥ & FileName Model Description
V8 GKLNRDO1TDGN < GDTMRD33.DGN Default Master Model
Dronnd nes Default Master model

(| Aftach.. Default Master model
Detach
Reload
Exchange
Open in New Session
Activate
Deactivate

Move

Copy

Scale

Botate

Make Direct Attachment
Add Link to Element
Create Drawing Title

q [ +
Clip Boundary .
Scale | 1.000000 Rotation | 00°00°00"
Clip Mask.
Offset X | 0.000000 Delete Clip
] o [ A
Mested Attachments: I Ovemdes: |Allow | Nesting Dep]

Update From Saved View

New Level Display. [( Push to Saved View

nced: | No =

a. Select View 1 and click OK.

b. An application was developed for the FDOTSS4 Workspace to streamline this exercise. From
the FDOTSS4 Menu select Design Apps > Reference File > Copy Reference File Levels.

n Standard | CellApps | Actions || Design Apps || Roadway | v7 | < | [l | a| D [ € I
O Cleanup 3
O Custom Line Style  »
O Draw 3
GEOPAK VBAS »
Input-Cutput »
O Miscellanecus 4
|O Reference Files 3 || Copy Reference File Levels
O Revisions » Attach External Reference Files
O Text » Batch Attach Reference Files
Reference-Raster Cleanup UHtility
Reference File Tools
Display All Reference Files
Display Mo Reference Files
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<OR> From the FDOT Plans Development, Existing Features Tasks, select the Copy Reference File Levels
icon.

Tasks v 01X

JTasks - ]

[s.‘u FDOT Plans Development |'

X 51 on B 505 K o8 of

P R=

Typical Sections v
Key Sheets L4
Roadway Plans w
Existing Features = A

o B¢ [ X M
:‘_\J_ g‘ [Cop}f Reference File Lr:*.fr:lz}

o Ry Ry B Y
E %""\{ﬂﬁ-w

Q

c. Open the application and select the RWDTRDO1.DGN: RWLine_ep level, click the Add button
and Process. Close the application.

Available Levels To Process Levels To Process

PaviMisc_ep i
Miscellaneous0

TextCurveData
Textlabel
LeaderLine_dp
TextMinar
DimLines_dp

RiLine

TextMisc

TrafSeparator_ep
TankStor_ep
Stump_ep

Silo_ep
Pavemk_ep
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Exercise 1.3  Copy Reference File Elements from SURVRDOL1 to New File

In this exercise, shapes are created based on the existing survey elements.

» To Add Lines from Survey Topo

1. From the main Tasks bars, select the FDOT Plans Development Task.

Tasks * X
[_-. Tasks - |
= Civil Toals ad

ﬂa’ F;ans Development ! el

_Main Classic L4

] Subsurface Utilities il

\?, Drawing L

[d Drawing Compasition el

% Solids Modeling v

2. Fromthe FDOT Plans Development, Roadway Plans Task, select the Create New File icon. The Create
File/Project dialog displays.

Roadway Plans e

d o|® B e =
W ﬂ Create NEWFiIEh A;';l
e} JEEERR

3. Create a GKLNRDO1.dgn file with the Create File/Project dialog as shown below.

Create File/Proje |
Project: [C:\a\pmiects\22049555201 v] Froject Settings
Warkspace: [FDDTSS4 v]

Cortrel Fle: [ ROADWAY.CTL -

File Group: [Hoadway Design Files [DGM) ']

File Type:

DIGITAL SIGMNATURE [MULTI) -

DIGITAL TERRAIN MODEL / TIN MODEL - 30
DRAINAGE DETAIL SHEET

DRAIMNAGE FLOOD DATA FORM

DRAIMNAGE MaP

DRAMNAGE OPTIOMNAL MATERIALS TABULATION
DRAMNAGE STRUCTURE XSECTIONS PATTERM LIMES & SHAPES
DRAIMAGE STRUCTURES - EXISTING
DARAINAGE STRUCTURES - PROPOSED
GEDPAK LIMES FOR EXISTIMG FEATLIRES
INTERSECTIONANTERCHAMGE DETAILS
INTERSECTIOMAMTERCHANGE PROFILES

KEY SHEET

LATERAL DITCH CROSS SECTIONS

LATERAL DITCH PLAN / PROFILE SHEET
MITIGATION AREAS

MOTIF FILE FOR PLAN SHEETS

MOTIF FILE FOR PROFILE SHEETS

PL&M &MD PROFILE SHEETS

Pl AN SHEFT

m

Output File: GKLMRDO1

Output Folder:  Fioadwayh

Seed Fie: fdatseed2d dan

Seed Path: resources/seed/

Auction: rndl | plotscale plotscale set Apply Action
Create ] [ Open File ]

Active File for Open/Edit GKLMRDO1.DGN
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4. Click Create to create the file, GKLNRDO1l.dgn. Click Open File, GKLNRDO1.dgn displays.
Set/Update Plot Scale displays. Use the default settings and click OK.

5. Click OK to close the Create File/Project dialog.
6. Use the Attach Survey Reference Files tool from the FDOT Menu.

H Standard | CellApps  Actions | Design Apps| Roadway | i | <7 | [l | Cg| D | (2] I
O Cleanup 3
€} CustomLineStyle » EI@
€) Draw 3
€)| GEOPAKVBAs ’
€3} Input-Output 2
€) Miscellaneous 3
|O Reference Files ] | Copy Reference File Levels
€) Revisions 3 Attach External Reference Files
€ Text Attach Survey Reference Files

Batch Attach Reference Files
Reference-Raster Cleanup Utility

Reference File Tools

Display All Reference Files
Display Mo Reference Files

7. Select the SURVRDO1.dgn file.

-
=

Name Date modified Type Size
eng_data 5/3/2010 4:29 PM File folder
E GOT GMN 11,/7/2013 AM  Bentley MicroStati... 2,9
% 4 SURVRDOL.dgn 10/24/2016 11:13 ...  Bentley MicroStati... 6.3
Fl 1 3

8. From the MicroStation menu select File > References to view the attached files:

Tools  Settings
ek g $DEe AR D Y9 @ % Hite Mode: [Bondaes v
St ¥ (4 File Name Model Description Logical Orientation Presentation Visible Edges

1 SURVRDO1.dan Default Master Model TOPO Coincident - World Wirsframe Cynamic
2 SURVRDO1 dagn Diefault Master Model GODTM Coincident - Word Wireframe Chynamic
3 SURVRDO1 dagn Diefault Master Model UTEX Coincident - Word Wireframe Chynamic
4

SURVRDO1 dgn Diefautt Master Model DREX Coincident - Word Wireframe Dynamic

4 1nr
Scale | 1.000000 : | 1.000000 Rotation | 00°00'00" Offset X | 0.000000

|I| & n “> 4 @ ¢ (@ Nested Attachments: [No Nesting ¥ | Display Over

New Level Display: |Config Varable * | & : [No hd
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9. Select MicroStation Fit View to see the project files.

10. From the Reference file manager, turn the display off for the UTEX and DREX logical names.
11. Highlight only the following levels in the TOPO, SURVRDO01.dgn file from the Level Display dialog.

2y B [ViewDisplay  ~]

E’j E:Z ;;:‘NH.EVE" ||-E‘-'E|5'|ﬁ hd

=+l GKLNRDA L
" TOPO, SURVRDO1.d
G - 01.dan

Level
CGBack_ep
CGep_ep
CGFace_ep
Driveway_ep
PavtAsphalt_ep
ShldrPaved_ep

Note For this dataset exercise; the existing sidewalks, traffic separators, concrete slabs and
miscellaneous pavement are not included. All projects including these items should include these
levels as well.

12. Choose File > Save Settings.
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13. From the FDOT Plans Development, Existing Features Tasks, select the Copy Reference File Levels
icon.

Tasks v 01X

Tasks - ]
[s.‘u FDOT Plans Development |'

X Glon 8L XY of

P R=

Typical Sections v
Key Sheets L4
Roadway Plans w
Existing Features = A

BN @ <~
:‘_\J_ g‘ [ Copy Reference File Levels ]

o Ry Ry B Y
E {E""\([{Hw

Q

<OR> From the FDOTSS4 Menu select Design Apps > Reference File > Copy Reference File
Levels.

n Standard | CellApps | Actions || Design Apps || Roadway | v.7 [ <7 | —_||a| E‘l [ € I

O Cleanup 3
O Custom Line Style  »
O Draw 3
GEOPAK VBAS »
Input-Cutput »
O Miscellanecus 4
|O Reference Files 3 || Copy Reference File Levels
O Revisions » Attach External Reference Files
O Text » Batch Attach Reference Files

Reference-Raster Cleanup UHtility

Reference File Tools

Display All Reference Files
Display Mo Reference Files
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14. Select each of the following levels and. click the Add button. When finished select Process.

15. Click the X button to close the application.

Lall=

Available Levels To Process

TOPO “PavemkTL_ep;™ A
TOPO "Pavemk_sp™
TOPO "PavtConcrete_ep
TOPO "PavtCrown_sp™
TOPO "PavtMisc_sp™
TOPQ "PipeCulvert_sp™
TOPO "PointLocator_ep™
TOPO "PoleElec_ep™
TOPO "PoleTel_ep™
TOPO "PullBox_ep™
TOPQ "Railing_ep™
TOPO “RipRap_ep™
TOPO ™Sl_TestHole_ep”™
TOPO ™SanitaryFM_B_gy
TOPO ™SanitarySewerE i
TOPO “SanitarySewerMis
TOPO "SateDish_ep™
TOPQ "Shrub_ep™
TOPO “SidewalkFront_ep
TOPO ™SignMulti_ep™
TOPO ™SignSingle_ep™
TOPO ™Silo_ep™ ﬂ

Levels To Process

TOPO ™CGBack_ep™
TOPO ™CGFace_sp™
TOPO ™CGep_sp™
TOPO "Driveway_ep™
TOPO "Pavtasphalt_ep™
TOPO "ShidrPaved_sp™

K1 — ~

¥ Turn Global Display Off

3¢

16. From the Reference file manager, turn the display off for the TOPO logical hame.

Tools  Settings

ErdRxe ¥

DR B D 300 0 ek

Slat ¥ 4 File Name

Model

Description Logical

i
(i)

Orientation Presentation Visble Edges |

X
1 SURVRDO1.dgn Default Master Model TOPO Coincident - World Wireframe Dynamic ( ” %Iay ~
2 SURVRDO1.dgn Default Master Model GOTM Coincident - Warld Wireframe Dynamic AR
3 SURVRDO1.dagn Defautt Master Model UTEX Coincident - Wordd — Wireframe: Dynamic VW
4 SURVRDO1.dgn Default Master Model DREX Coincident - World Wireframe Dynamic ~ Y
Scale | 1.000000 1 | 1.000000 Botation | 00°00°00" Offset X | 0.000000 ¥ | 0.000000
&I r_3| L_‘U > 4 B ’;5’ ] ‘:L - Nested Attachments: Display Overides: |Allow  ~ | Nesting Depth: |1
MNew Level Display: |Config Varable ~ | Georeferenced: |Mo 7
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» To Add Lines from R/W

1. From the MicroStation menu select File > References and attach the following files:
C:/lelprojects/rwmap/RWDTRDO01.dgn

2. From the FDOT Plans Development, Existing Features Tasks, select the Copy Reference File Levels

icon.

Tasks

- 1X

Tasks

- |

[s&( FDOT Plans Development

[

L STREEY. JE LRI e

&k

Typical Sections

Key Sheets

Roadway Plans

Existing Features

Q

Tr B3 |~8 [T K & X

> ¢ ¢ ¢

L‘J_ g‘ [ Copy Reference File Levels ]

YY"
E '@""\{ﬂ&w

<OR> From the FDOTSS4 Menu select Design Apps > Reference File > Copy Reference File

Levels.

[ Stendard | CellApps | Actions |

Design Apps | Readway | v7 [ |Hi[[aE| @]

1-16

O Cleanup 3
O Custom Line Style  »
O Draw 3
GEOPAK VBAS »
Input-Cutput »
O Miscellanecus 4
|O Reference Files 3 | Copy Reference File Levels
O Revisions » Attach External Reference Files
O Text » Batch Attach Reference Files
Reference-Raster Cleanup UHtility
Reference File Tools
Display All Reference Files
Display Mo Reference Files
©2016 FDOT
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3. Select the following level and click the Add button. When finished select Process.

Available Levels To Process Levels To Process

TOPO “Vault_ep™ - “RWline_ep™
TOPO “VentSewer_ep™
TOPO “Wall_ep™

TOPOQ ™WaterB_ep™
TOPO ™WaterEdge_ep™
TOPO ™WaterMisc_ep™
TOPO ™WaterMP_B_ep™
TOPO ™WellMon_ep™
TOPO ™Well_ep™

TOPO ™Wetand_ep™
TOPO ™XSPt_ep™

RWDTRDO1.DGN
Default}

"Default™

"L eaderLine_dp™
“RWLine™
“TextCurveData™
“Textlabel™
“TextMinor™
“TextMisc™

[¥ Turn Global Display Off
G| |

4. Click the X button to close the application.

5. From the Reference file manager, turn the display off for the RWDTRDO01.dgn file.

Tools  Settings

E-R e ¥DERAPE 8%

B 09 (3 5 i vose

Slet ¥ 4 File Name Model Description Logical Orientation Presertaton [=] .J X% _3,
1 SURVRDO1.dgn Default Master Model TOFO Caoincident - World Wireframe [
2 SURVRDO1.dgn Default Master Model GDTM Caoincident - World Wireframe [
3 SURVRDO1.dgn Default Master Model UTEX Coincident - World Wirsframe S
4 SURVRDO1.dgn Default Master Model DREX Coincident - World —— Wireframe ———={ ./
3 RWDTRDOT.DGN _ Dsfaut Master model Coincident - World ere{mmé\_)f) o
Scale | 1.000000 : | 1.000000 Rotation | 00°00°00" Offset X | 0.000000 Y | 0.000000

R E

FDOT Roadway Design and 3D Modeling

7] > < @ &[]0 [d]e
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Chapter 1 EXISTING TERRAIN AND FEATURES - Exercise Overview

Exercise 1.4  Create Shapes Around Existing Features

In order to create a continuous shape around the existing features, miscellaneous lines are drawn in the file at
various locations.

1. Turn Off the Level Filter.
2. Set the Active Level to Miscellaneous3.

3. Use the Existing Features, Place Smartline

Existing Features as —

e l'“"'l! "3_'1 4\; K /!-,,__ E'IQ

a . = -
o
W A A A

E LN

4. Place a line to separate the 2 existing roadways.
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5. Draw a line at each location where the roadway shape ends or needs to be closed. See the images below
for each location.

6. Turn Off all the Levels except PavtAsphalt_ep, RWLine_ep and the Active Level, Miscellaneous3.
7. Use the Existing Features, Flood Element tool.

A=EE A

X

Existing Features

To plodh o

p A GR A8 ] K
Y ﬁ‘
o2

y{ Flood Elerment |

—

Q

Wlﬁ

B @ fﬁ\{fl& N

8. Set the Create Region dialog settings as shown: @ Create Regi.. (5= e

- s
Fill Type:TNone h 4|

-

Text Margin: | 0.0000
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9. Zoom Out to see the entire area to be shaped and enter a data point inside the Existing Pavement area.

The shape will form as shown below.

closed shape

10. Enter a data point again to accept the shape placement.

HiNT  The entire area to be shaped must be viewable in the view for the command to be successful. Place a
tentative point inside the area to be shaped and use the wheel to zoom out far enough for the entire area, then
click the data point to form the shape.

Note The following Error may occur when using this command:
Q- © - - [ ocanvens -] T [7]2]3]2s]s] 78| i X (2008351956171
Create Region From Area Enclosing Point > Enter data point inside area I _"'"-.‘ Emor - Mo enclosing region found

This usually means there are gaps in the MicroStation line work. Locate the gaps and use the
Place Line tool to close the elements on the Active Level Miscellaneous3. When the command is
successful a closed shape should appear.
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11. Continue to create closed pavement shapes for each of the separate Roadways (EX_61 and Side Street).

a. EX_61 can be terminated where the R/W breaks as shown below. Be sure that the shapes do not
extend past the R/W limits or the limits of the terrain model.

add line across
EX_61 here

12. Repeat the steps to create closed shapes for each of the following types of features.

Note - Place lines to close line work differentiating existing features.
- Use the Active Level Miscellaneous03 for all the shapes.
- Zoom out enough to see the whole area to be shaped.
- The CGFace_ep and CGBack_ep elements will be used in later exercises.

Existing Features Type Levels On
Driveway_ep, PavtAsphalt_ep,

Shoulders ShidrPaved_ep

Driveways, Driveway_ep, PavtAsphalt_ep,

ShidrPaved_ep
Existing Traffic Separator | TrafSeparator_ep

Turnouts PavtAsphalt_ep
Side Streets PavtAsphalt_ep
Medians CGep_ep, CGBack_ep, PavtAsphalt_ep
Note This exercise is meant to demonstrate the procedures for add existing features into a 3D model.

There may be more features on a typical project and the steps outlined here within can be used to
achieve the desired results.
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Exercise 1.5 Creating Existing Feature Terrains
1. To prepare for this exercise:
a. Set the Active Level to Miscellaneous3 and turn Off all the other Used Levels.
b. Make sure the Reference file display for the Terrain is turned On.

2. Use the Existing Features, Clip Terrain tool to create a Terrain for Existing Features.

A=A

En

Existing Features

Q Gﬂﬂrjj h\i s e
¥ X

vyl A A v

L

-

E ™| Clip Terrain

3. Onthe Create Clipped Terrain Models dialog, under the Feature section set the Feature Definition to
DtmEXxistingFeature and enter ExFeature_SR61 Pavement for the Name.

Note DtmExistingFeature is a terrain feature used for Surface Templates. It is a construction class terrain
element and can be turned OFF with the F7 function key.

Reference Terrain Model GDTMRDOM
Clipping Method Extemal
[T] Horizontal Offset 0.000000
Wertical Offset 0.000000

Feature

Feature Definition Dtm ExistingFeature EI

Name ExFeature_SRE1_Pavement

a. Following the prompts on the end of the cursor, locate the Reference Terrain Model element.
This will be the terrain you are clipping from; which in most cases will be the Existing Terrain
Model. Select the GDTMRD boundary as the Reference Terrain.

b. Locate the Clipping Element; the shape for which you want to create a terrain. Select the shape
created for the existing pavement for SR 61 and data point to accept it as the Clipping Element.

Hint  Some of the shapes may overlap each other. Right-click or Tab through the shapes and select the correct
one. Select F6 to restart the command if needed.

c. Reset when finished to stop selecting Clipping Elements.

d. Setthe Horizontal Offset to 0.0 and left-click to accept.

e. Setthe Vertical Offset to 0.0 and left-click to accept.

f.  Set the Clipping Method to External and data point to accept.

Note Internal clipping elements will be added another exercise.
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4. A clipped terrain is created and placed in the 3D Model of the GKLNRDO1. The 3D Model is then
referenced to the 2D Model. Select the Function Key F2 to view the 3D Model.

Note There is an issue when selecting multiple shapes, the dialog will flip and lock to the internal method.
External boundaries can only be selected one boundary at a time.

5. Repeat the Clip Terrain command for each of the following existing shapes. Use the table below to
record the Status.

Existing Feature
Terrain Name

Ex_SR61 completed
Ex_ SR61_Shld
Ex_SR61_SideRoad
Ex_ SR61_Dwy
Ex_US98

Ex_ US98_Shld

Ex_ US98_Dwy

Status
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Note There is an issue with the one of the Ex_US98_Dwy shapes creating a terrain. To work around
this issue use MicroStation Delete Vertex from the shape at the tie to the shoulder. See image
below.

delete shape vertices's
here

Exercise 1.6  Clipping Terrains within Terrain, i.e. Medians/Traffic Separators

1. In order to clip an element within the boundary of another Existing Feature Terrain; for example the
Median or Traffic Separator Islands on Ex_US98, select the Terrain and hover over the boundary to
display the Context Menu. Select the Properties dialog and toggle Off the Triangles.

Y e cessssssssssssnsiess m—m_"r-\‘-'— ™

Edge Method

Slivers

Contours

Triangle Vertices
Flow Arrows
Low Points

High Foints

Terrain Model: EX_US98_Dwy3

29288888

Triangles
select Elevation 40.985554 Boundary
this icon Slope 3.02 Spat
Aspect 257.07 Feature Name EX_US98_Dwy3
Level: DTM_ex Feature Definition  DimExistingFeature

Ref: Ref (GKLNRDO1.DGM) Override Symbalogy  No

2. Use the Existing Features, Clip Terrain tool to create a clip boundary within a terrain for Existing

Features.
Existing Features EEEA
P pilalh 3 "
a _*! jj J\‘: 2 /L' E.'{

Y
W @ e A Bl

E | Clip Terrain |\"'f
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a. On the Create Clipped Terrain Models dialog, select the Reference Terrain Model
ExFeature_US98_Pavement

b. Enter the Name ExFeature_US98 Pavmentl.
c. Then locate the shapes inside the ExFeature_US98 Pavement boundary.

d. Reset when finished.

\". Create Clipped Terrain Mode F ! :
Reference Terrain Model EX_LIS98 lz‘
Clipping Method ntema
Horizontal Offset 0.000000

Vertical Offset 0.000000

Feature ~

Feature Definition DtmEnstlngFeaturE

Mame EX_1U558 1

HinT  Multiple internal clipping elements can be added one time.
e. Change the Clipping Method to Internal.
f. Data point to create the clipped Terrain.
3. To delete the first ExFeature_US98_ Pavement Terrain:
a. Select F11 to launch Project Explorer.
b. Select the Civil Model tab.
Navigate to the Civil Data > GKLNRDO1.DGN, Default > Terrain Models folder.

d. Right-click on the Terrain Model: ExFeature_US98_ Pavement and select Delete.

S g

[) Survey| < Givil Model |*p Givil Standards 1]
E- <. Civil Data

=< GKLNRDO1.DGN. Default
w " Linear Elements

+ FPoirt Hements
-2 3D Linear Blements
=& Temain Models

-4 Temain Model: ExFeature_SRET_Dwy [j_ wTo
- Temain Model: ExFeature_SRE1_Dwy1 .

124

emain Model: ExFeature_SRE1_Dwy2
emain Model: ExFeature_SRE1_Dwy3 Turn Level Off by Element
emain Model: ExFeature_SRE1_Dwyd

‘emain Model: ExFeature_SRE1_Dwy5 -~ .
emain Model: ExFeature_SRE1_Dwy6 Wt Element Information
emain Model: ExFeature_SRE1_Dwy7
‘emain Model: ExFeature_SRE1_Pavement x Delete
emain Model: ExFeature_SRE1_Shidr

‘emain Model: ExFeature_SRE1_Shidr , g p’ / /

emain Model: ExFeature_UUS98_Pavement1
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4. Continue this exercise by repeating these steps to clip the ExFeature_SR61_Pavment Terrain with the
shape for the island. Delete the original ExFeature_SR61_Pavment Terrain in Project Explorer.

%
N

MR AY

Tl ol W :‘5’; [
A

N
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Exercise 1.7  Creating Existing Traffic Separator Terrains

So far the Existing Pavement Terrain area has been created for ExFeature_US98_Pavement, now the Existing
Traffic Separator Terrain can be created.

1. Use the Existing Features, Clip Terrain tool to create a terrain for Existing Traffic Separator island
shape.

Existing Features S
Dﬂijjj J\E /\ /L' L)'{

3 ) g‘
'-._::_

Wl R A

E ?l Clip Terrain |\"f

2. Onthe Create Clipped Terrain Models dialog, select the Reference Terrain Model GDTMRDO1.
3. Set the Clipping Method to External.

4. Set the Feature Definition to DtmEXxistingFeature.

5.  Enter Ex_US98_TS for the Name.

Reference Terrain Model GDTMRDO1

Clipping Method Extemal

Horizontal Offset 0.000000
Vertical Offset 0.000000
Feature

Feature Definition CtmExistingFeature
Hame Ex_US98_TS|

6. Select the Traffic Separator Island Shape.

clipping
element

Locate Clipping Element

Complex Shape | Line String
Level: Miscellaneous3

reference
terrain

Note The curb islands will be created in exercises to follow using linear templates.

FDOT Roadway Design and 3D Modeling ©2016 FDOT 1-27



Chapter 1 EXISTING TERRAIN AND FEATURES - Exercise Overview

Exercise 1.8  Apply Surface Templates

In this exercise the Surface Template will be applied to each of the existing terrains created from the previous
exercises.

1. Use the Existing Features, Open Existing Features Template to view Surface Templates to apply to
each Clipped Terrain.

Existing Features BmEEA
To phd > ot
?ﬂ _‘I:I J\;: A /L En

__I_,':J
L

Wﬁgﬁy&* Ay oL

B {? .r{ Dpfﬂ Existing Features Template }

a. The Create Template dialog displays the FDOTSS4.itl file.

b. Navigate the left folders to the Existing Feature Templates folder.

£5 CAFDOTSS54_serverGEOPAK comidor FDOTS54 itl
EE Poirt Mame List
[ Components
[ End Conditions
[ Examples(For Training)
5 Existing Feature Templates
= CurbBExsting
= DrivewayBdsting
= (Guardrail Bxisting
= PavedshldrBdsting
Pavement Asphalt Bxdsting
== SidewalkExisting
== TrafficSepBxdsting
== WallBamerExsting
[ Existing Pavement Slope
[ Linear Templates Comman
[ Median Conditions
[ Suface Templates
[ Typical Sections (PPM)
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2.

FDOT Roadway Design and 3D Modeling

Chapter 1

Double click on PavementAsphaltExisting. This is an example of the template to be used for

W7 Create Template = E s
File Edit Add Tools
Template Library: Current Template Display
‘2 C\FDOTSS4_server\GEOPAK\comidor\FDOTSS4.itl Name: Pavement AsphaitExisting ©) Componerts Constraints —_—
=2 Point Name List Help
= Description ] Display Point N
2] Components ot jsplay Poirt Names
Display Al Components

(21 End Conditions
(£ Examples{For Training)
23 Existing Feature Templates
3¢ CurbExdsting
s DrivewsyExisting
Ses¢. Guardrail Existing
==_PavedSh =

= TrafficSepExsting
3= WallBamerEdsting
[C] Bdsting Pavement Slope
(3 Linear Templates Common
(£ Median Condtions

[ Suface Templates

(1 Typical Sections (PPM) PVT_BOT

PVT_BOT_IN

Lbrary  Active Template +=Had-tD B
Test.

Preview:

d. Click Close to exit the dialog.
Use the Existing Features, Apply Surface Template to apply Surface Templates to each Clipped
Terrain.

=R A

Existing Features
 Te M S KX
= s

d K
o By A A
B f,re? Y I.Ii-'ixpply Surface Template |

Following the prompts on the end of the cursor, locate the Terrain Model and select the
ExFeature_SR61 Pavement Terrain.

( \"\ Create Surfaces B plz

General

a.

Existing Templates"Pavement Asphalt Exdsting (5]

Template
Apply External Clip Boundary

Locate Terrain Model

# Terrain Maedel: EX_SRE1
Level: DTM
Ref: Ref (GKLNRDO1.DGN)
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b. Uncheck the Apply External Clip Boundary to No, data point to accept.
c. Setthe Template to PavementAsphaltExisting.
Hint  The Template library can be opened by Selecting Alt+|.

d. Data point to accept that template. A surface will be applied to that terrain with the correct
feature. See next exercise to edit the Template depth.

3. Repeat this procedure for each of the Existing Feature Terrains shown in the table below.

Existing Feature

Terrain Name Existing Feature Template

Ex SR61 1 PavementAsphaltExisting
Ex_ SR61_Shld(s) PavedShldrExisting
Ex_SR61_SideRoad PavementAsphaltExisting
Ex_ SR61_Dwy(s) DrivewayExisting
Ex_US98 1 PavementAsphaltExisting
Ex_ US98_Shld(s) PavedShldrExisting

Ex_ US98_Dwy(s) DrivewayExisting

Ex_ US98 TS TrafficSepExisting

4. To view those Existing Features created in the 3D Model without the Existing Feature Terrain triangles,
toggle OFF the top triangles by using the F7 key to turn OFF the Construction class elements.
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Exercise 1.9  Edit Existing Feature Depth

1. To edit the Depth of the Existing Features Components once they have been place, click on the Existing
Features > Edit An Applied Surface Template icon.

Existing Features H
q fr oMt 8 ) K A xid R
W ,@ e A6

E ﬂe? 4 ({3 \"1 Edit An Applied Surface Template l

2. Select the surface template drop whose template needs editing. The Editing Roadway Design Template
Drop dialog (the interface is identical to the Template Library dialog) opens with the current template.

' Editing Roadway Designer Template Drop l 5]
File Edit Add Tools
Template Library: Cumert Templzte Display oK
{3 CAFDOTSS4_server\GEOPAK\oridor\FDO TS5 4.l Name: Pavement Asphalt Existing @ Components Constraints
“ZZ Poi Cancel
=2 Point Name List Feserpte ] Display Point Names —
[ Componerts
(2 End Condtons Display Al Components ki

2] Examples(For Training)
‘25 Busting Feature Templates
»={ CurbBdsting
3= DrivewayBxsting
»={ GuardrailExsting
= PavedShidrExisting
@ Pavement Asphalt Existing
== SidewalkExsting
3={ TrafficSepBxisting
= WallBamerEdsting
[ Budsting Pavement Slope
23 Linear Templates Comman
[23 Median Conditions
[0 Surface Templates
[Z Typical Sections (PPM)

PVT_BOT_IN damm

meww oy g ,
Preview: S
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3. On the left hand menu, navigate to the Parametric Constraints folder and double click on the
EOP_PvtThick item.

=-{Z7 Points

{:l Components

..{_7] End Condtion Branches
{:l Display Rules

-1 EQP_WidthOut Rt

07 Atemate Sufaces

{:l Poirt Feature Definitions
=27 Component Feature Defintions

4, Set the Default Value to -.5 and click OK.

O —
Default Value;
efault Value 0. 500000

5. Click OK to close the Editing Roadway Designer Template Drop dialog. You do not have to select
File > Save to save your edits.

Note Another Option is to open Project Explorer and navigate to the Terrain’s surface template and right
click to choose Edit and Applied Surface Template

-

% Project Explorer el

| & Links | M8 File| < Cwil Model | Civil Standards |

EI% Temain Models
=-F Temain Model: EX_SRE1_1

¥ _Jd < _SR61_1 Suface Templats

I Temain Model: EX_SRE1_Dwyl|gme  Delete Template
Hif: Temain Model: EX_SRE1_Dwy2 W8 Edit An Applied Surface Template I
- Temain Model: EX_SRE1_Dwy3 . - o
4 Temain Model: EX_SRET_Dwyd @ Synchronize Applied Surface Template with Library
i Temain Model: EX_SRE1_Dwy5
: Temain Model: EX_SRE1_Dwyb
t Temain Model: EX_SRE1_Dwy7

Temain Model: EX_SRE1_Dwy
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Exercise 1.10 Adding Curbs to the Existing Features

In this exercise a model of the existing curbs will be developed. In order to use the Civil Tools to create the
Existing Curb Model, MicroStation elements will need to be changed to Civil Features.

1. Select Ctrl + F1 to return to a One View only of the project.

2. Select the Existing Terrain Boundary, and when the Context Menu displays, click on the Set As Active
Terrain Model. This will allow for profiles to be displayed on elements.

3. Inthe Level Display dialog, right click on the Ref, GKLNRDO01.DGN, default-3D file and Uncheck the
display.

4. In the Level Display dialog, click on GKLNRDO1.DGN, default file, set the Active Level to
Miscellaneous3, and turn OFF all other Levels.
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5. Create a Selection of the median shapes made from the Back of Curb elements.

CATVCondC_ep

CATVCondD_ep
CATVMisc
CATVMisc_ep
CCTV

CCTV ep
CCTVAer
CCTVBur
CCTVMisc
CGBack_ep
CGep_ep
CGFace_ep

a. Use the Existing Features, Set Feature Definition to set the Back of Curb shapes to the Civil
Roadway Feature, CurbEXxisting.

Existing Features = A
A A 1~ L B
o By e B
E {? o i =~

C.rn[ Set Feature Definition l

v

b. On the Set Feature Definition dialog, set the Feature Type to Linear and navigate the Feature
Definition to Plans (2D) > CurbGutter > CurbExisting. The Name will automatically populate.

Feature

Feature Type Linear

Feature Definition  CurbBExdisting

Curb Existing

c. Data Point to apply Feature to the selected elements.
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6. Create a Selection of the median shapes made from the Existing Pavement (PavtAsphalt_ep) elements.

CATVCondC_ep

CATVCondD_ep
CATVMisc
CATVMisc_ep
CCTV

CCTV ep
CCTVAer
CCTVBur
CCTVMisc
CGBack_ep
CGep_ep
CGFace_ep

a. Usethe Existing Features, Set Feature Definition to set the Existing Pavement (PavtAsphalt_ep)
shapes to the Civil Roadway Feature, PavementExisting.

Existing Features H P

PR AN R

o By R

@

2N il

C‘.rc[ Set Feature Definition l

b

b. On the Set Feature Definition dialog, navigate to the Feature Definition to Plans (2D) >
PavementExisting. The Name will automatically populate.

Feature

Feature Type Linear El

Feature Definition  Pavemert Existing El

MName Pavemert Existing

c. Data point to apply Feature to the selected elements.

FDOT Roadway Design and 3D Modeling
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» Open Profile Model for Back of Curb

1. Turn ON the CGBack_ep level.
2. Select the Back of Curb shape and hover over the highlighted line until the Popup Menu displays.

3. Select the View Profile icon and select View 3 at the bottom of the MicroStation window to open the
Profile view, then select View 3.

ll10p

4. Inthe Profile view, select the Existing Ground Profile to display the Popup Menu and then select the
Set Active Profile icon. Close the Profile view window.

B View 3, Profile - CurbExisting37 =] =)
B~ AQQRHBEH ORC| F| -

TR
“'--l—-.l‘l- l--‘-".‘....’

e rawsaa
LT T
Swaa
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» Appling an Existing Curb Template

1. Use the Existing Features, Apply Linear Templates to create a 3D Existing Curb Feature.

Existing Features P
e R S PP R
WA B A
E *‘g_.?{{[& S

Crosslml -

Lock To Start
Start Station
Lock To End

End Station

Exterior Corner Sweep Angle

Mirror

Reflect

Template Existing Feature Templates'Curb Existing
Design Stage 1 Final

Diescription ExistingCurb

Chapter 1

a. Atthe prompt locate element and select the CurbExisting Feature (i.e. back of curb line).

b. Hold Alt down arrow key to pick the CurbExisting Template.

=J- C\FDOTS54_server\GEOPAK \comidor\FDOTSS4

+- Components

- End Conditions

- Examples(For Training}

- Existing Feature Templates

‘avement Asphalt Existing
idewalk Exdsting
raffic Sep Bxsting
i Wall BamierExisting

+)- Existing Pavement Slope

0)- Lingar Templates Common

- Median Conditions

- Surface Templates

o)- Typical Sections (PPM)

c. Press the Alt key to lock the Start and then data point. Press the Alt key to lock the End, and

then data point again.

d. Select the side to place the curb and data point outward from the back of curb.

e. Enter (OR> accept) 1 degree for the Exterior Corner Sweep Angle.

f.  Enter Existing Curb for the Description.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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2. Select the F2 Function Key to open the 3D model View. The 3D Curb bottom shape will appear in the
model.

3. Use Existing Feature, Add Corridor Reference tool to add the Template Target Feature,
PavementExisting, to the CurbExisting Template.

Existing Features HE
At § K A B R
Y1
E ’-’J@ [N |~

Eross 5ecti] Add Corridor Reference h

b4

a. At the prompt, select the CurbExisting corridor boundary element handle on level
CorrHndlIStg3_dp.

b. Select the PavementExisting line in front of the CurbExisting Feature.

c. Use the Selector tool to end the command.
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Note The Existing curb in the 3D model should stretch from the back to the edge of pavement as shown
in the image below.

@

Locate Cornidor
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Exercise 1.11 View Existing Cross Sections

Once the Existing Feature Terrains have been created a cross section view can be created to verify the model
data. In this exercise a base line in the TOPO reference file will be used to create a cross section view.

1. Use Reference Display to display the attached SURVRD01.DGN, TOPO or TOPORDO01.DGN file. This
file has the Survey Baseline elements displayed to use for cross sections.

2. Use Existing Features, Open Cross Sections in a View tool.

Existing Features = A
I3 N K O R
Y
E N i

| Open Cross Sections in a View

Cross Sections

3. At the prompt, select the Alignment shown below.

select the EX_US98
baseline

Level: BaselineSurvey
. R=f: 3 (TOPORDO1.DGN)

aah OGO ELEMENT (Plan / Profile Draw)
Twpe = LINE

4. Enter information in the dialog as shown:

Note Be sure to check the Station box or the Program may crash!
:, Open Cross Sect...l. = | |i:hj
¥| LeftOffset  -50.000000
¥| RightOffset 50.000000
| Station 0+00.00
| Interval 50.000000

5. Data point in the view to accept EACH of the settings from above.
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6. Open View 4 and data point in the view to display the Cross Section.

B View 4, Cross Section - Line E'@

View Properties [+ | |« < || 0+00.00 [=[ »

7. For the Cross Section View 4:
a. Notice many of the MicroStation Zoom, Pan, etc. commands will operate as normal.

b. Use the Cross Section View Navigation tools to examine the Existing Features.

c. Select View Properties and set the Vertical Exaggeration to 10 and then select the View to see
the changes.

B View 4, Cross Section - Line

View Properties |'| IEI -

@ Fit Section

Certer Backbone

Center on Cument Offsets
Backbone Screen Width: _ 0
Vertical Exaggemtinn:(inb_

Digplay Mull Points

Digplay Cut and Fill Graphics
Digplay Cut and Fill Values
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d. Select the Station pull down menu and change to Station 2+20, (i.e. key in 220 and Enter).

B Viewd, Cross Section - Line EI@
PR e —

44

p——
------
—
—

-
-

......

il e

8. Navigate the cross section stations and notice the blue line in the plan view designating the current cross
section view station.

Note This line will also appear in the Profile Model if open.

this line
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Exercise 1.12 Add Existing R/W Lines for Cross Section Viewing
1. Select CTRL + F1 to return to a single plan view of the GKLNRDO1.DGN file.
Hint  Optional: Turn OFF the Reference file display of the TOPO.

2. From MicroStation, select the menu Tools > Groups Menu > Create Complex Chain.

X laap: | UL T

Simplify geometry

3. Set the Active Level to RWLine_ep
Hint  Optional: Turn off all other levels

4. Set the Create Complex Chain Method to Automatic and chain together the RWL.ines in the active
file within the project Existing Terrain Limits.

chain these lines

N

) Creste Complex Crain] icnina w8

| Automatic ~ |
Max Gap: | 0.000033
Simplify geometry
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5. Create a Selection Set of RWL.ine_ep.

6. Use Existing Feature, Set Feature tool to create Civil Features of the RW lines in the selection set.

Existing Features BEERA
M [ X R
By R o

E -'”\ M =

= - —
CrJ Set Feature Definition l

a. Inthe Feature Definition, navigate and select the
RightofWayltems > RightofWayLine(Existing) Feature.

T e Festure Demionl =t ]

Feature -~

Feature Type Linear El

Feature Definition  PavementCrown EI
Name +| PipeHandrailGuiderail
—| -l RightofWayltems
@& EszsementPerpetuslE

& EasementPempetual(P| =
& Eazsement Temporary
& LimitedAccessRightof
& LimitedAccessRightof
& LimitsofConstruction
& Propertyline

& RightofWayLine(Prop
e o P a0 Y
m [3

b. The Name will be set to Exist. R/W.
c. Data point in the view to Apply Feature Definitions to elements.

d. Hover over an element to verify the new Feature Definition.

Complex Elernent: Exist, B/AW

Feature: RightofWayLine(Existing)
Mo Active Profile
Level: RWLine_ep
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Chapter 1

7. Select the line to display the Context Menu and select Open Profile Model.

8. At the cursor prompt, select View 3 to open and draw the profile.

Q- » A v [ Mutiodel Views = || ] 1|@|5|5|?|E‘

Dizplay complete

i

9. Select the line and select Set As Active Profile.

HinT  To create an offset profile line 2 feet below the surface, use the Vertical Geometry, Profile Offset

Transition Command in the Civil Tools Task Menu

B View 3, Profile - RWLELGE3
E-é-AQREHEBRE OB >

Set Az Active Profile

= B 5=

10. Repeat these steps for each of the R/W lines in the file.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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11. Use Existing Features, Open Cross Sections in a View tool.

Existing Features S
FER RS-

WA Y
B ’A&) AN £

| Open Cross Sections in a View L

b4

Cross Sections

a. Select the Baseline Survey line in the TOPO file as the Alignment.

Locate Corridor or Alignment |

Line
Level: BaselineSurvey
[ Ref: 3 (TOPORDO1.DGN)
aae COGO ELEMENT (Plan / Profile Draw)
Tvoe =LINE

b. Enter -100 feet for the Left Offset, data point in the view
c. Enter 100 feet for the Right Offset, data point in the view
d. Enter the Start Station value 0+00, data point in the view
e. Enter or lock the interval to 50 feet, data point in the view

f.  Open View 4 and data point to display the Cross Section.

12. The existing R/W lines appear on the cross sections.

B View 4, Cross Section - Line EI@
< < ] > »
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Exercise 1.13 Add Existing Utility Lines for Cross Section Viewing

1. Select Ctrl + F1 to return to a single plan view of the GKLNRDO1.DGN file.

2. Attach the Reference file C:\e\projects\22049555201\utilsS\UTEXRDO02.DGN

<OR> if the SURVRDO01.DGN file was used turn On the SURVRD, UTEX reference attachment.

Chapter 1

3. Onthe FDOTSS4 Menu, select the Design Apps > Reference Files> Copy Reference File Levels.

H Standard | CellApps | Actions || Design Apps

|| Roadway

Al IEEI]

€} Cleanup

O Draw

€) Custom Line Style

GEOPAK VBAs
Input-Cutput

Miscellanecus

Reference Files

Copy Reference File Levels

Text

Revisicns

| <
3

3

3

3

3

3

3

3 Attach External Reference Files
» Batch Attach Reference Files
Reference-Raster Cleanup Utility

Reference File Tools

Display All Reference Files
Display Mo Reference Files

a. On the Copy Reference File Levels dialog, from the Available Levels To Process column,

select the WaterB_ep item.

b. Click the “plus” sign to add it to the levels to process.

c. Click the Process button, close the

dialog.

Copy Reference File Levels *

=/dD

Available Levels To Process

TOPO ™ValveCvriWater_e ﬂ
TOPO ™ValveSewer_ep™
TOPO ™ValveWater_ep™
TOPO "™Valve_ep™

TOPO "™Vault_ep™

TOPO ™VentSewer_ep™

TOPO ™WaterMP_B_ep™
TOPO “WellMon_ep™
TOPO ™wWel_ep™

TOPO “Wetland_ep™
TOPO ™¥SPt_ep™

RWDTRDO1.DGM

Default!,

“Default™
"Leaderline_dp™
"RWLine™

“RWLine_ep™ ﬂ

TOPO ™Wall_ep™ -
TOPO “WaterEdge_ep™ B )
TOPO ™WaterMisc_ep™ {

(o |

Levels To Process

=

K1 I ]

W Turn Global Display Off

FDOT Roadway Design and 3D Modeling
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1-48

4. Turn OFF the Reference file display for the utilities.

5. Delete any WaterB_ep elements in the active file outside of the terrain boundary limits. They are not
necessary for the project limits.

6. Set the Active Level to WaterB_ep.

7. Use Create Complex Chain, set Method to Manual and chain together the WaterB_ep lines in the
active file within the project Existing Terrain Limits.

8. Create a Selection Set of Water_ep.

%4 Element.. — b

flozo » @
Eler=ae § ,
% | i
= (W | =
Level -

WallShidrBase_pxc
Wall Temp Bamier
Wall TempBamier_px
Water

Water_ex

B
WaterB_ep

WaterD _ep

WaterEdoge_ep

WaterFct

WaterFilter L

i ®

>

F iy

9. Use Existing Feature, Set Feature tool to create Civil Features of the Water Lines in the Selection
Set.

Note Existing and Proposed Utility features are located the Utilities folder in the Feature List

er'.? No Feature Definition

@ Mo Feature Definition
} Comidor Lines(3D)
Plan{2D)

-l Survey_Display

+- 1 Traffic Plans

&
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Note This folder will be shown when the Include Utilities Features box is checked on the FDOT Menu
Configuration dialog

' Standard Menu

Options Available with Standard Menu

[~ Construction [” Drainage

[ Geotechnical ¥ Roadway

[~ Traffic Plans [~ Traffic Control

" standard Plus Structures Menu
" Right-of-Way Menu

" Photogrammetry Menu

Existing Features = A
A3 3 ) X i

o By B

e

Cri Set Feature Definition }

b
Water Main, 10" Pipe (Quality Level B), Existing H
G- Reclaimed Water [+
i Sanitary Sewer
i Telephone (Aboveground)
8 Telephone (Underground) E|
¥ Unknown

-l Water

- @ Steam Pipes {Quality Level B), Edsting

- @ Steam Pipes (Quality Level C), Edsting

- @ Steam Pipes {Quality Level D), Existing

- @ Steam Pipes, Edsting

e
- @ Water Main, 10" Fipe {Quality Level C), Existing
- @ Water Main, 10" Pipe (Quality Level D), Existing

[

10. Data point in the view to Apply Feature Definitions to elements.
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11. Use the Selector tool to identify the new Feature and hover over an element to verify the new Feature
Definition.

Line String: 10" WM (B)
§ Feature: Water Main, 10" Pipe (Quality Level B), Existing

Mo Active Profile
Level: WaterB_ep

12. Select the line to display the Context Menu and select Open Profile Model.

vy .
.'.'llllﬂllllilllll*ll

= X
Open Profile Model

Ll{i.
e
s
f==
%C‘u

*
-
-
-
-
= .
a [
-
-
-
-
-
-
-
-
-
-
-
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13. At the cursor prompt, select View 3 to open and draw the profile.

O - O - M ~ [ Mubi-Model iews || T 1|@|5|5|?|5

Display complete L

——— —
- - — e e e

I\"---“_‘-‘lh——l--———l-

14. Set the sidebar tasks to Civil Tools.

File Edit Eement Settings Tools Liiities Worispace GEOP
File Edit Element Settings Tools LUtiities Workspace GEOPAK Window Subsurface Lty

EB-O-m5-8-E-a@-2-R-{@-o0-5e-B-@-2-8-8-0R3R

Tasks - 0% Tosks > 1%

W View1 - Top, Default

@

- A9

| 7 civil Tools
|33: FDOT Plans Development - |

ﬁ g:vﬂ?rﬂﬂ}iéiﬂrﬁ j":»mi :T:

Analysis & Reporting

then click here +-9 Subsurface Ltilties

+1- ¥ Drawing

ST Mrmwine Crmmseiinn

+
g
il 4 Main Classic
#
#

Ei General Geometry

15. To offset the Utility Profile line 3 feet below the existing Terrain surface, on the Civil Tools Task Menu,
select the Vertical Geometry > Profile Offset Transition tool.

BH vertical Geometry EE = A

BB s L e L D b A

R zatay
SIS

v A o
2L | -4 & lL E D 5P|'cfile Offset Transition

En

I.'-
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a.

f.

g.

Set the Placement Method to Single Offset.

i '\

[ E5
[~

=

:, Profile Offset

Placement Method  Single Offset
| Offset: -3.000000

Mirrar

Distance
Lock To Start ]
Start Distance | 0.000000
Lock To End 7
End Distance
Length
Feature
Name

Element Template MNone

L ~

Following the prompt on the cursor select the water profile line in View 3.
Enter -3.0 for the Offset value.

Press the — key and press Alt to lock the profile to the start point. Data point to accept the offset
and start point.

Press Alt to lock the profile to the end point and data point to accept the end point.
Set Mirror to No.

Data point to place the profile line the view.

16. Select the water profile line in View 3 and hover over it to display the Context Menu. Select Set As
Active Profile.

©2016 FDOT
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EXISTING TERRAIN AND FEATURES - Exercise Overview,

17. Press the F2 key to open the 3D view and view the 3D water line.

Current Active 30 Linear Elerment: 10" WM (B)
By Profile

Level: Water_ex

i
/
e
18. Repeat these steps for each of the Ultility Lines in the file.
19. Use Existing Features, Open Cross Sections in a View tool.
Existing Features HEREa
At R0 ¢ KA 2 K
@ ey A s
E 4@ S\ il |
. | Open Cross Sections in a View I
Cross Sections b

a. Select the Baseline Survey line in the TOPO reference file as the Alignment.

select the EX_1J598
baseline

j Locate Carrider or Alignment |

o Lins
Level: BaselineSurvey

i Ref: 3 (TOPORDD1.DGN)
il OGO ELEMENT (Plan / Profile Draw)
Tvoe = LINE

b. Enter -100 feet for the Left Offset, then data point in the view.
c. Enter 100 feet for the Right Offset, then data point in the view.

d. Enter the Start Station value 0+00, then data point in the view.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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e. Enter or lock the Interval to 50 feet, then data point in the view.
f.  Open View 4 and data point to display the Cross Section.
20. The existing Water Utility displays on the cross section.

B View 4, Cross Section - Line

View Properties |v| |4 =
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2 CENTERLINE ALIGNMENTS

INTRODUCTION
This chapter will introduce three (3) important OpenRoads Technologies for creating geometry/line work
while designing in FDOTSS4. They are:
e  Feature Definitions
e  Civil Geometry Design Intent

o Design Standards

FEATURE DEFINITIONS

As defined in the Bentley Civil Tools help files:

“Feature Definitions are used to control symbology, annotation, and various other properties
that are applied to the geometric elements. The feature definitions are built by using your
existing feature table from GEOPAK (DDB), InRoads (XIN), or MX (PSS). These existing
feature tables are utilized by way of a link to the file, plus the addition of more settings to enhance
capabilities. The feature definitions are used to:

o Define what the geometric elements actually are. What is being modeled such as curb,
centerline, edge of pavement, etcetera.

e  Control symbology in various views, including capability to define differing symbology
in plan, profile, and 3D spaces

e Define terrain modeling attributes (spot, break line, void, etcetera)
e Define surface display characteristics

An extensive FDOTCivilFeatures.dgnlib has been developed for the FDOTSS4 Workspace to be used for all
FDOT projects. All elements placed in the design file should have a defined Feature definition. The Civil
Geometry tools can be set with and Active FDOT Civil Features for element creation and assignment. They can
be viewed in the Project Explorer and in the Feature Toggle Bar.

CIVIL GEOMETRY - DESIGN INTENT

As defined in the Bentley Civil Tools help file:

“Design intent builds associations and relationships between civil elements. Object information
(how, where, and by what method it was created) is stored with the object to insure the original
intent is retained and honored in the design. If an element is modified, any related elements will
recreate themselves based on these stored relationships.

Civil Geometry or rule-base elements are created intelligently as the tools are used and elements are constructed.
The FDOTSS4 Workspace and design development workflow is highly dependent on using Civil Geometry for
the 2D plan layout rather than traditional MicroStation place elements tools.
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CiviL GEOMETRY DESIGN STANDARDS

Also known as Design Geometrics and Criteria and as defined in the Bentley Civil Tools help files:

“Design standards can be used to maintain required curvature and other alignment checks when
performing geometric layouts. They work at two levels:

e Provide values for the element creation tools (for example, minimum radius and
transition lengths)

e Check the suitability of complex elements (for example, check for kinks in the
alignment)

Design standards are very alignment oriented. You may find limited value for using design
standards for non-alignment computations.

When a design standard is violated, feedback is provided in two ways:

e Anicon in the graphics on the element that has the problem. Hover over the icon to
reveal a tool tip report of the error.

e Inthe Civil Message Center

An extensive FDOTDesignGeometricsCriteria.dgnlib has been developed for the FDOTSS4 Workspace to be
used for all FDOT projects. Alignments created in the design file either with Civil Geometry Tools or Imported
should have a set Design Geometrics Criteria. FDOT Design Geometrics Criteria can be viewed in the Project
Explorer and in the Design Standard Toggle Bar.

EXERCISE OVERVIEW

In this chapter exercise, the existing roadway Baselines for SR61 and US98 will be imported from a provided
(.gpk) file. A new Centerline of Construction for the SR61 roadway is required to improve the intersection with
US98. The new intersection will be located across from the School entrance on US98. It will be a 90 degree
angled intersection from US98. The centerline will require a new horizontal curve following the PPM design
guidelines as follows. In order to provide minimal property impacts to a local business on SR61 the alignment
will be offset from existing baseline to the west 30 feet and will re-join SR61 at a small skew that does not require
a horizontal curve.

Plans Preparation Manual, Volume 1
50 MPH

Design Geometrics and Criteria

Design Speed

2-2

Facility

Urban Arterial with Curb

Maximum Tangent Deflection w/out curve

1 degree Table 2.8.1a

Minimum Horizontal Radius

881 feet Table 2.83

Minimum Length of Curve

750 feet Table 2.8.2a

2.1 Import Baseline
2.2  Design New SR61 Centerline

2.3 Create ALGNRDO1 Stationing Annotation Models

2.4  Import Side Roads

©2016 FDOT

FDOT Roadway Design and 3D Modeling



CENTERLINE ALIGNMENTS - Import Baseline

Exercise 2.1  Import Baseline

Chapter 2

In this exercise, the user will create a new design file and import chains from the job00.gpk file provided from

the survey.

1. (Optional) Extract the 22049555201(2).zip file in the Data Set folder to the c:\e\projects folder.

2. From the desktop FDOTSS4 folder, double-click on the Create Files icon.

-

(=0 » roorss

File Edit View Tools Help

Qrganize « Include in library ~ Share with =+ Bumn

' Favorites ¥
M Desktop

& Downloads

] Recent Places

& OneDrive - Florida Department of Transportation
B sharePoint

B Desktop
4 Libraries
A Danforth, Vern
M Computer

.

New folder

(7 ClearCrash

) Create 3D Deliverables
i Create Files
oToMeeting

(| ECSO's Website

(a|FDOT CADD Suppert Community
[#5 FDOT XML Signing

[# FDOTS54 for PowerGEOPAK

[Ef) FileChecker

[\ Key Sheets

{2 LandXMLVisualizer

ML Quantity Rounder

3. Create a DSGNRDO1.dgn file with the dialog as shown below.

Create File/Proje

Froject: |C:\e\proiects\22ﬂ49555201

ﬂ Fraject Settings

Workspace: | FDOTSS4

Control File:  [ROADW®Y CTL

File Group: |F|Uadwa}' Design Files [DGM)
File Type:

jl
=y
= #

INTERSECTIOM/IMTERCHANGE DETAILS
INTERSECTION/IMTERCHANGE PROFILES
KEY SHEET

LATERAL DITCH CROSS SECTIONS
LATERAL DITCH PLAN / PROFILE SHEET
MITIGATION AREAS

MOTIF FILE FOR PLAN SHEETS

MOTIF FILE FOR PROFILE SHEETS

PL&N AND PROFILE SHEETS

PL&N SHEET

FOMND DESIGN

PROFILE SHEETS
PROJECT L&YOUT SHEETS
PROJECT NOTES

FROJECT PROFILE LAYOUT
FROPOSED DESIGH

POND <SECTIONS PATTERM LINES & SHAPES

PROPOSED DIGITAL TERRAIN SURFACE MODELS
PROPOSED PROFILE
MEAMTITY CIRPHTATIAN DFTAN S

Dutput File:  [DSGNRDOT

Output Folder: |F|Dadway\

Browse

Browse

SeedFil:  |fdotseed2d.dgn

SeedPath  [resources/seed/

Action: |de | platzcale;plotscale set
Create | Open File |

Active File for OpendEdit DSGNRDOT.DGH

L éopbboton_|

a. Click Create to create the file, DSGNRDO1.dgn.

b. Click Open File, DSGNRDO1.dgn displays.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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c. Set/Update Plot Scale displays. Use the default settings and click OK.
d. Click OK to close the Create File/Project dialog.

4. Ifthe SURVRD file exit, Use the Attach Survey Reference Files tool from the FDOT Menu. Otherwise
skip to step 7.

m Standard | CellApps Actions DesignApps| Roadway | 7 | <7 | [T Q D OI

(2 Cleanup 3

€) CustomLine Style » EI@
O Draw 3

€) GEOPAKVBAs 3

€) Input-Output 4

O Mizcellaneous 3

|O Reference Files 3 | Copy Reference File Levels

O Revisions 3 Attach External Reference Files

€ Text | Attach Survey Reference Files

Batch Attach Reference Files
Reference-Raster Cleanup Utility
Reference File Tools

Display All Reference Files
Display Mo Reference Files

5. Select the SURVRDO1.dgn file.

-

Name Date modified Type Size
eng_data 5/3/2010 File folder
E GOT GMN 11,/7/2013 Bentley MicroStati... 29
;J SURVRDO1.dgn Bentley Micro5tati... 6,3
4 I 3

6. From the MicroStation menu select File > References to view the attached files:

Toolz  Settings

.E_:Z - A;ﬁ fk i .4 D ¢ Q ﬂ)j 53 E,/ I_:} g:j é 7 Hiite Mode: | Boundaries - |

St ¥ 5 File Name Model Description Logical Crientation Presentation Visible Edges Gl
1 SURVRDO1.dgn Default Master Model TOPO Coincident - Word Wireframe Dynamic W N
2 SURVRDO1.dgn Default Master Modsl GDTM Coincident - Word Wireframe Dynamic W
3 SURVRDO1.dgn Default Master Modsl UTEX Coincident - Word Wireframe Dynamic W
4 SURVRDO1.dgn Default Master Modsl DREX Coincident - Word Wireframe Dynamic o

4 ] 3

Scale | 1.000000 1.000000 Rotation | 00°00°00" Offset X | 0.000000 Y | 0.000000

m!;, 1 __ 2 4 =l ] Nested Attachments: Mo Nesting x| Di A - 1

Mew Level Display: |Config Vanable ¥ | G 5
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7. From the MicroStation menu select File > References and attach the following files:
e  C:/lelprojects/survey/TOPORDO1.dgn (disregard if SURVRD exists)
e C:/lelprojects/rwmap/RWDTRDO01.dgn
e  C:/lelprojects/roadway/AERIALS.dgn

8. Fit View and Save Settings, select Ctrl F.

9. Change the Task Menu to Civil Tools.

Tasks

s MR View 1, Default

JTasks 3| BT o A& o Olmile
[@ FDOT Plans Development (=R S) Tasks

= Civil Tools
iy Claretic
FDOT PFlang Development
% Subsurface Lty Engineering
w.g Drawing

(- (3 Drawing Composition

MO 00

ﬁ l‘l‘"bi[\"b‘i >§'Fj‘r
& -

click here

Typical Se

Key Sheets

Roadway Plans

Existing Features - =

10. Use General Geometry, Import Geometry tool and select the job00.gpk file in the Roadway folder.

EHI. General Geometry —

'l @& O
Uz pdlrg

_\_'_{ W |
f.\[ Import Geometry }

R |55 48

B
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a. Navigate to the Alignment > No Features folder.
b. Click in each box to select BL98 and EX-61.

-
Import Geometry

=R C:\ENPROJECTSY2204955520 1\ROADWAY JOBOD.GPK

B- ._Nignment
=-[¥] MoFeature

|:| Curves
(-] Point List

Create Civil Rules

Import ] [ Cancel

" = S

c. Click Import.

11. Zoom to the intersection of EX-SR61 and US98, hover over the baseline to verify the alignment
imported in the previous step.

¥
e

F £
Complex Element: BL98
No Active Profile
Level: Default
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Chapter 2

12. Use Horizontal Geometry, Set Feature Definition tool.

< Horizontal Geometry H-E=I— Y
a1t @ Y
W - " [_Set Feature Definition ]

+

AN

a. Set the Feature Definition to Baseline(BL).

Feature

L)
Feature Type Linear El
[+l

Festure Definition  Baseline(BL)
Name BL

b. Select both EX-SR61 and US98 line, then click Reset to set the Baseline(BL) feature on the
lines.

c. Select the Element Selection to exit the command.

Tasks

[-—'. Civil Tools

. RN E

31 Elerment Selection ]

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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Exercise 2.2  Design New SR61 Centerline

This exercise will use several Construction lines to create the final Centerline as shown below.

ConstrLinesd

» ConstLinesl

1. Locate the Driveway into the school off US98 between the baseball field and the parking lot.

2. Now that the new intersection is located, turn the display OFF for the Aerial Reference file.
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3. Use the Horizontal Geometry, Line Between Points tool.

==
i
n
>

£ Horizontal Geometry
by . . -

a I 4, e '@ &
W @ e

L
E|. N

Line Between Points —_—
3 d’ e St r_l-l, BRATA

r
N~ ™

a. Use Feature Definition ConstLinesBlueDash and Name ConstLines1.

b. Starta line perpendicular to BL98 and ending at in the middle of the Driveway. Be careful not to
snap to anything on the second point.

Distance 63.175133
Line Direction 00°0000"

Feature -

Feature Definition  Constlines BIueDaEl

Name Constlines1
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» ConstrLines?2

1. Use Horizontal Geometry, Simple Line From Element tool.

=
I}
n
>

" Horizontal Geometry

' % @2
/N P

[

m

=] O [f'”{\.lE’impIF:I:ilel’FrcmElen'uent
T =N

2. Use Feature Definition ConstLinesBlueDash and Name ConstLines2

3. First select ConstLinesl, then use the AccuSnap to locate the beginning of the line at BL98.

TrimExtend Mone

¥| End Distance -2000.000000

Feature

Enter End Di=tance Feature Definition CnnstUnesBIueDaEl
End Distance | EININNIGIN | & gl Mz Constlines2

4. Enter a Distance of -2000 feet. Data point in the View to accept the Distance.

5. Data point to accept Trim None.

2-10 ©2016 FDOT FDOT Roadway Design and 3D Modeling



CENTERLINE ALIGNMENTS - Design New SR61 Centerline Chapter 2

» ConstrLines3

1. Use the Horizontal Geometry, Single Offset Entire Element tool.

£ Herizontal Geometry
a i %, e @ &
+

W ¢ e

E PN AT D |—‘
RO /7,0
2~

N T

- — t 1 Single Offset Entire Element
5 J’J r‘f \/_‘ -
2 Single Offset Partial

- A

2. Use Feature Definition ConstLinesBlueDash and Name ConstLines3.
3. Data point in the View to create a line -30 feet Offset to EX-61.
4. Uncheck the mirror option to No, and click in the View.

¥ Dffset
Mirror
Feature

Feature Definition ConstlinesBiusDal |

Name ConstLines3

5. Once the new line is created, turn the Display OFF for the TOPORD Reference file.
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Chapter 2

» ConstrLines4
Next step, create a line from the Offset line to intersect the EX-SR61 line at a 1 degree deflection angle.

1. Find the Azimuth angle of EX-61, select the element and click the Context Menu Description. Copy
the bearing value into the buffer space selecting Ctrl C <OR> right-click Copy.

Use the Horizontal Geometry, Line Between Points tool.

-
1}
[ ||
>

<. Horizontal Geometry
ol T e p
a1 R #
+

W ¢ @

R :lLIHE Between Points )] - J\;j
- |3 |3 » ol

T

3. Use Feature Definition ConstLinesBlueDash and Name ConstLines4.
4. Start a line at the intersection of ConstLine2 and ConstLine3 enter a value of 2000 feet for the Length
and use the Bearing in the buffer as the Line Direction minus 1 degree.

Enter End Point
Distance| ENTINIIN] | & [4» :
2000.000000

V| Distance
| Line Direction 100°56'19.86852788"

Feature ~

Feature Definition  ConstLinesBlue Dasl‘El

Constlinesd

MName

©2016 FDOT FDOT Roadway Design and 3D Modeling
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CENTERLINE ALIGNMENTS - Design New SR61 Centerline Chapter 2

5. Use MicroStation Trim to Element and extend the ConstLines4 line to intersect EX-61. This step will
create an interval element ConstLines5.

» Verify the Construction Lines Maintain Design Intent

1. Change the Active Level to Scratchl_dp. Use MicrosStion Drawing to Place Circlee with MicroStation
with a center at the end of ConstrLines5

2. Open View 4 and use Copy View from View 1. Zoom into the School Entrance in View 4

El & R % G

FDOT Roadway Design and 3D Modeling ©2016 FDOT 2-13



Chapter 2 CENTERLINE ALIGNMENTS - Exercise Overview

3. Move the location of the ConstLinesl and check the end of ConstLines5 to see if the location has been
corrected.

HinT  1: Select the first line and Use the manipulator tool handle in the middle to move parallel location.

Hint 2 Select ConstLines5, Use MicroStation Undo/ Redo to see the end change location.

endis
different

4. Select Ctrl Z to undo change.

5. (Extra Exercise) Change the Offset Distance of ConstrLines3 from -30 to -40 to verify that the end of
ConstrLines4 will change.

6. Select Ctrl Z to undo change.
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CENTERLINE ALIGNMENTS - Design New SR61 Centerline Chapter 2

» Construct a Horizontal Curve between ConstLines2 and ConstLines5 to Meet
Geometric Standards.

1. Use the General Geometry, Design Standards Toolbar.

=
i
n
>

it General Geometry
' @ % T .0
:I Dr:rlgn Stanu:laru:l Toolbar h
5 9
5 of

2. Set Active the Design Facility Standard to: Arterial, Flat, Urban, with Curbs, 50 MPH.

MPH {Arterials (FDO
MPH (Arterials |

ESMPH (Arerials (FD

+ ut Curb and Gutter (/

4~ Rolling Temain (Aterals (FOO 'T_[ eel;nue_-metri-:sCrHeria Design Library,
OT_DesignGeometrcsCriteria Design Library)

+ Fro nta:|-= F' vads (FDOT_DesignGeometricsCriteria Design Library]

- Interstate, Freew DOT_DesignGeometricsCriteria Design Library)

3. Activate the Toggle Active Design Standard icon.

Bt Design Standards Toolk |

7 | A, || Prterizls\Riat Termain\Urban'With Curb af ] | 50MPH

Toggle Active Design Standard

4. Use the Horizontal Geometry, Simple Arc tool.

HH
1}
[ ||
>

£ Horizontal Geometry

qs‘ﬁl"_@ &e?i

v 9 +¢+

= VRN PN
HO/"b -)@ Bt
AN |Slmple—\rcl
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5. Use Feature Definition ConstLinesBlueDash and Name ConstLines6

6. Create a Radius between ConstLine2 and ConstLine5 using the default value 881.4738, Set
Trim/Extend to Both.

Trim/Extend Both
¥| Radius 881.0000
Loop
Feature
Feature Definition  ConstLinesBlueDash

MName ConstLines5

N Atenals\Fat Terran\Uban\With Cub o w | | SOMPH
-

» Make a Longer Driveway into the School.
1. Use Horizontal Geometry, Line Between Elements tool;

Z Horizontal Geometry = A
W o

E v, YN

? ogpeenrone | N

12 ~

AR S S S S gl

2. Turn ON the TOPORD file.

3. Use Feature Definition ConstLinesBlueDash and Name ConstLines6.

4. First, snap to the end of the first Construction line placed, ConstLines1.
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CENTERLINE ALIGNMENTS - Design New SR61 Centerline Chapter 2

5. Then snap to the end of the Existing Centerline in the TOPORD file.

Note After the line is constructed a Warning icon may appear on the line because the Active Design
Standard icon is being toggled ON and the tangent length may be less than the minimum 100 feet.

» Next, Create a Centerline of All the ConstrLines.

1. Use the Horizontal Geometry, Complex by Element tool.

==
1]
n
>

<. Horizontal Geometry

. .

sl +‘
E N B K r‘
RO e A

T = Y

AT TS ARE

+
1- — ¥

T |

S J Complex By Elements |
>
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2. Create the new Alignment by connecting the elements.
Use Feature Definition Centerline(CL) and Name SR61,

with no spaces. Use the Manual Method. Method Marual

Maximum Gap 0.032808

Feature

Feature Definition  Centedine{CL)
Mame SRE1

3. Be careful to select at the school side first and near the start of the line.

(v )

Method Manual
Maximum Gap 0032308

Feature

Feature Definition Certerine{CL)
Name SRE1

Locate Next Element
Line From Element: Constlines?
Fea ConstLin

4. Continue until New Centerline is constructed as shown below.

Complex E\Em
Feature: CenterlTrreg

Mo Active Profile

Level: CLConst_dp

DDE FEATURE
Attribute = CLC
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CENTERLINE ALIGNMENTS - Design New SR61 Centerline

» Set a Begin Station Value at the Intersection of BL98

1.

a ~ wn

FDOT Roadway Design and 3D Modeling

Use the Horizontal Geometry, Start Station tool.

H
1]
[ ||
>

Z_ Horizontal Geometry

a I %, Y% @ %

W @
8, N, 7NV

RO /7@, 2N
T2~

Aﬁ?AT?ﬁIIE

3 RS
ctalt Station l_

s & = U (=

Set a Begin Station value of 700+00 at the intersection of SR61 and BL98.
Select the new SR61 Centerline(CL).

Use AccuSnap to locate the Intersection with BL98 and data point to accept.

Enter 70000 and select Enter <OR> data point to accept.

Yy,

©2016 FDOT
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Chapter 2 CENTERLINE ALIGNMENTS - Exercise Overview

» Describe the New Centerline Geometry

1. Use Horizontal Geometry, Horizontal Geometry Report tool.

£  Horizontal Geometry M= A
1 ' e @
"P' +¢+ [ Horizontal Geometry Report }

e/ N VNV

2. Select the SR61 Centerline (CL). Use the settings below at the prompt to generate the report shown.

Lock To Start
Start Station
Lock To End

End Station

Interval
[ Interval

Profile

[ Included Profiles Mone

Horizontal Alignment Review Report

Report Created: 7/29/2014
Time: 10:32am

Project: Default
Description:
File Name: C:\e\projects\22049555201\roadway\DSGNRDO1.DGN
Last Revised: 7/29/2014 10:30:42

Note: Allunits in this report are in feet unless specified otherwise.

mn

Alignment Name: SR61
Alignment Description:
Alignment Style: Centerline(CL)

Station Northing Easting
Element: Linear
POB () R1698+53.79 402573.996 2006962 466
Pl () R1699+55.72 402619.953 2006871.488
Tangential Direction: M B63*1186.7" W W
Tangential Length: 101.93
Element: Linear
Pl () R1699455.72 402619.953 2006871.488
Pl () R1700+00.00 402642100 2006833.142
Tangential Direction: N 59°5928.0" W
Tangential Length: 44.28
Element: Linear
Pl () R1700+00.00 402642.100 2006833.142
PC () R1 705+69.84 402927.098 2006339688
Tangential Direction: M 59°5925.0" W
Tangential Length: 569.84

Elnrnnmte Mirnnlar
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Chapter 2

Hint  Ifthe Stationing format is not displayed correctly, In the Bentley Civil Report Browser, select Tools Format

Options
SRR LSE - sl - Al
L —
File [ Tools | Help
IC\-P Stj"IE Sheet Root.. =811, 9%t
ed Format Options... £ x|
Q HonzorrtalPdlgnmentLengthxsl
PORH i al I Y TR, —w
f - A
Format Options u
Mode Precision Format Gose |
Morthing,/Easting: I 123 I
) Help
Blevation: 012 -
Angular: Degrees ;I Iu._-I ;I Iddd“mm'ss.s";l ™ Include Angular Suffic
Slope: ID_12 LI Iﬁﬂﬁé LI
Use Atemate Slope if Slope Exceeds: Iﬂ_{[ﬁ;
Altemate Slope: Iﬂ.-| _I Ig_ﬂ.q LI
Linear: 012 -
Station: Iﬂ.'IZ _.':: !5;_,55 =5 5 'I Delimiter: |+
Acres/Hectares: 012 -
Area Units: 012 -
Cubic Units: Iﬂ-| I ™ Convert to Cubic Yards
Direction: IBearingg =] |D_1 | Iddd mmsss” v
Face: IF-!jght Face vl
Vertical Observation: IZen'rth ,I
\

» Save the SR61 Centerline to the job00.gpk

1. Use the General Geometry, Export to Native tool and save the SR61 Centerline to the job00.gpk file.

ﬂl General Geometry

.

ol @™ O

W 7 [z}

E —:i;— >57| Export to Native |

ETI

FDOT Roadway Design and 3D Modeling
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CENTERLINE ALIGNMENTS - Exercise Overview

Exercise 2.3

2-22

1.

2.

3.

Create ALGNRDOL1 Stationing Annotation Models
From the FDOTSS4 menu, select Actions > Create/Edit File.

m Standard | CellApps | Actiuns“ Design Apps | Drainage Roadway | <7 | __||C'| |:|I

IE) Create/EditFile

[»  SetGeographic Coordinate System
€) SetPlot Scale of File

| oo e

£} Sheet Navigator

EX Sheets 3

Create an ALGNRDOL1.dgn file with the dialog as shown below.

(%) Create File/Project

= —E—

Project: | C:he\projectsh 22049555201

- | Froject Settingz

Workspace: | FDOTSS4

e |

Control File: [ ROADwAY.CTL

File Group: | Roadway Degign Files [DGMN]

- i

File Type:

YOUT
AUTOMAT ACHIMNE GUIDANCE MODEL [3D]
BACK, OF SIDE'WALK PROFILES

BORDER SHEET REFEREMCE FILE FOR PLAN SHEET
BORDER SHEET REFERENCE FILE FOR FLAWN/PROFILE SHEET
BORDER SHEET REFEREMCE FILE FOR PROFILE SHEET
BORDER SHEET REFEREMCE FILE FOR ®SECTION SHEET
B0 CULVERT WINGWALL DESIGN AND SPECIAL DETAILS
BRIDGE HYDRAULICS RECOMMENDATION SHEET

CLIP BORDERS

COMCRETE SLAR IMVENTORY

CURYVE OR CODRDINATE DATA SHEET

DIGITAL SIGNATURE [MULTI)

DIGITAL TERRAIN MODEL / TIM MODEL - 30

DRAIMAGE DETAIL SHEET

DRAIMAGE FLOOD DATA FORM

DRAIMAGE MAP

MB&IMAGE NPTIOMAI MATFRIALS TARII ATIOMN

BORDER SHEET REFEREMCE FILE FOR BRIDGE HYDRAULIC SHEET
BORDER SHEET REFEREMCE FILE FOR DRAIMNAGE MAP SHEET

Output File: ALGNRDO
Output Folder:  Roadway®,
Seed File: fdotzeed2d.dan

Seed Path: resources/seed/

Browse
Browse

Action: mdl | plotscale;platscale setmodel create desian ALGNI Apply Action

| Create | [ Open File ]
Active File for Open/Edit ALGMRDOT.DGM

—

Click Create to create the file, ALGNRDO1.dgn. Click Open File, ALGNRDO1.dgn displays. Click OK.

Note

This tool now creates multiple models to display Stationing at different scale once the Open File

button is clicked.

©2016 FDOT
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CENTERLINE ALIGNMENTS - Create ALGNRDO1 Stationing Annotation Models

4. Verify the Active Model in the design file is ALGNRD_50.

't Defautt Views

Name Madel

1 ALGNRD_10 Views ALGNRD_10
o ALGNRD_20 Views ALGNRD_20
' ALGNRD_30 Vie

WS ALGNRD_30

ALGNRD_40
ALGNRD_50

2 o T [& ALGNRD_100
s ALGNRD_200 Views ALGNRD_200
1 ALGNRD_400 Views ALGNRD_400
s ALGNRD_500 Views ALGNRD_500

T ALGNRD_1000 Views ALGNRD_1000
T ALGNRD_2000 Views ALGNRD_2000

Default

) ALGNRD_50 View ~ || 21 |[1]2]3]4]5] 6|72

5. In MicroStation, select GEOPAK > ROAD > Design & Computation Manager.

GEOPAK | Window 5

ubsurface Utilty Engineering  Help

| ROAD *| ROAD Tools

£ ’ Project Manager

| DRAINAGE 3
LAMDSCAPE p|  Active Chain Control

| WATER SEWER | Hement Attributes

l 3PC AdHoc Attribute: Manager
Training

User Preferences

Activate Map

Geometry

3

o

| Design & Computation Manager

Quantity Manager

Chapter 2

a. Navigate to the Roadway Design > Plan Features folder and select CL Centerline of

Construction (with stationing

).

H Design and Computation Manager = & P

g id

File Edt Settings Favortes Help

¢ on=

3 Topography
7 Structures

[ Roadway Design
[~ Plan Features

dh CACD Curve &
& CZ Clear Zone

& CAFDOTS5 3 geopak databases \FOOTS53.ddb

3 RW tems for Roadway Plans

& AS Archeological Sites

& BLDGP Buildings {Proposed)

BSW Back of Sidewalk

CI COGO Information

&b CL Centerline of Construction {with stationing)

Coordinate Data

g DITCH Ditch Line
DWY Driveway, Lane, Tumout

m

FDOT Roadway Design and 3D Modeling
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Chapter 2 CENTERLINE ALIGNMENTS - Exercise Overview

b. On the CL Centerline of Construction dialog, check the Place Influence box and click the
Draw Plan & Profile button.

Match Point Tesd
Draw Flan & Profile

C.

6. Onthe Draw Plan & Profile dialog,
a. Change the Element Type to Stationing.
b. Enter 50 for the Label Scale.

h Draw Plan &

ftem: entedine of Construction {with stationing)
Flement Type{( (Siatoning Jb_~] Label s@_
Key-n Points: il o

Select Chain to Diraw

EL92 Tick Marks
l |
EX-61 Tick Mark Stations
FRIENDSHIP : :
SRET ‘PC/PT/TS/CS/SC/ST/PI Labels!
Pl Labels

Small Ticks
[Ticks Left: Labels Left

Large Ticks
[Ticks Left: Labels Left

Control Point Labels
[ A= Per Preferences

2-24 ©2016 FDOT FDOT Roadway Design and 3D Modeling
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10.

c. Inthe Select Chain to Draw List box, select on SR61.

._hll Draw Plan & Profile

ltem: | CL Centerine of Construction {with stationing)

Blemert Type: | Stationing * | Label Scale: |50
Select Chain to Draw
BLS2 | Tick Marks

EX-61 | Tick Mark Stations
| FR P
c [sReT W] PC/PT/TS/CS/5C/ST/Pl Labels
| Pl Labels

Small Ticks
| Ticks Left: Labels Left

Large Ticks
| Ticks Left; Labels Left

Control Point Labels
| As Per Preferences

Chapter 2

Close each of the Design & Computation Manager dialogs (3) and click Fit View to see the results.

In MicroStation, select File > Save Settings <OR> select Ctrl F.

(Optional) Continue to add the Stationing Annotations by repeating these steps for the different scale

models.

Return / Open to the DSGNRDOL file and attach the Reference in the ALGNRDO1_50 Model file.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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Exercise 2.4  Import Side Roads %)} General Geometry

1. Use General Geometry, Import Geometry tool. al i *n ﬂ? » e@ P— D
2. Navigate to the Alignment > NoFeature folder. E Ty

E _::j Impert Geometry I
i e

E
i
i
»

3. Select the following GEOPAK chains from the job61.gpk file: Friendship, Friendship2.
Note This file may be named job61.0rg in the dataset, copy and rename it job61.gpk

a. Be certain to Uncheck the Profile before E-T]ELIEC i
clicking the Import button. E-C]JEMMETT

(-] EX-REUSE

-] EX-WATER

-] FISHHAWK

=-[Z]FRIENDSHIP

. @]Profile ‘

=-[#|FRIENDSHIPZ 4

. @]Profile

[#-[7|GREENLIN

[ HILLGREENE

E-LISA

E-CMILL

E-T10LD SRS1 2
4 i | »

4. Use Horizontal Geometry, Set Feature Definition tool.

<. Horizontal Geometry BMEERA

a I[d W, @ ¥

W —@- +..,3+ [_SetFeature Definitiu:un]

Y P
E-/ \"L |;f.jtF_

a. Setthe Feature Definition to Centerline(CL). Eeature

b. Select both FREINDSHIP and
FREINDSHIP2 line, then click Reset to set
the CenterLine(CL feature on the lines. Feature Definition Certerine{CL)

Feature Typs Linear

MName FREINDSHIP

Tasks

c. Select the Element Selection to exit the command. —
[». Civil Taals

o MRRERTEE
_1 E

lement Selection }
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3 2D PLANS

INTRODUCTION

This chapter will continue to use the OpenRoads Technology for Horizontal Geometry. Rather than use
traditional MicroStation element creation tools, these exercises will provide participants with practice using the
Civil Tools. Using Civil rule-based Feature Definitions assures design intent is incorporated into the two
dimensional (2D) plan layout. This will, in turn, prove valuable when design changes or “what if scenarios are
needed or tested.

This chapter also introduces two (2) important new OpenRoads Technologies for creating geometry / line
work while designing in FDOTSS4. They are:

e Civil AccuDraw
e Civil Cells

CiviL AccuDrRAw

As defined in the Bentley Civil Tools help files:

“Use Civil AccuDraw to allow precise input of points, whether the points are physical points or
end points of linear geometry. The Civil AccuDraw values can be persisted as rules on the points
by locking both values in the Civil AccuDraw input. Several methods can be used, among them
are:

e Distance and Direction, to set the order of ordinate entry to distance then direction,
with both sharing a common point of origin.

e Dist-Dir, to set the order of entry to distance for the first ordinate then direction for the
second ordinate, without a common point of origin.

e Dist-Dist, to set the order of entry to distance for the first ordinate then distance for the
second ordinate, without a common point of origin.

o XY, to set the order of ordinate entry to X-axis then Y-axis, with the two sharing a
common point of origin.

e DX DY, to set the order of ordinate entry to the difference in X coordinate then the
difference in the Y coordinate, with the two sharing a common point of origin.

e Station-Offset, to set the order of ordinate entry to station identification then offset
value, with both sharing a common point of origin

The delivered methods are those configured by default. These defaults can be edited, removed,
or additional methods may be added.

FDOT Roadway Design and 3D Modeling ©2016 FDOT 3-1



Chapter 3 2D PLANS - Civil Cells

CiviL CELLS

As defined in the Bentley Civil Tools help files:

“A civil cell is a collection of civil elements - geometry, templates, and terrain models - which
can be placed repeatedly in a design. The collection of civil elements will have been created
relative to one or more reference elements. When you place the civil cell, you choose the new
reference elements, and a new collection of civil elements is then created relative to them. A civil
cell can therefore be thought of as a copy of the original collection of civil elements, relative to
the geometry of the new reference elements. Civil cells can be 2D or 3D. They can consist of 2D
(plan) elements only, or 3D elements (2D elements with profiles), and can include terrains,
linear templates, area templates, and simple corridors.

When the new civil elements are created, all of the rules associated to them are also created.
This means that the new civil elements retain their relationships, both with each other and with
the reference elements, and therefore know how to react when these relationships change. In
addition, the Civil and MicroStation toolsets can still be used on the new civil elements, to adjust
and further refine the design as required, because there is no difference between a civil element
created by a civil tool, and one created by placing a civil cell.

Civil cells can save a lot of time and effort, because they replicate the complete series of steps
needed to create the civil elements. They also help to ensure compliance with design standards,
by making a civil cell available to the design team.

EXERCISE OVERVIEW

3.1  Preparation for 2D Plans

3.2  BL98 Milling Limits

3.3 BL98 Side Street

3.4 BL98 Widening

3.5 BL98 Widening Taper Line

3.6  For SR61 New Construction Template Lines

3.7 Add Right Turn lane on BL98

3.8 Add the School Entrance right Turn Lane off BL98 Intersection
3.9  Create/Edit the Intersection Curve Radii

3.10 Trim Back Sidewalk and Curb Lines to the Curve Radii

3.11 Use Civil Cell Technology to Place Curb and Sidewalk Around the Radii
3.12 Create a Custom Civil Cell for Other Radii

3.13 Place Left Turn with Traffic Separator

3.14 Place Right Turn Island

3.15 For BL98 Intersection Crosswalks Lines

3.16 Create BL98 Turnouts

3.17 For BL98 Intersection Shoulders

3.18 For Friendship Intersection
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Exercise 3.1  Preparation for 2D Plans
1. (Optional) Extract the 22049555201(3).zip file in the c:\e\projects folder.
2. Open the DSGNRDO1.dgn file of the c:\e\projects\22049555201\roadway\ folder in the FDOTSS4

Workspace in MicroStation.

Exercise 3.2 BL98 Milling Limi

ts

Chapter 3

In this exercise the exiting pavement edge lines from the TOPORD file are copied to be used as the Milling Lines

for the proposed improvements.

1. Use MicroStation References to attach and display the TOPORDO01 and RWDTRDO1 Reference files.

lools  Settings

H- B xe £¢RA0 0 B D 1% @ 5 tieve

Hierarchy

DSGNRDO1.DGN

d

[+] ¥ [ File Name Model Description
Aerials.dgn Default Master model
M RWDTRDO1.DGN Default Master model
-+ TOPORDO1.DGN Default Master model
ALGNRDO1.DGN ALGNRD_50 Global Origin aligne.

2. Use MicroStation Level Display to turn OFF all the TOPORDO1 Levels except the PavtAsphalt_ep.

Level Display - View 1

=l r——
E)NIL&E'M'

- DSGNRDOT.D

GN

vis TOPORDO1.DGN
vy ALGNRDO1.DGN, ALGNRD_5D

Wi Aerials.dan
vy RWDTRDO1.DGN

Name

Used

BankMent_ep
Bridge_ep
BridgeHe_ep
Building_ep
CGBack_ep
CGep_ep
CGFace_ep
ConcSlabs_ep
Deck_ep
Driveway_ep
DummyChains_ep
Fence_
HoodLight_ep
Gates_ep
GroundShot_ep
Handrail_ep
Hole_ep
Mailbox_ep
MizcEquip_ep
Pavemk_ep

PavtConc_ep
PaviCrown ep

FDOT Roadway Design and 3D Modeling
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Chapter 3 2D PLANS - BL98 Milling Limits

3. Use MicroStation References, Merge into Master tool to copy existing edge PavtAsphalt_ep lines
into the active DSGNRDOL file.

Tools Settings
Elv R B & ¥ D &3 SRR A) Fa <D 5B (@ > Hite Mode: [Boundaries ]
Hierarchy ] ¥ | FieName Modzl
= DSGNRDO1.DGN Aerials dgn Default
RWDTRMNT NN Default
v TOPOR  Aftach... Default
< ALGNF  Detach ALGNRD_50
Reload
Exchange
Open in Mew Session
Activate
Move
Copy
Scale
Botate
Scale | 1.000000 | Merge into Master | R
sl Ral Make Direct Attachment 1] = ]

4. Use the Horizontal Geometry, Line Between Points tool.

H
]
n
>

Horizontal Geometry
R PN T

T oeT

Line Between F'n:int:| — W
R T T, H‘f M

-

Yy

5. Create a PavementMilling(ML) line across the existing intersection of SR61 and BL98.

Distance 235231729
Line Direction 59°5205.3326349"

Feature -~

Feature Definition PavemerrtMiIIing[MLEl

Name ML
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Chapter 3

6. Use MicroStation Break Element on the PavtAsphalt _ep line string elements where the new
PavementMilling(ML) line intersects.

7. Repeat these steps for the other side roads along BL98.
8. Create a Selection Set of the PavtAsphalt_ep by level.

FDOT Roadway Design and 3D Modeling

Paret Tract Parcel Raw
ParkEquip_ep
PattemLines1_dp
PattemlinesZ2_dp
PattemLines3_dp
Pattemlines_ep
PavedMedianBase_px
Paveml_ep

Favers

Pavtfsph_ep
PavtAsphalt
PavtAsphaltt_pm

©2016 FDOT
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a. Subtract out of the Selection Set the Intersection lines at SR61; these will not be
PavementMilling(ML) lines.

Parent Track Parcel

Paret Tract Parcel Raw
ParkEquip_ep
Pattemlines1_dp
PattemLlines2_dp
Pattemlines3_dp
Pattemlines_ep
PavedMedianBase_px
Pavemk_ep

Pavers

PavtAsphalt
PavtAsphalt_pm

b. And also subtract out of the Selection Set the Intersection lines at Friendship Road.

PavtAsph_ep
ActivePoirtCell_dp
AdhocPoint_dp
AdviWamPanel
Aggregate
Alignment
Alignment Raw
ArchSite_ep
ArtificialCovering
ATDims
Attenuator
Attenuator_ep
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9. Use the Horizontal Geometry, Set Feature Definition tool.

H
]
n
>

Z_ Horizontal Geometry

2 b 4

wi - T | Set Feature Definition |
N A

E # ¥ * - “ |_

R O :.("," {_-u ",}* ﬂ* -‘\f T_\lﬂ

10. Data point to change the elements to the Feature Definition, PavementMilling(ML).

L]

Feature

Feature Type Linear El
Feature Definition Pavemerﬂl‘v‘lilling[l"ﬁEl

MName ML

11. Change the Selector tool back to New and verify the New Feature Definition by hovering over a line
until the Context Menu displays.

Line String: MLG
Feature: PavernentMilling(ML)
Mo Active Profile

Level: PavtMilling
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Exercise 3.3 BL98 Side Street
In this exercise Civil AccuDraw is used to help construct a side road centerline on BL98.

1. MicroStation AccuDraw and Civil AccuDraw should never be toggled ON at the same time because
both use some of the same Shortcut Key ins. Toggle OFF the MicroStation AccuDraw.

nc A\e\projects\2204955:

File Edt Eement Settings Tools Utities Workspace GEOPAK Window

Tasks

J Tasks
| % civil Tools

2. Use General Geometry, Civil AccuDraw tool to activate the Civil AccuDraw toolbar.

—.S

ii General Geometry -
A @™ O

W Z 2Ny

iy of

R | I:,’{ Activate Civil Accudraw Toolbar ]

3. Click on the Mode Station-Offset to toggle ON.
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2D PLANS - BL98 Side Street Chapter 3

4. Use the Horizontal Geometry, Line Between Points tool to create a ConstLineBlueDash line
perpendicular to the BL98 at Station 39+00 for a Length of 80 feet used as a side road centerline. Here
are the steps to use Civil AccuDraw with the Station Offset option:

< Horizontal Geometry =R A

am"?‘_ﬁ‘@*@i

+
W..p_'_.*

el oo |—

R d Line BEtv" /een Iin::u'ntr;l "\ J‘_}\.L

Important! on, the cursor prompt, tab to the offset field and use the Shortcut Key-in o, and select
the reference line BL98. The cursor will now track the station and offset.

Station | 277215 R1

Distance 30.723862
Line Direction 0070000

Feature

Feature Definition  ConstLinesBlueDash

MName CongtLines

(Select a reference element '}
or Reset to return to
lcommand.

a. For the first data point, set the Snap Locator button to Perpendicular, and select on the BL98.

Feature -~

sture Definition  ConstlinesBlue DaEl

ne ConstLines

E—
Enter Start Py

Complex Ele
Featire: Bas
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Chapter 3 2D PLANS - BL98 Side Street

b. For the second point tab to the Station field in the AccuDraw Cursor Prompt dialog, enter
Station value 39+00, select Enter to lock in on the station.

Feature ~

Feature Definition  Const LinesBIueDasl‘El

Name Constlines

Offset | [N
Enter End Point

c. Tab to the Offset field in the AccuDraw Cursor Prompt dialog, Enter Offset value 80, select
Enter to lock.

Feature ~

Feature Definition  ConstlinesBlue Dasl‘El

MName Constlines

Simion |35-0000R1 ) (R
Enter End Point
Distance| 80.000000

d. Data point in View to place the point.

Feature ~

Feature Definition Constl.inesBIueDaEl

Name ConstLines
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Exercise 3.4

BL98 Widening

In this exercise, the proposed Pavement Lines used for widening on BL98 are created at the following locations:

S'?'L??(-)I—N OFFSET LENGTH
1 28+00 16 feet 500 feet
2 33+00 32 feet 600 feet
3 30+00 -24 feet 300 feet
4 33+00 -24 feet 1000 feet

Locate Element <Alt> to Pick element in

1. Toggle OFF Civil AccuDraw tool.

Toggle Off

2. Use the Horizontal Geometry, Single Offset Partial tool.

==
]
n
>

2 Horizontal Geometry

by [ 3 yhe .-
4509, R @ ¥
\.\{ X \1—
bl
* L1 r h
E M
* L3 L3 - |—
RO [, »,40DN
T2y
A T AT S
- [— . ~ 1 1 Single Offset Entire Element
CINC i g —
|4_|- 2 Single Offset Partial
BB wvertical G i =0
= —" ) 3 Variable Offset Taper
& Terrain Model -
srrain fede -‘-:L 4  Ratio Defined Taper
an -

a. Select the BL98 line at the prompt to Locate Element.
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Chapter 3 2D PLANS - BL98 Widening

b. Fillin the Single Offset Partial dialog as shown below.

-

). Single Offset Partial | =0 |i:hlw

V| Offset: 16.000000

Mirror

Distance ~
Lock To Start

¥| Start Distance 23+00.00
Lock Te End

' End Distance |27+

(¥ =]
(%2}
(%3]
(4=

I ¥| Length S00. 000000
Feature Y
Feature Definition El
MName ECQOPA

c. Data point in the View to accept the Offset.
d. Data point in the View to accept Length.

Feature ~

Feature Definition  PavementAsphalt{EQOPA] =
ECPA

MName

e. Data Point in the View to accept No at the Mirror option prompt.

3. Repeat this procedure for each of the PavementAsphalt(EOPA) widening lines diagram and table
above.
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2D PLANS - BL98 Widening Taper Line Chapter 3

Exercise 3.5 BL98 Widening Taper Line

In This exercise a tapered Pavement Asphalt (EOPA) line off BL98 is created at the following location. Select
Alt to enter the End Station.

START START
STATION | OFEESET END STATION END OFFSET
39+00 20 feet Alt to end Station Lock Snap Nearest

=187-36:1

HinT  Toggle On the Civil AccuDraw.
1. Use the Horizontal Geometry, Variable Offset Taper tool.

< Horizontal Geometry -~

d 5 i, %ip '@ %

W g @

Single Offset Entire Element

0
| g
Y |/
o
-

] ]

I|I

1 1
=

i b 2 Single Offset Partial
EH vertical Seometry

Ll

Variable Offset Taper
™ Terrain Madel p—
Y 4 Ratio Defined Taper
- 2 P
fl corrider Modeling
= Open 'Offsets and Tapers' as Toolbox

2 30 Geometry

2. Select the BL98 element to offset from.
3. Enter the Station at 39+00 and select Enter to lock the value.

4. Tab to the Offset, enter 20 and select Enter to lock the value.
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Chapter 3 2D PLANS - BL98 Widening Taper Line

5. Data Point in the View to set the first point.

Start Parameters - <Alt= Lock To 5t
Start Offset | 20.000000 & 4
Station | EEISUEIITEY .%
Offset 20000000 |&

6. Select Alt key to lock the End Station value.

7. Set the AccuSnap tool to Nearest, hover over the right PavmentMilling(ML) until the Snap Mode
displays.

End Parameters - <Alt> UnLock
From End

End Ofiset |[EEE | [

Complex Element: Consilines8
Feature: PavementAsphalt(EOPA)
Mo Active Profile

Level: Pavtisphalt

8. Data Point to place the second point and complete the command.
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2D PLANS - For SR61 New Construction Template Lines Chapter 3

Exercise 3.6  For SR61 New Construction Template Lines

First, it is necessary to create a Template Limits line for the Project Typical PPM Civil Cell. This is a Construction
type element which is used to define the Begin and End Station limits.

1.  Use the Horizontal Geometry, Single Offset Partial tool.

" Horizontal Geometry H
4, ' @ 2
W g o
SR T -
], N VANl
RO _/ﬁ(_u’ 21
T2y
N2 AT L S

1 Single Offset Entire Element

.
(3]

§ Y

BB vertical Geometry

Single Offset Partial

L

Variable Offset Taper

& Terrain Model . '
Ratio Defined Taper

e

[ -

2. Create a Feature line, ConstLinesGreen.
a. Select the SR61 Centerline(CL).
b. Set the Offset to 0.00.

c. For the first point, set AccuSnap to Intersection and select the intersection of SR61 and BL98.

End Lhstance  F34+96.1/7 H1

~ Length 3446 171056

Feature B

Feature Definition  ConstLinesGreen El

MName ConstLines

Start Parameters - <ilts Lock T
o1 (0.000000 &4

Complex ETement. BLS2
Featirs: BazalinalRl 4
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Chapter 3 2D PLANS - For SR61 New Construction Template Lines

d. For the second point, zoom out to the first intersection after the end of the SR61 curve and snap
to the right PavementMilling(ML) of existing SR61 <OR> Key in Station 716+50.

V| Offset: 0.000000

Mirror

Distance

Lock To Start

Start Distance 169.175133
Lock Te End

End Distance 2546 654331
Length 2377 479638

Feature -~

Feature Definition  ConstLinesGreen El

Name Constlines

HinT  Use Intersect Snap and to place first point and Key Point snap for the second point.
3. Use Civil Cells task, Place Civil Cell tool.

=
1]
n
b

S Civil Cells

| Place Civil Cell |

F= 2m maarmERRr s

a. Navigate to the FDOT_Templates.dgnlib, 4 Lane Divided Arterial(45 MPH or Less) and select
PPMEXHIBIT TYPS5.

7 Active DGN

+)- FDOT_Driveways.dgniib, Defauk

i1 FDOT_Intersections danlib, Defaul
FDOT_SidewslkCurbRamps.dgnlib, Default

: - FDOT_Templates danlib, 2-Lane 2-Way Aterial_Collector

- FDOT_Templates dgniib, 4 Lane Divided Arterial_Collector

+]- FDOT_Templates.daniib, 4 Lane Divided Interstate System

+- FDOT_Templates.daniib, & Lane Divided Atterial (Inside Shoulder_
- FDOT_Templates.dgnlib, & Lane Divided Aterial
FDOT_Templates.danlib, 5 Lane Undivided Arteria_Collector Minir
: FDOT_Templates.daniib, 5 Lane Undivided Arterial_Collector

: - FDOT_Templates.danlib. 4 Lane Divided Arterial {Urban Ditch)

- FDOT_Templates dgnlib, 4 Lane Divided Arterial {55 MPH or Less
|- FDOT_Templates.daniib, 4 Lane Divided Atterial (45 MPH or Less

- FDOT_Templstes.dgniib, Ramp B
+ FDOT_Templates.dgnlib, Ramp C
i FDOT_Templates.danlib, Shared Use Path

b. Click OK and follow the prompts to complete the Place Civil Cell command.
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2D PLANS - For SR61 New Construction Template Lines Chapter 3

c. Locate Reference Element, select the GreenConstLine.
HinT  Use the tab key to after clicking on an element to get to the last place GreenConstLine.
d. Resetto Skip View Alternates.

e. Data point to accept Civil Cell Placement.

Accept Civil Cell Placement
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Chapter 3 2D PLANS - For SR61 New Construction Template Lines

4. Change the Front Sidewalk Utility Strip Width to Oft and the Sidewalk Width to 6ft,

a. Select the SidewalkFront Feature and zoom to find the Context Menu near the middle of the
element.

=

Change the SidewalkFront Dimension from 3 to 0.
c. Change the SidewalkBack from 5 to 6.
d. Repeat this for both sides of the roadway.
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2D PLANS - Add Right Turn Lane on BL98 Chapter 3

Exercise 3.7 Add Right Turn Lane on BL98
This exercise uses Civil Cells to add a right turn lane to the BL98.
1. Use Civil Cells, Place Civil Cell tool.

H
i
n
>

= Civil Cells

Place Civil Cell

= 2m e nrAEFRT

A

2. From the Place Civil Cell dialog, navigate to the FDOT _Intersections.dgnlib and select Right Turn
Lane.

N
Pick Cvil Cel =

Active DGN - =
FDOT_Curb Transitions.dgnlib, Default i Q' q' (el
FDOT_Driveways.dgnlib, Default
FDOT_Intersections dgnlib, Default
- CurbSidewalk Lines

- TSNose

- Left Tum with TS

Side Road Tumout

mEe

m

Right Tum lsland
i Left Tum Lane w. Curb Median

H- FDOT_SidewalkCurbRamps dgnlib, Default

H- FDOT_SidewalkCurb TEST danlib, Default

H- FDOT_Templates.dgnlib, 2-Lane 2-Way Arterial_Collector n

H- FDOT_Templates dgnlib, 4 Lane Divided Arterial_Collector 4
H- FDOT_Templates.dgnlib, 4 Lane Divided Interstate System
t]
H
t]
L

- FOOT_Templates dgnlib, & Lane Divided Arterial (Inside Shoul
- FDOT_Templates.danlib, 6 Lane Divided Arteral

- FOOT_Templates dgnlib, 5 Lane Undivided Arteria_Collector ©
FNOT Temnlates danlibh_ R | ane IInrliuirl:n.-l Aderal Callertar |
1 ¥

E S O ey W O oy O o O e Oy Y O

l 0K I l Cancel

3. At the prompt, for the first Reference, select the widening PavementAshaplt(EOP) line.
4. For the second Reference, select the SR61 Right EOP Out PavementAshaplt(EOP).

5. Reset to Skip Elements to View Alternatives.
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Chapter 3 2D PLANS - Add Right Turn Lane on BL98

6. Data point to accept Civil Cell Placement. The right turn lane is added.

Civil Cell Name Fight Tum Lane [

7. Edit the storage length for first Right Turn Lane placed, select the tangent line and change the Length
from 135 to 500 feet.

i _

8. Use MicroStation Trim to Intersection to correct the PavementAsphalt(EOPA) lines.
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Exercise 3.8  Add the School Entrance Right Turn Lane off BL98 Intersection
1. Use the Horizontal Geometry, Single Offset Partial tool.

" Horizontal Geometry

"m]

*

RO /M 00

==
1]
]|
>

T
2T AT SIS
s Y [Single Offset Partial |

2. Create the side road PavementAsphalt(EOPA) opposite SR61 left offset -23 feet.

a. For the beginnin

g, snap to beginning of SR61.

b. For the end, snap to the BL98 widening line end point at SR61.

c. Uncheck Mirror to set to No.

FDOT Roadway Design and 3D Modeling

©2016 FDOT

snap here to
for end point

snap here to
for beginning
point
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Chapter 3 2D PLANS - Add the School Entrance Right Turn Lane off BL98 Intersection

3. For the opposite side, use the Horizontal Geometry, Single Offset Partial tool.

" Horizontal Geometry EEEA
1 e g 3
1 R S
oL +
e /SN YO T
B L ¥ p =1
R R Wl
O ¢, 0/AMNN
SIRN
N 7 T*— B — -7~
1 r"H ?=. ’ ,r"; A -:_’.'.r‘ l—i'—d—'lﬂ-‘-‘-l
s MY [ Single Offset Partial |

4. Create the side road PavementAsphalt(EOPA) opposite SR61 Left Offset 39 feet.
a. For the beginning, snap to beginning of SR61.
b. For the end, snap to the BL98 widening line end point at SR61.

c. Uncheck Mirror to set to No.

HINT  If necessary, Let the tool place the line on the opposite side and edit it after it is placed

) —
I —

snap here to
for end point

snap here to
for beginning
point
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2D PLANS - Add the School Entrance Right Turn Lane off BL98 Intersection Chapter 3

5. Add another Right Turn Lane Civil Cell on the opposite side of the intersection.

2L civil cells HEE

A

a. Atthe prompt, for the first Reference, select the widening PavementAshaplt(EOPA) line.

b. For the second Reference, select the intersection PavementAshaplt(EOPA) line.

)
Locate Ref Element: P;
(EQOPA) (1/2)

c. Data point to accept Civil Cell Placement. The Right Turn Lane is added.

6. Click onthe Select Tool Set icon to exit the Place =
Civil Cell command <OR> F6 Function Key. J

asks - |

| & Civil Tools |'
QR A 2L A XL ®

Analysis & Reporting W
i General Geometry w

Hariznntal Genmeatre LT

7. Edit the storage length for the second Right Turn Lane placed, select the tangent line and change the
Length from 135 to 365 feet. Change the lane width to -16 feet.

£ v IS 1bd
T__ i —a
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Exercise 3.9 Create/Edit the Intersection Curve Radii

1. Use the Horizontal Geometry, Simple Arc tool.

=
1}
n
»

2 Horizontal Geometry

4%, @ 7
Wog- o
DN s
RO /&, M
o)

" F

"

- r T e —— ==
2. Create/Edit the Curve returns.

3. Select Feature Definition, PavementAsphalt(EOPA) to place remaining curve radii.

4. Follow the cursor prompt to select the two Roadway PavementAsphalt(EOPA) reference lines.

HiNT  Select the two PavementAsphalt(EOPA) in each quadrant. Use the value shown and trim both for each of
the following quadrants: Southwest 110 feet,
Southeast 60 feet,
Northeast 60 feet,
Northwest 60 feet

Trim/Extend None
7] Radius 110.000000
Select Construction Sector
Loop
Y AI0. 000000, K
Feature -~ \
Feature Definition  PavemertAsphat(EOPA =] ¥
Name SW EOPA 2

—i
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ais

FDOT Roadway Design and 3D Modeling

Chapter 3

©2016 FDOT

Trim'Extend  Both
¥| Radius 60.000000
Loop
Feature -~

Feature Definition  PavementAsphaltEQPA |

Name E EOPA

Select Construction Sector
Radius | [HRyHEI] %
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2D PLANS - Create/Edit the Intersection Curve Radii

5.

6.

I| \-‘-

Select F11 to open the Project Explorer menu options; change the tab to Civil Model.

% Project Explorer

= 22

e —
B Links File | [ Survey | € Cwil MUdE?["Q Civil Standards

= o Civil Data
Active Design
file

-

DSGMNRDO1.DGN, Defautt

M- G i

Navigate to the Civil Cells listed in the active design file, right click on each and select Drop Civil Cell.
This allows for editing the Civil Geometry elements individually in future exercises.

% Project Explorer

[P

= Links File | [ Survey| < Civil Model |9 Civil Standards
=--._ Civil Data

=2 DSGNRDO1.DGN, Defaut
-~" Linear Elements
-4 Point Elements
2 3D Linear Hements

Corridor Compenent Quantities
Drop Civil Cell
Place Civil Cell

Civil Objects
Referenced Models
Process Civil Cell

Delete

g x

Properties

©2016 FDOT
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2D PLANS - Trim Back Sidewalk and Curb Lines to the Curve Radii

Exercise 3.10 Trim Back Sidewalk and Curb Lines to the Curve Radii
This exercise takes advantage of design intent to modify the curb and sidewalk lines off SR61 to the new curve
radius end point.
1. Selectthe LT _CURB_FACE_OUT line.

Complex Element: LT_CURB_FACE_OU
Feature: CurbGutterTypeF

Mo Active Profile

Level: CurbFace

|

2. When the Context Manipulators display, zoom into the beginning point and select the Start Station
handle OR the Station value to move the end.

0+00.00
-1.500000

Start Station
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Chapter 3 2D PLANS - Trim Back Sidewalk and Curb Lines to the Curve Radii

3. Drag the handle while zooming out and select the End Radius point to move the point.

move it to this

Attribute = EQOPA
ADHOC ATTRIBUTE
Pavement Thickness (Mumeric) = 0.250000

Base Extension W {h ric) = 0.333000
Extend Base Under Curb (String) = N
Widen_Side (String) = LEFT
EQP_Widening_Profile (String) = none

4. Notice the results. The curb and sidewalk move as one because of the built in design intent relationship.

|

5. Repeat these steps to move the RT_CURB_FACE_OUT line back to the curve radius on the right
Roadway.
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Exercise 3.11 Use Civil Cell Technology to Place Curb and Sidewalk Around the Radii
1. Select Civil Cells, Place Civil Cell tool.

2= Civil Cells BRERA
=2 2 manmmarmr i

2. Navigate to the FDOT _ Intersections.dgnlib and select the CurbSidewalkLines civil cell.

1 Active DGN
- FDOT_Driveways dgrlib, Defautt
|- FDOT_Irtersections.dgnlib, Defautt
i~ 4 Lane Div > 55 (PPM Exhibit 13)
- Basic Left Tum
- Left Tum with TS
ide Road Tumout
- Left Tum with TS_tim
- Right Tum Lane
- T5Nose

- Right Tum lsland
- FDOT_SidewalkCurbRamps dgnlib, Default
- FDOT_Templates dgnlib, 2-Lane 2-Way Arterial_Collector
- FDOT_Templates danlib, 4 Lane Divided Arteral_Collector
- FDOT_Templates danlib, 4 Lane Divided Interstate System
- FDOT_Templates danlib, § Lane Divided Artenal (Inside Shoul
- FDOT_Templates darlib, § Lane Divided Arterial
- FDOT_Templates danlib, 5 Lane Undivided Arteria_Collector b il

4. FONT_Temnlataz darlih_F | ane Lndivided Ateral Collsctor
m 3

3. Atthe prompt, select the SW EOPA radius line, reset to View Alternates and then data point to accept
the Civil Cell Placement.

place these lines
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Chapter 3 2D PLANS - Use Civil Cell Technology to Place Curb and Sidewalk Around the Radii

4. Edit the SidewalkFront to be 0 feet from the CurbBack line at the middle of the element.

5. Edit the SidewalkBack line to be 6 feet from the SidewalkFront line of the element.
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Exercise 3.12 Create a Custom Civil Cell for Other Radii
1. Select Civil Cells, Drop Civil Cell tool.

=
1]
n
>

= Civil Cells

| Drop Civil Cell |

L N T e

2. Select the CurbSidewalkLines Civil Cell in the View and data point to drop the Civil Cell.

HiNT  Move the cursor over the curb or sidewalk lines to see it highlight

Locate Civil Cell

Civil Cell
Level: Default

3. Use Civil Cells, Create Civil Cell tool.

==
Il
n
4

S Civil Cells

ST

—, | Create Civil Cell |

a. Enter the Civil Cell Name: Custom CurbandSidewalkLines.

Civil Cell Mame  Custom CurbandSidewalkLines

Reference Name  Optional Blement

Lt R R TN stom Curband SidewalkLines

b. Data point to accept the new Name.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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Chapter 3 2D PLANS - Create a Custom Civil Cell for Other Radii

c. Atthe prompt, locate Reference Element and select the SW EOPA line.

Locate Reference Element

d. Resetto Locate Reference Element.
e. Reset to Optional Reference.
f. Data Point to accept Civil Cell.
4. Use the new Civil Cell to place for the other Radii; use Civil Cell, Place Civil Cell tool.

= civil cells BHEERA
Q =t r“—'f o

Pl Ciwil Cell
[ o -1 F]ﬁmnaci.l - = |- LY

a. If the Custom CurbandSidewalkLines is not active, navigate to the Active DGN and select it
from the list. Click OK.

Active DGN
! - Right Tum Lane
- Right Tum Lane1
-PPM EXHIBIT TYP-5

tl- FDOT_Driveways.dgnlib, Defautt

71 FDOT_lrtersections. daniib, Default

- FDOT_SidewalkCurbRamps dgnlib, Default

- FDOT_Templates.danlib, 2-Lane 2-Way Arteral_Collector

- FDOT_Templates.danlib, 4 Lane Divided Arterial_Collector

- FDOT_Templates.danlib, 4 Lane Divided Interstate System

- FDOT_Templates.danlib, & Lane Divided Arteral {Inside Shoul!
- FDOT_Templates. danlib, & Lane Divided Arterial

- FDOT_Templates.danlib, 5 Lane Undivided Arteria_Collector M
- FOOT_Templates. danlib, 5 Lane Undivided Arteral_Collector
- FDOT_Templates.danlib, 4 Lane Divided Arterial {Urban Ditch)
- FDOT_Templates.danlib, 4 Lane Divided Arteral {55 MPH or L
- FDOT_Templates.dgniib, 4 Lane Divided Arterial {45 MPH or L
il FDOT_Templates dgniib. Ramp B

4. FONT Tamnlstes danlih Ramn
1
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b. At the prompt, select the NW EOPA Radius line.

Locate Reference Element: Pavementisphalt
(EORA)

Chapter 3

c. At the prompt, select Element to View Alternatives, move the cursor over the EOP line and
click on the Arrow to reflect the Civil Cell to the correct side.

FDOT Roadway Design and 3D Modeling

Selﬂc:t Elements to View Alternatives (Reset to

Skip)

W EOPA

D Faven

rentsphalt(EOPA)

Mo Active Profile

Level: Pavthsphalt

DOE FEATURE

Attribute = EQOPA

ADHOC ATTRIBUTE

FPavement Thickness (Numenc) = 0.250000
Base Thickness (Numeric) = 1.000000
Base Extension ‘Width (Numeric) = 0.233000
Extend Base Under Curb (String) =N
\wfiden_Side (String) = LEFT
ECP_\widening_Profile (String) = none

©2016 FDOT
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Chapter 3 2D PLANS - Create a Custom Civil Cell for Other Radii

d. Resetto View alternates.

e. Data Point to accept the Civil Cell Placement.

5. Repeat these steps to place the Custom CurbandSidewalkLines Civil Cell on the NE EOPA Radius.

T il
ocate ce Flement: PxrementAsphalt
p
.. Place Civil Cell E!E
Civil Cell Name Custom CurbandSidewalk Lines (-]
.

MNE EOP line to add Civil
Cell

6. Leave the SE Radius without curb and sidewalk.
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Exercise 3.13 Place Left Turn with Traffic Separator
1. Use Civil Cells, Place Civil Cell tool.

H
i
n
>

= Civil Cells

2 | 2

—{ Place Civil Cell }

= 2m e nrAEFRT A

a. Navigate to the FDOT _Intersections.dgnlib and select Left Turn with TS civil cell.

+- Active DGN

+)- FDOT_Driveways.dgnlib, Default

- DOT_Intersections.dgnlib, Default
- 4 Lane Div > 55 (PPM Exhibit 13)

Basic Left Tum

Side Road Tumout

Left Tum with TS_trim

Right Tum Lane

T5Nose

CurbSidewalkLines

i Right Tum Island

+- FDOT_SidewalkCurbRamps.danlib, Default
- FDOT_Templates dgnlib, 2-Lane 2-Way Areral_Collector
- FDOT_Templates dgniib, 4 Lane Divided Arterial_Collector
- FDOT_Templates. dgnlib, 4 Lane Divided Interstate System
- FDOT_Templates dgniib, 6 Lane Divided Atterial (Inside Shoul
- FDOT_Templates.dgnlib, & Lane Divided Aterial
- FDOT_Templates.dgnlib, 5 Lane Undivided Arteria_Collector I

4. FNOT Temnistes danlih & | 2ne Lndivided Arerisl Collactor
T 3

b. At the Locate Reference Element Centerline, select the BL98 line in the View.

Civil Cell Name Left Tum with TS

Locate Reference Elel

c. At the Locate Reference Element PavementAsphalt(EOPA), select the RT_PVT_EOP_IN line
in the View.
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Hint  For the direction of travel |, this is always the left median EOP line

Civil Cell Name Left Tum with TS [

Locate Reference Element: Pavementdsphalt
(EQPA) (2/2)

Complex Element: RT_PWT_ECP_IN
Feature: Pavementisphalt{ EQPA)

Mo Active Profile

Level: PavtAsphalt

d. Click on the Arrow of both Reference Elements to View Alternates, when the Green Turning
Radius and Traffic Separator are both in the correct place, Reset to skip.

traffic
separatar

Select Elements to View Alternatives (Reset to
kip)

turning
radius
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2D PLANS - Place Left Turn with Traffic Separator Chapter 3

e. Data point to accept the Civil Cell Placement and view the left turn lane on SR61 at BL98
Intersection.

2. Use MicroStation Trim to Intersection tool.

Tacsks > 3 X

J'Tasks hd |
| & Civil Toals |‘

B View 1, Defau

g = «@ O~

-

[ O | = LG DAY
RPN P ;
112} 3", 49,6 6,1l 1 Modify Element
Analysis & Reporting Eﬁ 5> BreskEl .
2 Break Elemen
i General Geometry A
: Vi 3 bBdend Line
4 Horizontal Geometry ] ]
A 4 Trim To Intersection
HH vertical Geometry _
~ ). 5 Tnm To Element
Terrain Model
k& Triem Multinle
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Chapter 3 2D PLANS - Place Left Turn with Traffic Separator

3. Trim the curb median elements at the begin taper as shown.

4. Use MicroStation Trim to Element tool.

Tasks

J'Tasks
| & Civil Tools

. o | i3 Jo b W DD
P . W
Fu) 3""3T’—%’ﬂ?’ﬁ:"’ﬂ 1 Modify Element
Analysis & Reporting E\.ﬁ 3 Break Element
ﬂiGeneralGenmetw "3 Extend Li
o 3 end Line
. Horizontal Geometr -
i A 4 Trim To Intersection
BH vertical Geometry I ]
e 5 Trnm To Element
& Terrain Model
1 6 Trim Multiple

5. Trim the elements at the Curb Median lines at the Traffic Separator as shown, leave the green line.

frim these lines
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2D PLANS - Place Left Turn with Traffic Separator Chapter 3

6. View the placed left turn, change the Turning Radius from 100 feet to 75 feet.

: || 0000

000’ L- 000po0 00 L

H

7. View the placed left turn, change the Storage Length from 200 feet to 300 feet.

HinT  Select the green line, then select the length text.
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Chapter 3 2D PLANS - Place Left Turn with Traffic Separator

8. Zoom to the Turning Radius Offset Dimension, change the value from -1 feet to -4 feet.

o
!.',"'I
=]
[=]
o
(=]
o
=]
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Exercise 3.14 Place Right Turn Island
1. Use Civil Cells task, Place Civil Cell tool.

H
i
n
>

= Civil Cells

0 e - 2

—{ Place Civil Cell }

= 2m e nrAEFRT A

2. Navigate to the FDOT Intersections.dgnlib, select Right Turn Island. Click OK.

Civil Cell Name Right Tum lsland [

+- Active DGN

+- FDOT_Driveways.danlib, Defautt

= FDOT_Intersections danlib, Default
i 4 Lane Div » 55 (PPM Exhibit 13)
Basic Left Tum

Left Tum with TS

Side Road Tumout

Left Tum with TS_trim

Right Tum Lane

TSNose

CurbSidewalkLines

+- FDOT_SidewalkCurbRamps.danlib, Default

- FDOT_Templates dgnilib, 2-Lane 2-Way Arerial_Collector
- FDOT_Templates dgniib, 4 Lane Divided Arterial_Collector
- FDOT_Templates.danlib, 4 Lane Divided Interstate System

- FDOT_Templates.dgnlib, & Lane Divided Arterial (Inside Shoul

- FDOT_Templates.danlib, & Lane Divided Arterial

- FDOT_Templates.dgnlib, 5 Lane Undivided Ateria_Callectar I

1. FNOT Tamnlstes danlih 5 | sne Lndivided Atedsl Collactor
Ll [

3. Select the first PavementAsphalt(EOPA) lines.

Civil Cell Name Right Tum Island [-]

Locate Reference Element: Pavementsphalt
(EOPA) (1/2)

Complex Element: EQOPAZ
Feature: PavementisphaltEOPA)
No Active Profile

Lewvel: PavtAsphalt
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Chapter 3 2D PLANS - Place Right Turn Island

4. Select the second PavementAsphalt(EOPA) line.

Civil Cell Mame Right Tum lsland [

ocate Reference Element: Pavementfsphalt

5. Reset to Skip Alternates.
6. Data Point to accept the Civil Cell.
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2D PLANS - Place Right Turn Island

» Change the Right Turn Island Parameters

1. Change ConstLinesBlueDashed Arc Radius from 110 feet to 126 feet.

2. Check ConstLinesBlueDashed Begin Arc Offset is -18 feet.

i l=R=Ne] N

Bl =@ I

=
)
-
-
u
-
-
=
-
=
-
=
=
-
Ty
-
o
=]
&
L]
§
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Chapter 3 2D PLANS - Place Right Turn Island

3. Check ConstLinesBlueDashed End Arc Offset is -16 feet.

i _~

—k
(=1
=

4. Change the straight ConstLinesBlueDashed SR61 EOP Offset from 1 foot to -16 feet.

Fmeasaccrn

3-44 ©2016 FDOT FDOT Roadway Design and 3D Modeling



Chapter 3

2D PLANS - Place Right Turn Island

5. Check ConstLinesBlueDashed BL98 EOP Offset is -16 feet.

J (ie )

6. Change Island EOP Offset from the ConstLinesBlueDashed BL98 from -5 feet to -2 feet.

)
o
o
[=]
o
5]
[=]
(=]

change to -2

FDOT Roadway Design and 3D Modeling ©2016 FDOT 3-45



Chapter 3 2D PLANS - Place Right Turn Island

7. Change Island EOP Offset from the ConstLinesBlueDashed SR61 from 1 foot to 6 feet.

M~
e
1.090000

change this to
6 feet

8. Change Island Radii to 4 feet.
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2D PLANS - Place Right Turn Island Chapter 3

9. Change the Island ingress Offset -6 feet and Island Egress Offset -3 feet.

10. Move the Offset handles to the Radius Point.

move the offset handles
to the radius point
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Chapter 3 2D PLANS - Place Right Turn Island

11. Change the Active Level to Miscellaneous0.

=English, AS= 1.0000, TX= 2.8000, LS= 1.0000, CLS= 1.0000

- _/:' Al Len = |Miscellaneousﬂ' -

MeterBlec_ep
MeterBleclUG_ep
MeterGas_ep
MeterUnk
MeterlUnk_ep
MeterWater_ep
Mizcellaneous0
Miscellaneous 1
Miscelaneous2

.
aak
o,
4
i
!
[

it
i

L
I

NN EEEE(ICOeN

=

m

Miscellaneous3
Miscellaneous4
Miscellaneoush
Miscellaneoust
Miscellaneous 7
Miscellaneous8
MiscellaneousS
MiscEquip_ep
Monument_ep

ARASNSANSSNASNSASNSSNSS

L L L L U

14

'

12. Use the MicroStation Crate Region Flood tool, select the center of the island, and then data point to
accept the closed element.

I EILE)

Eill Type: [ None

Associgtive Region Boundany

@ @ ¢
Max Gap: | 0.000033
Text Margin: | 0.0000
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13. Use the MicroStation Select tool to view the properties of the new island. Record the Area

14. View the modified Right Turn Island.
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Chapter 3 2D PLANS - For BL98 Intersection Crosswalks Lines

Exercise 3.15 For BL98 Intersection Crosswalks Lines
1. Use the Horizontal Geometry, Single Offset Partial tool.

£ Horizontal Geometry = Dist
"y a7 wh p, Lock
a 'l o g @ Y
¥ Start
W e 2
T Lock
N A ) -
S - L (7 4 End |
R ™ g L
O { (~ , .v_,‘l> ﬂb ) T_\j‘_h eng
T2 ™ Feat
A ff 7__ r;j v -— h:..f e . Feature O
5 -J"} ;,f \/ _l-_ 1 Single Offset Entire Element
[} 2 single Offset Partial |
HB vertical Geometry _—
L\_t 3 Variable Offset Taper
& Terrain Model s
~d_ 4 RatioDefined Taper
T rarridar Madslinn

2. Create a Partial Offset line from BL98 -52 feet across the intersection. Use Feature Definition
ConstLinesBlueDash and Name ConstLineA.

Y4 Single Offset Partial_= B Z|BE co™

V| Offset: -52.000000

Mirror

Distance

Lock To Start

Start Distance 31+43.64 R1
Lock To End

End Distance  33+91.64 R1
Length 248000002

Feature -~
Feature Definition CnnsthnesBlueDaE

Name ConstLinesA

| End Parameters - <Alts Lock To End

Distance:End Distance | 33+91 64 R1

Complex Element: EOPAT
Interval

3. Use Horizontal Geometry, Line Between Points tool.

=
[}
n
>

< Horizontal Geometry

4D %) % @
+

W - L2

El:‘ 3.' ’ R !—‘

R Cj I_'i|-,E BET'r‘.-IEEI‘l F"cint-:- |"\ J\—_Ir

v L

T2 N
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2D PLANS - For BL98 Intersection Crosswalks Lines Chapter 3

4. Create a line from the curve center to the midpoint of the Island Radius EOP. Use Feature Definition
ConstLinesBlueDash and Name Line B.

j i = P & UL"‘ TG' G’

Line

Distance 126.839380
Line Direction 24°31°40.18102542"

Feature L

Feature Definition  ConstLinesBlue DaEl

Name ConstLinesB

Enter End Point
Distanc 339320 Rl

Complex Element: ConstLines21
Interval

Feature: Pavementlsphalt{EQOPA)
No Active Profile

5. Use the Horizontal Geometry, Single Offset Partial tool.

" Horizontal Geometry - Dist
“uby L . ] Lock

a ITa o, g @ #
¥ Start

W@ @
T or Lock
SN A/ ) -
8. NV End |
RO / (= ’ "")h lCL "‘h v Leng
T —-—; ”.\: Feat
A ;ﬁj’ ?ﬂ_ ;I:j W '-x'- “:"1" i - Feature O
} 1 Single Offset Entire Element

{7 YT

EH vertical Geometry

Single Offset Partial

=

A

Variable Offset Taper

£ Terrain Model

Ratic Defined Taper

e

#H rarridar Madslina
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Chapter 3 2D PLANS - For BL98 Intersection Crosswalks Lines

6. Create a Partial Offset line from SR61 across the intersection. Use Feature Definition
ConstLinesBlueDash and Name ConstLineC.

HinT  Snap to the mid-point of the radii.

- ]
1 @1 single Offset Partial L= 2 o R G

Offset 56573593

Mirror

Distance

Lock To Start ) second mid-paint
Start Distance 699+50.43 R1 i snap

Lock To End

End Distance  700+56.62 R1
Length 106.198205 End Parameters - <Alt> Lock To End

Feature

Feature Definition  ConstLines B\ueDaEl

Name ConstLinesC

Note Use these lines in later exercises to place 3D Sidewalk Ramp Civil Cells.
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2D PLANS - Create BL98 Turnouts

Chapter 3

Exercise 3.16 Create BL98 Turnouts

In this exercise the additional rural turnouts can be added to BL98.

1. Use Horizontal Geometry, Single Offset Entire Element tool.

£ Horizontal Geometry

a b %, e @ %

W ¢ e

SRS T -
E, ANV
RO /7 &
T2
.ﬂ.;ﬁf?ﬂ_r;jT

{7 YT

L

u

mEEA

—_—

.

- -

H [

| Single Offset Entire Elernent

THE

a. Select the ContLineBlueDash Turnout line.

7} Single Offset Entire Elew, Sl = S

20.000000

Mirror o

Feature R

Feature Definition PavementAsphat(EOPA]~ |
EOPA

MName

FDOT Roadway Design and 3D Modeling

©2016 FDOT

Locate Element <Alt> to Pick element in

Line: Constlines

Feature: ConstlinesElueDash
Mo Active Profile

Level: Constlines
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Chapter 3 2D PLANS - Create BL98 Turnouts

b. Accept the -20 feet Offset and Mirror.

V| Offset: 20000000

Mirror v

Feature ~
Feature Definition PavementAsphat{EOPA] |
Mame ECPA

Locate Element <Alt: to Pick eleme

2. Use Horizontal Geometry, Simple Arc tool.

==
]l
n
»

£ Horizontal Geometry

e SN YN
RO /76, 2D
T2 N | Simple Arc |

a. Place the Radius on both side and set Trim/Extend to Both.

Trim/Extend  Both
¥| Radius 25.000000
Loop
Feature »

Feature Definition  PavementAsphatt(EOPA]= |

MName EQPA
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2D PLANS - Create BL98 Turnouts Chapter 3

b. Change the Geometry to fit the existing driveway.

HINT  Use the centerline snap and dimensions to modify the location, length and angle. Use the Offset
PavementAsphalt(EOPA) Dimensions to change the width.

o “'J, @O‘ @ -

3. (EXTRA Exercise) Repeat the steps above to create an addition Turnout as shown below
<OR> use the Civil Cell, FDOT Intersection.dgnlib, and Side Road Turnout.

However, first place the Side Road Centerline.

use Civil Geometry ar Civil
Cellto create this turn out

Hint  When using the Side Road Turnout Civil Cell; there was an issue delivered. Drop the placed civil cell, fit
the view and delete the extraneous element placed.
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Chapter 3

Exercise 3.17 For BL98 Intersection Shoulders
This exercise uses the PavementAsphalt(EOPA) to create the 5 feet ShoulderPaved(PSHLD) Offset lines.

1. Turn ON the ShidrPaved level.
2. Use Horizontal Geometry, Single Offset Entire Element tool.

£ Horizontal Geometry n=EmaA .
1 [T gn 7
a 02 4 Yp @ %

. +

L

SN YNV
Po_ffw{?p’)pﬂp“‘?j_\:f‘

AT ,};Tl l_»'fI_—L
s . A [ Single Offset Entire Element
TV 1

3. Set the Offset to 5 feet and the Feature Definition to ShoulderPaved(PSHLD).

| Offset: . 000000

Mirrar

Feature o~

Feature Definition  ShoulderPaved{PSHLD HEl
Mame PSHLDR

4. Select the PavementAsphalt(EOPA) lines from the previous steps.

5. Repeat these steps to add the remaining Shoulder lines for the widening along BL98.

View the intersection below for complete details.

FDOT Roadway Design and 3D Modeling

©2016 FDOT
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2D PLANS - For Friendship Intersection Chapter 3

Exercise 3.18 For Friendship Intersection
1. Use Civil Cells, select Place Civil Cell tool.

H
i
n
>

= Civil Cells

0 il i - A
T Place Civil Cel |

[ T W e Al

a. From the Place Civil Cell dialog, navigate to the FDOT _Intersections.dgnlib and select Side
Road Turnout.

# Place Civil Cell |_= %

Civil Cell Name Side Road Tumoui(-)

+- Active DGN

+- FDOT_Driveways.dgriib, Defautt

- FDOT _Intersections.dgnlib, Default

- 4 Lane Div = 55 (PPM Exhibit 13)

- Basic Left Tum

- Left Tum with TS

- Left Tum with TS_trim

- Right Tum Lane

- TSNose

- Curb Sidewalk Lines

- Right Tum lsland

- FDOT_SidewalkCurb Ramps dgnlib, Default

- FDOT_Templates dgnlib, 2-Lane 2-Way Atteral_Collector

- FDOT_Templates dgnlib, 4 Lane Divided Arteral_Collector

- FDOT_Templates dgnlib, 4 Lane Divided Interstate System

- FDOT_Templates.danlib, & Lane Divided Arterial (Inside Shoul
- FDOT_Templates.danlib, & Lane Divided Arterial

- FDOT_Templates dgnlib, & Lane Undivided Artera_Collector I

_FNNT_Temrlstas darlin R | ane Undivided Atedal Callsctar
m 3

o OO OO O O e O O s Oy

-

b. Add Side Road Turn Out civil cell to both sides of the Intersection with Friendship and
Friendship 2 Centerlines.

Hint - When using the Side Road Turnout Civil Cell; there was an issue delivered. Drop the placed civil cell, fit
the view and delete the extraneous element placed.

c. Use Modify Element to clean the extra curb line and sidewalk lines across the intersection.
d. Change all Radii to 35 feet.

Change Friendship2 Side Road Offsets to 20 feet.

f.  Change Centerline Length to 100 feet.

@
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Chapter 3 2D PLANS - For Friendship Intersection

Friendship2 Rd

2. Use Civil Cells, Place Civil Cell tool.

n
]
n
>

2= Civil cells

0 | -

—{ Place Civil Cell }

= 2m manrASFAT v

a. From the Place Civil Cell dialog, navigate to the FDOT _Intersections.dgnlib and select Left
Turn with TS.

Civil Cell Name Left Tum with TS [

Pick Civil Cell

+- Active DGN

+- FDOT_Driveways.dgnlib, Default

- FDOT_Intersections.dgniib, Default

i 4 Lane Div > 55 {PPM Exhibit 13}
Basic Left Tum

Side Road Tumout
Left Tum with TS_trim
Right Tum Lane

TSNose

i-- CurbSidewalk Lines
.. Right Tum lsland
- FDOT_SidewalkCubRamps danlib, Default
- FDOT_Templates dgnlib, 2-Lane 2-Way Ateral_Collector
- FDOT_Templates.dgnlib, 4 Lane Divided Arteral_Collector
- FDOT_Templates dgnlib, 4 Lane Divided Interstate System
- FDOT_Templates. dgnlib, & Lane Divided Arterial (Inside Shoul
- FDOT_Templates dgnlib, & Lane Divided Arterial

- FDOT_Templates. dgnlib, 5 Lane Undivided Artera_Collector b
. FNNT_Tamnlates dAarlih_ B | ana Lindivided Atedsl Collectar
m 3

e 0y O O O o O o O e O

-

b. Use FDOT _Intersections.dgnlib, Left Turn with TS Civil Cell to a place left turn lane on SR61
at Friendship Intersection.
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c. For the first Reference element, select the Friendship Rd Centerline.

" Place Civil Cell
Civil Cell Name Left Tum with TS [.-]

CL) (112)

1I

d. For the second Reference element, select the left median PavementAsphalt(EOPA) line.

Ll

Civil Cell Name Left Tum with TS [

Locete Reference Element: Pevementd = phalt
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Chapter 3 2D PLANS - For Friendship Intersection

e. Reset to Skip Alternates and data point to accept Civil Cell Placement.
f.  Change the turning Radius to 50 feet.
g. Change the turning lane storage length to 300 feet.

3. Use MicroStation Trim to Element tool.

Tasks

J'Tasks
| & Civil Tools

A = & L9 L .
1_3 E""pﬂir_l!.‘ .ﬂ—?.ﬂ:‘i—.ﬂ’_' ll Modify El "
-4 1 odi emen

E“ 2 Break Element

Analysis & Reporting

s General Geometry |
: 3 BEdendLine
«<_ Horizontal Geometry
Trim To Intersection

>

HH wertical Geometry

\.
i
Jun

Trim To Element
#™ Terrain Model

E & Trim Multiole
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2D PLANS - For Friendship Intersection Chapter 3

4. Move the LT_PVT_EOP_IN to the beginning of the Traffic Separator.
HinT  Use the ConstLinesGreen as the cut element

P Trim To Element RS A ESD)|
‘ Select cutting element first ‘
|
[
|
|
[

|
. |
cutting element !

II
trim these lines

5. Use MicroStation Trim to Intersection tool.

Tasks * 01X

J'Tasks - |
| & Civil Tools |'

R I [ Y O R e
lh E""rﬂrri% PﬂP}Eﬁ:‘pﬂ_

1 Moedify Elernent

Analysis & Reporting
E'.(* 2 Break Element
iy General Geometry - .
I 3 Bxtend Line

£ Horizontal Geometry . _ )
A4 Trim To Intersection

BH vertical Geometry ol

5 Trirmn T Elarnant
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6. Trim the Curb and EOP lines to the beginning of the median Taper line.

‘i

7. (EXTRA Exercises) Complete the Intersection with Civil Geometry tools as follows below:
a. Add Curb lines for each of the Radius.

b. Trim Sidewalk lines into the Radius Curb lines. There is no sidewalk along SR61 north of
Friendship Road.

c. Add Asphalt Pavement(EOP) Taper lines from the Intersection Radii at Friendship to the End
Station of SR61 11 left.

d. Add ShoulderPaved(PSHLDR) lines to both sides along the Taper.

taper and shoulder

lines
taper and shoulder

lines

Locate Element <Alt> to Pic
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4 PROFILES

INTRODUCTION

This chapter will continue to use the OpenRoads Technology Civil Tools, Vertical Geometry. Rather than use
traditional GEOPAK Profile creation tools, these exercises will provide participants with practice using the Civil
Tools. Using Civil rule-based Feature Definitions assures design intent is incorporated into the vertical geometry
layout. This will be beneficial for design when changes need to be reflected and considered through-out the
development process.

This chapter introduces important new OpenRoads Technologies for creating vertical geometry line work
while designing in FDOTSSA4.

OPEN PROFILE MODEL
The Open Profile Model generates a MicroStation View that presents the desired feature in profile thus enabling
the Vertical Geometry tools to interact with the chosen feature.

Open the Civil Tools Task pane to the Vertical Geometry section then click the Open Profile Model icon. Move
the cursor into the Workspace and note that it is accompanied by a command prompt requesting that you, "Locate
Plan Element™. Select the element with which you wish to work in profile. The cursor is now equipped with a
prompt that says, "Select or Open View". Data point or left-click in it a view to present a profile of the selected
element. If no other view is open, click one of the view icons on the View Groups toolbar then click again in the
new View. Vertical Geometry tools can then be used to edit/create vertical profile data in the design.

EXERCISE OVERVIEW

4.1  Preparation for SR61 Profile
4.2  Create SR61 Profile

4.3  Edit SR61 Profile

4.4  BL98 Profile

4.5  Friendship Profile
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Chapter 4 PROFILES - Preparation for SR61 Profile

Exercise 4.1  Preparation for SR61 Profile
1. (Optional) Extract the 22049555201(4).zip file in the c:\e\projects folder.

2. Open the DSGNRDO1.dgn file of the c:\e\projects\22049555201\roadway\ folder in the FDOTSS4
Workspace in MicroStation.

3. Use MicroStation, References tool to attach the Existing Terrain file,
c:\e\projects\22049555201\survey\ GDTMRDO02
Note If the SURVROD file exist the SURVRDO01 -GTMRD logical can be used

Tools  Settings

v E —ﬁé-:] ¥ 5( j*j 20 -" Fj gﬂ L:] 3 Hilte Mods: [Boundaries ~

-
7] References (6 of 6 unique, 3 displayed) & W -

Hierarchy [+] ¥ 3 File Name Model De
{8 DSGNRDO1.DGN, Defaut| Agrizls dgn Default Mz
RWDTRDON.DGN Dlefault z
TOPORDO1.DGN Defautt z
« ALGNRDD1.DGNM ALGMRD_50 Gle

+ Gl Default-3D
o GDTMRDOZ DGN Default Mz

4. Select the Tasks list and set the Menu Tasks to Civil Tools.

Tazk: i
. ¥ ¥ X " u View1, Default
[ Civil Toals - | ) » o v é q q
. ; = & Tasks
H i O J,"J A oo n
EJ E}ri% bﬁbﬁl :-pr£< g 1 @
> \'/ c
Bl M, [ E=3| FDOT Plans Development
= - - - g Subsurface Uity Engineering
+ Analysis & Reporting ,,\,;. Drawing
b general Geometry [ (3 Drawing Composition
£ Horizontal Geometrv n=

5. Use the Terrain Model, Set Active Terrain Model tool.

@™ Terrain Model 1

@ =gl RE %
WBIA AR W

E Tf—q Set Active Terrain Model }
n B i P B N g2
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PROFILES - Create SR61 Profile Chapter 4

6. At the cursor prompt, select the Terrain Boundary green line from the attached GDTMRDO02 Reference
file <OR> pick it from the list on the dialog.

A=

Locate Terrain Model to set as Active

Terrain Model: GOTMRDO1
Level: DTM_ep
Ref: 6 (GDTMRDO2.DGM)

Exercise 4.2  Create SR61 Profile
In this exercise, several Vertical Geometry tools are used to create a proposed profile for SR61.

1. Use the Vertical Geometry, Open Profile Model tool.

BH vertical Geometry

B85 L s RO AY |2

W IL}:EEH F'I:l:f”E Model |

R —

]~ @B,

R v Ay e 1 =g
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Chapter 4 PROFILES - Create SR61 Profile

a. At the cursor prompt, select on the mainline SR61 Centerline.

SR61 Centerline

Loeate Plan Element

Complex Element: SRE1
Feature: Centerling(CL)
No Active Profile

Level: CLConst_dp
DOE FEATURE
Attribute = CLC

b. Atthe prompt select to open View 3, then data point in the View.

o ™ Views3, Profile - SR61 = |-G ]
Erovae BB OES| S e

- :,

- i
b4

sall

h
| 12| 4|56 7|8 : X |41.500334 Y |-16.867954
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PROFILES - Create SR61 Profile Chapter 4

2. Use the Vertical Geometry, Define Profiles by Best Fit tool.

E Vertical Geometry
L [Naya AN
E |~ & & 1
R~ Y o

7| |JL | £ |°d Define Profiles By BestFit

a. At the cursor prompt, data point to Make Complex Element option.

b. Enter the Profile Name , SR61-PR, and then data point on the green line in the profile.

B View 3, Profile - SR61
B-i-AQQRHEER ORIEH

Best Fit Make Complex Bement

Best Fit Parameters

Upper Envelope 2.000000
Lower Envelope -2.500000
Desirable Crest Curve Length  300.000000
Desirable Sag Curve Length  200.000000
Minimum Curve Length 150.000000

Feature

Name SRE1-Pr

Element Template Profiles(2D)\Proposed_pr\Grade Line[~] data point to use
existing ground

Locate Profile To Fit
Profile:

Type: Surface Profile
Level: XSGrdLine_ex

c. Follow the prompts to enter the Best Fit Parameters as shown.

Best Fit Make Complex Element El
Best Fit Parameters ~
| Upper Envelope 2000000
| Lower Envelope -2.500000
¥| Desirable Crest Curve Length  300.000000
| Desirable Sag Curve Length  200.000000
| Minimum Curve Length 150.000000
Feature ~
Name: SRE1-Pr
Element Template Profiles(20}\Proposed J:r"-.GladeIJneEl
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Chapter 4 PROFILES - Create SR61 Profile

3. Use the General Geometry, Design Standards Toolbar tool.

it General Geometry

R R A Al e
‘] Design Standards Toolbar |
il

-

4. On the Design Standards Toolbar, navigate to Arterials, Flat Terrain, Urban, With Curb and Gutter
and select 55MPH. Toggle On the Active Design Standard.

HiNT  Be sure to set left and right fields to 55 MPH

Temain\Urban\With Curb and Gutter\55MPH| ~ li55MPH [=] ‘ ‘

5. Use the General Geometry, Set Design Standard tool.

i General Geometry = A

“ EEL&? ®% T O
nf 27 cCﬂI Set Design Standard |

E 355 % uf

R ff‘- A% :i.

a. At the prompt, select the Best Fit Profile created in the previous steps. The profile now has a
Vertical Design Standard rule placed on it.
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PROFILES - Create SR61 Profile Chapter 4

b, 4

e
b. Using the Select Tool, . (temesieion | slect the profile element and view its properties in the
Element Information dialog.

Eu---‘.; Active Profile: SR61-PRType: Fit Profile =

_ .. Depends On

AN \\ierials'\Flat Terain'Urban\55MPH H

...... /’ IJne
General LS
Descnption Application Data
Extended L
Vertical Design Standard LS

Yertical Design Stanc 55MPH
Minimum Slope 0.300%
Maxamum Slope 5.000%
Require Curves to be False
Allow Overlaps False
Alow Gaps False
Maximum Difference 0.400%
Wertical Table Type K Table
Table

6. Use the General Geometry, Civil Message Center tool.

it General Geometry BEEE A

a 21t e @ Gt ©
W lZ ZT :)) [ Civil Message Center L
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Chapter 4 PROFILES - Create SR61 Profile

a. The Civil Message Center dialog displays to view the results.

Note It may be docked at the bottom of the screen, click on the Tab

B Civil Message Cent

Hide All || & 50 MicreStation | €3 1 Error ||| 1, 7 Wamings ||| 0 Messages

Element Message Description

Display complete

Active Profile: SRE1-PR

[Plot Scale=-359.0000, Units=Unlknown, AS= 1...
Linked Data Manager: (0} links found in 00:00:0...
Linked Data Manager: Scanning. ..

Complex Blement: SRE1

Temain Model: GODTMRDO1, Boundary, Level: X...
Active Temain Model Set

30 Model [GDTMRDO2 DGM/Default] has bee...
Reference attached

Complex Element: EQPAZE

Total 4256 payitems in the database
Cnmnlew Flemeart - FOP AR

m

‘REREREREREREER

il | 3

b. Inthe Civil Message Center dialog, select on the MicroStation tab. This will toggle Off all
the general messages for MicroStation and leave only Errors and Warnings in the list.

Element Message Description

@Em:ur Crest is less than minimum Design Standard Value = 185000000 Actual Vi
_ﬂ‘."ﬂ'aming Speed Substitution Designated design speed 50 not found in Vertic
_ﬂ.,‘.".n'aming Speed Substitution Designated design speed 50 not found in Vertic
_ﬂ.,‘.".-'aming Speed Substitution Designated design speed 50 not found in Vertic
_ﬁ.,Waming Tangert length is shorter than minimum Design Standard Value = 100000000 Actual Vi
_ﬁ‘."ﬂ'aming Maximum deflection with no curve exceeded Design Standard Value = 1°0°00" Actual Value =
_ﬂ.,‘.".n'aming Tangert length is shorter than minimum Design Standard Value = 100.000000 Actual Vi
_ﬂ,‘.".n'aming Tangert length is shorter than minimum Design Standard Value = 100.000000 Actual Vi
4 1 | 3

c. Inthe Civil Message Center, review the Errors and Warnings.
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PROFILES - Create SR61 Profile Chapter 4

d. Select the first error, then right click over the error and select Zoom To from the popup box.
B Civil Message Cente S

Hide All | gk 50 MicroStation |3 1 Error ||| # 7 Warnings ||l 0 Messages
Element Message Description
@ﬂ___l—l Design Standard Value = 185.000000 Actual
_ﬂ,‘."‘a‘aming Zoom to Designated design speed 50 not found in Vertic
B Waming Add To Selection Designated design speed 50 not found in Vertic
_ﬂ,‘."‘a‘aming Speed Substitition Designated design speed 50 not found in Vertic
_ﬂ,‘."‘a‘aming Tangert length is shorter than minimum Design Standard Value = 100.000000 Actual Vi
_ﬂ,‘."‘a‘aming Maximum deflection with no curve excesded Design Standard Value = 1°000" Actual Value =
_ﬂ,‘."‘a‘aming Tangent length is shorter than minimum Design Standard Value = 100000000 Actual Vi
_ﬂ,‘.".n'aming Tangent length is shorter than minimum Design Standard Value = 100000000 Actual Vi
4 L 3

e. Notice the Error is now centered in the profile view. Hover the cursor over the Error icon to

Note

display the Error Message description.

Crest is less than minimum. ]
Design Standard Value = 185000000 Actual Value = 135.395077
Level: Scratchl_dp

The values are given in whole stations, i.e. 3.5 station equals 350 feet
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Chapter 4 PROFILES - Create SR61 Profile

7. On the Design Standards Toolbar, navigate to Arterials, Flat Terrain, Urban, With Curb and Gutter
and select 50MPH.

E'I_ Design Standards Toolbar

7y | Ay || Arerials\Fiat Temain\Urban\With Curb and Gr] | 55MPH

= Arterials (Active Design)
=} Flat Temain (Atterals (Active Design))
+ Rural (Arterials (Active Design))
- Urban {Artenals (Active Design))
— With Curb and Gutter {Arterials (Active Design))
J0MPH (Arterials (Active Design))
35MPH (Arterials (Active Design))
ADMPH (Arterials (Active Design))
AEMPH (Arterials (Active Design))

BEMPH (Arterials (Active Design))
- Without Curb and Gutter (Arterials (Sctive Design))
+- Rolling Temain {Aterals (Active Design))

e O Y B

8. Use the General Geometry, Set Design Standard tool.

-
1]
[ ||
>

it General Geometry

9 mﬂ_@ BT O

W 27 2:’1 Set Design Standard |

E 5t 3 uf

9. At the prompt, select the Best Fit Profile created in the previous steps. Notice the Error icons are no
longer displayed.
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Chapter 4

Exercise 4.3 Edit SR61 Profile

This exercise changes the profile using Civil AccuDraw and MicroStation Modify Element.

> Edit the Best Fit Profile

In order to edit this profile, because it was created from the “Profile by BestFit” the rule must first be removed.

1. Select the Profile Element and hover over the element to display the Context Menu.

2. Select the Convert to Profile Rule tool.
» Delete Pls

1. Use MicroStation Modify, Delete Vertex tool.

Tasks

T X a View3 pre

JTasks

= |

| % Civil Tools

f )~ &~

E % ]? ul@
N S | & .. oo gy ahe
Ly + JF Ri w e

1 2""»3[1 3 v8 >EL\'D

1)

1 Modify Element
Analysis & Reporting
- |—_>$ 2 Break Element
ii General Geometry
L ) ) " 2 3  Extend Line
40 % %™
— A 4 Trim Te Intersection
el
| v o
— 5 ). 5 Trim To Element
E Sl M b
- >}’) i F 6 Trim Multiple
R £¥ 7 IntelliTrim
. Horizontal Geometry e 8 Insert Vertex
BB vertical Geometry |:|3*' 9  Delete Vertex
# Terrain Model " 0 Censtruct Circular Fillet
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Chapter 4 PROFILES - Edit SR61 Profile

2. Zoom to the beginning of the Profile and delete the first two Vertical Elements.

® View 3, Profile - SR51
B~ AQHEHEBEH DG LR .

o e P,

- -,

Artesials\Flat Temain\Urban\With Curb and Gl = | | S0MPH
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PROFILES - Edit SR61 Profile Chapter 4

> Create Profile with Place Vertical Line

New vertical civil profile elements are added to match the existing profile across US98.

1. Use Vertical Geometry, Profile Line Between Points tool.

BB vertical Geometry - —

B 15 b L (R IR b A |2

P NEAY
I L

= |_‘| Profile Line Between Points |

2 Rl Ay o [

2. Place Line Elements on the Existing Ground points to trace the Profile across BL98.

Note This is not exact, simply trace a few lines.

B View 3, Profile - 5R61 EI@
B AQRQRHEHEE OB K

3. Continue using the Profile Line Between Points tool

a. Begin at the edge of the existing pavement or connect to the proposed profile line from the step
above.

!

.

.

Enter Strt Point

LY
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Chapter 4 PROFILES - Edit SR61 Profile

b. In the Profile Line Between Points dialog, check the length and slope, length of 16 feet and
slope of -2%. Click a data point in the view to create the line as defined in the dialog.

T e i reveen o =]

| Length 16.000000
V| Slope l2.00%

Feature
Mame

Element Template Profiles [2D}"-.Pmpusedjr"-.GladeLineCtrEl

B View 3, Profile - SR61 Sl s [F=R|E=R =

o~ - I ] Q ‘{El‘:l B 2 EJF_IU o Enter Start Point

c. Using Line Between Points to join the two profiles, place another Profile line between the “16’
at 2% line and the Best Fit Profile.

38.333967

200.000000
B6.873596
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PROFILES - Edit SR61 Profile Chapter 4

» Profile by VPI's

1. Zoom to the Beginning of the profile, Use Vertical Geometry, Profile Complex By VPI tool.

BE vertical Geometry H Y
TN
E |~ &) & &Y

.3 3 3

R v A P i [
T LA | { Profile Complex By VPI & V

2. Toggle OFF the Active Design Standard, set the Curve length to 50 feet.
HinT  Check that the Vertical Curve Type is set to Parabola

50.00000

0.000%

Wertical Curve Type @

Feature
Name

Element Template

3. Start by snapping to the Beginning Point on the ground and complete the Profile Segment as shown
below.

HiNT  This is not exact, snap to 3 points
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Chapter 4 PROFILES - Edit SR61 Profile

4. Zoom to the End of the Profile, select the Line and move the last End Point to snap to the Existing
Ground.

B View 3, Profile - SRGL [=n|ER =T
EBr-éa-AQQREHEBE M| H

Hint  Click on the solid ball manipulator at the end of the line to move it in both directions

B View 3, Profile - SRb61 EI@
E-e~-AQQREBE MHNE G| H

726+42.21 R1

Profile:
Type: Surface Profile
Level: XSGrdLine_ex
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PROFILES - Edit SR61 Profile Chapter 4

» Complex Profile Elements

=
1}
n
>

1. Use Vertical Geometry, Profile Complex | EB wertical Geometry
by Elements tool. 1 . _
QB [ Lo [ [ D v |2
\_ -‘.l‘,..\ \.\:
& & B

R —

Pﬂ*ﬁﬁ&Wm

F'lcflIF_Ccm lex By Elements b
T/ 1L p Y

1—|'—I_I_I_

2. Keyin the name SR61 PR on the dialog and Start at the Beginning Profile line and create a new
Connected Profile.

Hint  On the Profile Complex by Element tool setting, enter the Feature Name. This is the Profile Name assigned
to the Profile.

L'l Complex Element 3l

Method
Maximum Gap 0. 100000

Feature

Mame SRE1_FR

Element Template MNone

3, Profile - SR6L @ Element Selection (Slu=h e [E=0| R |
- AR QREEHEBE OBR F

4 @ O 12
Bl =@ W .

179.820324

148.248613
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PROFILES - Edit SR61 Profile

» Profile Report

1. Use Vertical Geometry, Profile Report tool.

HH vertical Geometry

0 BB |55 b e [ [ b A ]2

[N ala Y
Ele @y L&

HEEA

| Profile Report

<OR> With the Profile selected, hover over the element to display the Context Menu and select the Profile

Report.

148.248613

2. The Bentley Civil Report browser displays the Vertical Alignment Review Report for the Profile.

Close the Civil Report browser.

Vertical Alignment Review Report

Project: Default

Description:

Report Created: 9/9/2015

Time: 1:37pm

File Name: C:\e\5S4projects\22049555201\roadway\DSGNRD01.DGN

Last Revised: 9/9/2015 13:33:568

m

Note: Allunits in this report are in feet unless specified otherwise.

Horizontal Alignment: SR61
Horizontal Description:
Horizontal Style: Centerline(CL)

Vertical Alignmeng: SR61_Pr,

Vertical Description:
Vertical Style: Centerline(CL)

Station

Elevation

Element: Linear
POB
PVC
Tangent Grade:
Tangent Length:

Element: Symmetrical Parabola
PVC
PVI
PVRC
Length:
Entrance Grade:
Exit Grade:

698+53.79 R1
698+76.91 R1
-0.53%

2512

698+76.91 R1
698+95.02 R1
699+11.12 R1
32.20

-0.53%
-6.43%

©2016 FDOT

37.36
3723

Element Selection | =

lozo ., @
Bl =@ B |

[
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3. Use Vertical Geometry, Set Active Profile tool.

EH Vertical Geometry HERA
ol = | N o Y a7

W [ Set Active Profile |

ISP

<OR> With the Profile selected, hover over the element to display the Context Menu and select Set Active
Profile.

» Export Profile

1. Use the General Geometry, Export to Native tool.

-
]
n
>

't General Geometry

a3 i % @ 8 VO
W |21

E —:%i— 2 Export to Native |
E

Hint  Always check that the profile has a Feature Name before saving to the GPK file
2. Select the SR61 Profile and save it to the job00.gpk file.
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PROFILES - BL98 Profile

Exercise 4.4 BL98 Profile

1.

2.

With the BL98 selected in the Plan View, hover over the element to display the Context Menu and
select the Open Profile Model.

Select View 3 to view the Existing Ground Profile for the mainline BL98 Centerline.

= BB ffl - € & s X

_'-‘ Open Profile Model

3. With the Profile selected, hover over the element to display the Context Menu and select the first icon
Properties
4. Inthe name field enter BL98_EX
Feature Lol
BL92 EX
Feature Definition DtmbBdsting
5. With the Profile selected, hover over the element to display the Context Menu and select Set As Active
Profile.
B View 3, Profile - BLOS =R =R

6.

4-20

Use the General Geometry, Export to Native tool, select the BL98 EX Profile and save it to the
job00.gpk file.
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PROFILES - Friendship Profile Chapter 4

Exercise 4.5 Friendship Profile

1. With the Friendship selected in the Plan View, hover over the element to display the Context Menu
and select the Open Profile Model.

Complex Elernent: FRIENDSHIP

\lo Active Profile
\‘u N Level: Default
] -

*

2. Select View 3 to view the Existing Ground Profile for the mainline Friendship Centerline.

B View 3, Profile - FRIENDSHIP =N EoR ==
Eréda-AQQHEBHEBE OEG F| e
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3. With the Profile selected, hover over the element to display the Context Menu and select Set As Active
Profile.

B View 3, Profile - FRIENDSHIP =8 EoE =<
B-#-ALQAHEBE OB E .
-

4. Repeat the steps for Friendship2 Rd.
5. Open View 2 using the F2 Function Key to see the 3D alignment cernterlines for the project

6. Notice the 3D lines displays in View 2.
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5 TEMPLATE DESIGN

OVERVIEW

The Create Template command generates the transverse geometry that is central to roadway design. A template
comprises a series of points and components that represent break line features that are processed using Corridor
Modeling commands. Roadway features that have been processed are saved to the design surface. Templates are
stored in a template library (*.itl).

TEMPLATE BASICS

e The FDOTSS4 Workspace provides an extensive Template Library.

o FDOTSS4 Templates closely follow CADD Manual, PPM and FDOT Design Standards and should be used
to start a project.

o FDOTSS4 Templates are designed from the PPM typical sections of the proposed roadway.
o FDOTSS4 Templates are stored in the FDOTSSA4.itl.

e The FDOTSS4.itl Templates have Features, Point Names, Component Names, Parametric Constraints and
Display Rules which follow a standard naming convention.

e A project specific Template Library is created and FDOTSS4.itl file templates are copied to that library and
are modified to meet the specific needs of the project.

e New and modified templates should adhere to the template standards of the FDOTSSA4.itl file.
e When applied to a Corridor, templates are written to the design file and can be edited within the file.

e  Once templates are in a design file, they can be copied to another Project Template Library or design file.

APPLYING TEMPLATES

e Templates create a model of the proposed roadway.
e Template points generate longitudinal break line features in the model.
e Templates are used to create a proposed model of the roadway.

e Templates are assigned to specific stations along an alignment at a specific interval, which are called template
drops.

e When a corridor is processed, the points of the template drops are connected to form a model of the roadway.
e The connected template points also form longitudinal break line of the surface model.

e The model can be exported into a traditional surface Terrain model.
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CREATE TEMPLATE DIALOG

The Create Template dialog is accessed from the Corridor Modeling, Create Template tool. To create or edit a
Template Library, click the Open Create Template icon on the Corridor Modeling dialog. This displays the
Create Template dialog.

The Create Template dialog is the primary place where templates are created and edited. This is also where
templates are copied from a standard Template Library to a project Template Library using Tools > Template
Library Organizer.

e  User Definable Folder Structure

e Create Templates, Components and End Conditions

e Right-click Functions

e Copy and Paste, and Drag and Drop

¢ Red-colored Box Indicates Current Template

e Drag and Drop Components to Current Template Window

On the left side of the dialog, you will find the Template Library area, which contains a Windows-like folder
structure. The root folder is the name and location of the Template Library that is currently open. Only one
Template Library may be open at a time.

To navigate the folder structure, double-click the folders you want to open or close. Inside any folder you can
create and organize your templates and subfolders. The organization of the folder structure is user definable. The
folder structure also supports common Windows functions, such as drag and drop, cut and paste, etc.

Most commonly used commands can be accessed by right clicking on the folders and templates. If you double
click a template, it becomes the Current Template and is signified by a red box around the Template icon. The
Current Template is also identified in the Current Template area next to the Template Library area. To assemble
or edit a template, it must be the Current Template.

CURRENT TEMPLATE WINDOW

5-2

e Templates Assembled and Edited

¢ Right-click To Create Components

e Double-click To Edit Points and Components
e View Commands Bottom of Window

In the center of the Create Template dialog is the main graph for creating templates. The graph is called the
Current Template window. The Current Template window uses its own graphics engine and is not a MicroStation
View. The scale of the graph is dynamic and changes as you zoom in and out.

The center point of the Current Template window is marked by the dynamic origin, which is a magenta-colored
box. The dynamic origin is used as a reference point and can be moved to any location in the graph.

At the bottom of the graph there are numerous view commands, which are similar to MicroStation View
commands. There are two buttons that look like the MicroStation View Previous and View Next commands,
however, they are used to undo and redo template creation operations.

If your mouse has a scroll wheel, it can be used to pan and zoom. The CTRL-Z keyboard hot key will undo your
last edit or creation. In the graph area you can right-click to access commands and you can double-click elements
in the graph for editing purposes.
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TEMPLATE PREVIEW WINDOW

e  Previews Templates and Components

e Works on Non-current Templates

e Placement Point Location Denoted by a Cyan-colored Box

e Click Point to Move Placement Point Location

e Drag and Drop from Preview Area to Current Template Window

Under the Template Library area is the Preview area. When you highlight (single click) a template, the template
is displayed in the Preview area.

You can use the Preview to assemble templates from their parts or components. This is accomplished using drag
and drop functions. The cyan-colored box in the Preview represents the insertion point for any drag and drop
operation. You can change the insertion point location by clicking the desired insertion point on the preview.

DYNAMIC SETTINGS

e Tools > Dynamic Settings Command

e  Precision Input Template Points

e XY = Absolute Coordinates

e HS =Horizontal Delta Distance and Slope from Last Point Placed
e DL = Enter Delta Coordinates from Last Point Placed

The Dynamic Settings dialog is used for precision input of the template components and to assign point names
and styles when creating components. It also serves as a compass for the location of your cursor with respect to
the dynamic origin. The dynamic origin can be moved using Set Dynamic Origin, located at the bottom of the
Dynamic Settings dialog.

The Dynamic Settings dialog is accessed by selecting the menu option Tools > Dynamic Settings or using the
View Control icons located below the Current Template window.

The Key-in pull-down specifies the type of key-in to be performed:
XY = key-in absolute coordinates

DL = key-in delta coordinates from last point placed (defaults to the dynamic origin if it is the first point
of a component)

HS = key-in horizontal delta distance and slope from last point placed
VS = key-in vertical delta distance and slope from last point placed
OL = key-in delta coordinates from dynamic origin

OS = key-in horizontal delta distance and slope from dynamic origin
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COMPONENTS

e Components are Parts of the Template

e  Curb and Gutter, Median Barrier, Pavement Layers, Cut and Fill, etc.

o Simply Drag and Drop Components Together to Create a Complete Template
e When Two Points Coincide, Heavy White Plus Sign Appears

e Existing Connection Point Name Override Dropped Point Name

Components are logical parts of a template. Portions of the template that are separated into components are
normally based on tabulation considerations. Examples of components include curb and gutter, median barrier,
pavement layers, cut and fill slopes, and ditches.

Components are normally kept in a separate folder in the Template Library and are used to assemble complete
templates. Drag and drop the components to the Current Template window to create a complete template. When
connecting two components, the connecting point will change to a white colored plus sign prior to placing the
component. This is the indication that the points coincide. When the components are connected together, using
drag and drop from the Template Library folders, any coincident component points will use the point names of
the previously placed component. Template point names can be edited anytime during the creation process.

Components are normally created with point names that are not specific to being on the left or right side of the
roadway. When they are used to create completed templates, prefixes and suffixes to the template points can be
automatically added during component placement. Prefixes and suffixes are controlled using Tools > Options in
the Create Template dialog and can be set and cleared in the Dynamic Settings dialog during placement using
the Apply Affixes check box.

MERGING COMPONENTS

¢ Right-click Between the Components to Merge
e  Select the Merge Components Command

When combining two components of a pavement section together, two separate components are produced with a
vertical segment dividing them. To remove the vertical segment, position the cursor over the vertical segment
and right-click. Then select Merge Components.

EXERCISE OVERVIEW

5.1 Creating a New Project Template Library
5.2  Create Template Library Folders

5.3  Using the Template Library Organizer
5.4 Naming Project Templates

5.5  Creating A Resurfacing Template

5.6  Editing Templates
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Exercise 5.1  Creating a New Project Template Library

This exercise opens the proposed roadway design file, DSGNRDO1.dgn, with GEOPAK using the FDOT
Workspace and Project configuration. The Create Template dialog displays and a new Template Library file
created for the project in the project symb folder. This new project Template Library is the container for all the
components and templates used to develop the design model for the project design.

1. (Optional) Extract the 22049555201(5).zip file in the c:\e\projects folder.

2. Open the DSGNRDO1.dgn file of the c:\e\projects\22049555201\roadway\ folder in the FDOTSS4
Workspace in MicroStation.

3. Use Corridor Modeling, Create Template tool.

ffl corridor Modeling == A
oo ] N1 S

i [ o H-[2] Toserai]
T EwY

BN e T sl e b

4. Open the Create Template dialog and select File > New > Template Library.

-

B ' Create Template
e

{File Edit J Add Tools
Mew 4 Folder
pen... Ctrl+0 Template

Save Ctrl+5 Template Library...

Save As...

Cloze

5. Navigate to the Project roadway folder, C:\e\projects\22049555201\roadway\.

1= Recent tems
B Desltop
'Ei_ii Metwoark
= Libraries
A Darfaorth, Vem
1N Computer
i O5Disk (C)
| &
| projects
J 22045555201
T
=s DVD RW Drive (D7)

B T LI P R N i
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6. Enter the new Template Library Name, 22049555201. Click Save.

 Save Template Libra

roadway f—; 5 i

Mame Date modified Type
aerials 11/6/2014 6:01 AM  File folder
eng_data 5/12/2014 4:43 PM File folder

! projdbs 11/6/2014 6:01 AM  File folder
|| 22049555201.itl 11/7/2014 1:17 PM ITL File

v
2

Recent Places

Desktop

FH
Libraries

iL®

-

Computer

P Y 4

m
LL" T
' File name: Q_l 95552(1

Save as type: |Ten1p|ate Libraries (.itl)

7. Select File > Save again to verify, then close the Create Template dialog. Click Close.

|-€ I P|

| Library  Active Template | =t oM -

Preview:

C:'e'\projects 22045555201 roadway" 22049555201 itl Saved
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Exercise 5.2  Create Template Library Folders
e Components
e  Corridor Templates
e End Conditions
e Linear Templates
e  Surface Templates

The Components, End Condition, Linear Templates, Surface Templates folders contain parts of the full
Templates and is obtained from the FDOTSS4 Template Library.

The Corridor Templates folder contains the constructed templates for the corridor. The Project Templates in the
exercises to follow are named and saved in stages or phases in order to track the progress of the design. This
method is also recommended to provide a backup and/or history for potential trouble shooting along the way.

1. Use Corridor Modeling, Create Template tool.

ffl corridor Modeling = A
a e ) N S

W Lf#-: | H :__-". |7J"* |EJ,| \i Create Template l
Tt EwY &

=R s \J '\|\'|<1 ..u]r |4T~| |T| e o {i

2. From the Create Template dialog, select File > Open and navigate to the
FDOTSS4/GEOPAK/corridor directory and choose the EmptyProject.itl Template Library.

3. From the Create Template dialog, select File > Save As to copy the blank Project Template Library
over the 22049555201 .itl Template Library created earlier. This will save the next few steps.

FDOT Roadway Design and 3D Modeling ©2016 FDOT 5-7



Chapter 5 TEMPLATE DESIGN - Create Template Library Folders

» Optional Steps
1. Create new folders in the Project Template Library.

i " Create Template . - L EIEI&J

Edit Add Tools

——

er | G e
Open... Ctrl+0 Template ©) Components  (7) Constraints

Hel
Save Ctrl+5 Template Library... Display Point Names £
Save As.. [ Display Al Compenents
Close

2. Create and re-name five folders. Select the Root folder and repeat steps to include all the following
folders:

Components
Corridor Templates
End Conditions
Linear Templates
Surface Templates

O O O O O

B | Create Template .

File Edit Add Tools

Template Librany:
3 Ce'projects" 220459555201 roadw
'ZZ Paint Name List
[ Components
=
(7] End Conditions
[ Linear Templates
[ Surface Templates

3. Select File > Save to save the project Template Library .itl file.
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TEMPLATE DESIGN - Using the Template Library Organizer Chapter 5

Exercise 5.3  Using the Template Library Organizer

This exercise uses the Create Template dialog to open the Template Library Organizer from the Tools menu
option. Various components and templates from other Template Libraries and Roadway Designer files are
obtained from using the Template Library Organizer. For the Chapter exercises to follow, the FDOTSS4
Template Library contains a basic Typical Section and all of the components used for the project design.

1. Use Create Template and select Tools > Template Library Organizer.

B " Create Template_
,.-l"_

File Edit Acdg

Template Library: Ternplate Library Organizer... I

Apply Feature NMame Override...
Apply Component Name Override...
Options...

Dynamic Settings

Ternplate Library Report (itl File)

2. Fromthe Template Library Organizer dialog, click the Ellipses icon next to the OK button. The Open
Template Library window displays.

B ' Template Library Organizer — =NED X ]
Available In: Available In: - 0K
£ C\e'\projects' 22043555201 \roadway' 22043555201 & [T Active Design File Comidors Q [ _,
Help |

3. From Open Template Library, navigate to the c:\FDOTSSA\GEOPAK \corridor folder and select the
FDOTSSA4.itl Template Library file. Click Open.

Open Template Libra

Loolk in: . comidaor - G ? ¥ E]v

o= Name Date modified Type
g . help 3/3/2015131PM  File folder
RecentPlaces g ahles 3/3/20151:31 PM  File folder
£ | EmptyProject tl 2/19/20159:26 AM  TTL File
) FDOTSS4.it 9/2/201511:16 AM_ ITL File

Type: ITL File
Size: 5.81 MB
Date modified: 9/2/2015 11:16 AM

Libraries

Ay
L

Computer

4

@
File name: FDOTS54 1l

Files of type: Template Librares (" itl)
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5-10

4. The Template Library Organizer dialog displays with the .itl file listed in the right Available In:

# ' Template Library Organizer

window pane.

TEMPLATE DESIGN - Using the Template Library Organizer

Available In:

Awailable In:

5.

6.

5 C\e\SS4projects 2204555520 T\roadway' 22049555201 il
"ZZ Point Name List
[Z1 Componerts
[0 Comidor Templates
[Z1 End Conditions
[Z1 Linear Templates
[0 Suface Templates

== Poirt Mame List

[ Componerts

[ End Conditions

[ Bxamples{For Training)
[ Existing Feature Templates
|27 Bxisting Pavement Slope
[ Linear Templates Commaon
|21 Median Conditions

27 Suface Templates

[Z] Typical Sections (PPM)

k] C:\FDOTS54_server\GEOPAK comidor\FDOTSS54 itl

From the Template Library Organizer, navigate to the FDOT folder shown below.

Select the PPM EXHIBIT TYP-5 to preview the template in the Preview window below the directory

view.

{23 C\FDOTSS4_server\GEOPAK comidor\FDOTSS4 it

EE Point Mame List
[ Components
[ End Conditions
=3 Bxamples(For Training)
(7] Design and 3D Modeling Course Guide Template
[ Ramp Teminals
3 Typical Sections (Variable Median)
£ 4 Lane Divided Arterial (45 MPH or Less)

[ 4 Lane Divided Arterial (55 MPH or Less)
[ 4 Lane Divided Arterial (Urban Ditch)
[ 6 Lane Divided Arterial

[ Bdsting Feature Templates

[ Bdsting Pavement Slope

[ Linear Templates Comman

[ Median Conditions

[ T A RN, RV (R
1 3

-~

m
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TEMPLATE DESIGN - Using the Template Library Organizer Chapter 5

7. Drag the Template from the right side to the left side onto the Components folder for the project.

-
# ° Template Library Organizer I. 5] _'S__"hl
Awailable In: Available In: “

23 C\e\SSdprojects'\ 22049555201 \roadway\ 22049555201 i | [ (&9 C:\FDOTSS4_server\GEOPAK \comidor\FDOTSS4R | [-2]

*ZZ Point Name List *ZZ Poirt Name List Cancel
=3 Components 7 Components e
[C7 Resurffacing (Miling, Overbuild and Overay) 7 End Conditions \—/E P

23 Bxamples(For Training)
(=7 Design and 30 Modeling Course Guide Template
[Z] Ramp Teminals
25 Typical Sections (VariableMedian)
'\a 4 Lane Divided Arterial (45 MPH or Less)
#x PPM EXHIBIT TYP-5
[ 4 Lane Divided Aterial (55 MPH or Less)
(27 4 Lane Divided Arterial (Urban Ditch)
(2 6 Lane Divided Aterial
[Z Existing Feature Templates
[Z7] Buisting Pavement Slope
7 Linear Templates Common
[Z1 Median Conditions

S oo - T iao o
| L1 2

[ Comidor Templates
|23 End Conditions
[ Linear Templates
[ Surface Templates

m

I

Prewview: Preview:

“ A

8. Collect the following items from the FDOTSS4 Template Library and drag them to the Project Folders
Locations as shown below

FDOTSS4 Template Location Project Folder Location

Examples/Typical Sections(Variable) /4 Lane

Divided Arterial (45 MPH or Less) PPM EXHIBIT TYP-5 to Components

End Conditions/Parts Entire Parts folder to End Conditions
Component/Pavement/Resurfacing Entire Resurfacing folder to Components
Component/Curb & Gutter Curb Type E Inside to Linear Templates

. Outside Lane w/ Paved Shoulder to Linear
Linear Templates Common

Templates
Linear Templates Common Outside Lane w/ Type F Curb to Linear Templates
Surface Templates Pavement Asphalt to Surface Templates

9. Click OK to return to the Create Template dialog and click Yes to the “Save data to file... The FDOT
Standard Items are now saved in the Project Template Library.
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Chapter 5 TEMPLATE DESIGN - Naming Project Templates

Exercise 5.4  Naming Project Templates

This exercise copies and renames the Typical Section obtained from the FDOTSS4 Template Library in the
project Template Library template folder using the Create Template dialog. The Create Template dialog has
functionality similar to Window Explorer to help manage templates for each project.

Note A consistent project template naming convention is valuable as the design progresses. As more
are added to the template design, create a backup copy and add a suffix to the name “_1, _2, _3,
etc.

1. Inthe Components folder, right click on the PPM EXHIBIT TYP - 5 Template, and select Copy.

3 C\e\projects'\22049555201'symb\SRE 1 Name:
"ZZ Point Name List

Description:
5 Components Pt
[ Resurfacing
5 Comid Set Active
& E”_Idlf Cut Ctrl-X
5] Linear| ( Copy , Ctrl-C
= C Paste Ctrl-v
=
=0 Delete Del
23 Surag Rename F2
== Fi
Ternplate Documentation Link...

2. Rightclick on the Corridor Templates folder and select Paste. Right click on the copied EXHIBIT TYP
— 5 Template and select Rename.

£5 Ce'projects" 2204955520 1 eymb \SRE1 il Mame:
"ZZ Point Name List -
== Descriptior
=3 Components ~
[ Resurfacing
== PPM EXHIBIT TYF-5
=5 Comidor Templates
S E Set Active
& E Cut Ctrl-x
= Copy Ctrl-C
g Paste Ctrl-V
=
as Delete Del
o E
{ Rename ’ F2
ernplate Documentation Link...
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TEMPLATE DESIGN - Naming Project Templates

Chapter 5

3. Change the Name of the Template to SR61. Right click on the SR61 Template and select Set Active. A
small red box will indicate the Active Template.

B " Create Template

=]

File Edit Add Tools

- Components

[ Resurfacing

=< PPM EXHIBIT TYP-5
- Comidor Templates

3 End Conditions

[ Parts
- Linear Templates

= Curb Type E

= Outside Paved Shoulder

= Qutside Type F Curb 2% w/Sidewalk
4 Suface Templates

»=¢ Right Pavement/Travel Lanes 2%

Library  Active Template

Preview:

Template Library: Current Template
& Ce\projects' 2204555520 1\symb \SRE1 itl Name: SR61
== Point Name List Descripiion:

Display
@ Components

Display Point Names

Constrairts

Display All Components

4. Select File > Save to save the Project Template Library.

FDOT Roadway Design and 3D Modeling
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Chapter 5

Exercise 5.5

Creating a Resurfacing Template

TEMPLATE DESIGN - Creating a Resurfacing Template

This exercise creates a Resurfacing Template within the project Template Library. This exercise helps provide a
basic understanding of the basic template creation methods from the FDOTSS4 Template library components

types, connection points, constraints, targets, etc.

1. Right click on the Corridor Templates folder and select New > Template.

File Edit Add Tools

Template Librany:

9 Cheprojects' 22049555201 \symb S RE1 it
EE Point Mame List
i=5] Components

[ Resufacing
== PPM EXHIEIT TYP-5

EE New

Folder

Cument Tem,
Mame:

Description:

En
= o Cu Ctrl-X 6 emplate
5] Lir Copy Ctrl-C

= Paste Ctrl-V

=

=t Delete Del [k
a il: Rename F2

2. Right click on the New Templatel and select Rename. Change the Name to RRR98 and Select Enter

to store the name.

3. Right click again on the RRR98 and select Set Active.

23 C\e'\projects\ 22049555201 symb \SR61 it

5-14

EE Point Mame List
5] Components

[ Resurfacing

== PPM EXHIBIT TYP-5
5 Comidor Templates

5 End Conditions

[ Pars
5 Linear Templates

== Curb Type E

== Qutside Paved Shoulder

== Outside Type F Curb 2% w/'Sidewalk
5] Surface Templates

== Right Pavement/Travel Lanes 2%

©2016 FDOT
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TEMPLATE DESIGN - Creating a Resurfacing Template Chapter 5

» Before Adding Components, Open Preference File that Adds a Prefix to the Point
Names.

1. Select the Tools > Options from the Create Template dialog to launch the Template Options dialog.

i ' Create Template

File Edit Add | Tools

Template Library: Template Library Organizer...
= Co\e'projects'| Apply Feature Name Owverride... 3
é (P:Dlnt Nam Apply Component Name Override...
ompaner;
[ Resurf Options...
= PPME

Dynamic Settings
Comidor T
3 Comdor Te Template Library Report (itl File)

2. Click the Preferences button and then select the FDOT list item. Click Load and then Close the
Preferences dialog. Click OK to close the Template Options dialog.

Template Options X

MNaming Options
Component Seed Name:
@) From Feature Definition

") Specify:
Point Seed Mame: -
Apply Affices
Prefic
Lkt - Preferences
Right: 1| Mame:

T
Step Options {“-@

X pipoooo Yo ol

Active Preference: Default
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Chapter 5 TEMPLATE DESIGN - Creating a Resurfacing Template

3. Select the Tools > Dynamic Settings from the Create Template dialog. This provides a toolbox like
dialog for placing components.

Note The X'and Y Step value 0.1000 functions similar to a grid lock in MicroStation when placing the
components

Dynamic Settings @

X |0.000000 @
I

0.000000 Step: 100000

Paint Mame: -
Foint Style: [ Archeological Site v |
Apply Affixes

I hs= - I

[Set Cymamic Origin ]

4. Change the Point Style to Template Miscellaneous.

Dynamic Settings @

¥ 0.000000  Step: 0100000
Y- 0.000000 Step: 0100000
Point Mame: -
Point Style:  (TemplateMisc_pr Jy)

e ——
Apply Affixes

h5= -

[Set Cymamic Origin ]

5. Uncheck Apply Affixes.

Dynamic Settings @

X -1.737602 Step: {.100000
Y. |0284752 Step: 0100000

Point Mame: -

Point Style: [TemplateMiSC _pr ']

[ Set Dymamic Crigin
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TEMPLATE DESIGN - Creating a Resurfacing Template

» Add Components

1. Navigate to Components/Resurfacing/Overlay and select the Pvt Overlay Right Component.

Template Librany:
—4 Ce'projects’\ 22043555201 eymb
EE Point Mame List
—4 Compaonents
— Resudfacing (Milling, Cverb
71 Milling
) Cwerbuild
— Cveray
= Pyt Overay Left
ot
7 Widening
== PPM EXHIBIT TYP-h
— Comidar Templates
b=] RRR98
== SRE1
7] End Conditions
7] Linear Templates
1] Surface Templates

2. Drag the Component to the small magenta square in large View.

Name: RRR32 @ Componerts Constraints
Help

—4 Cle'projects’ 22049555201 symb SRE1.itl
Display Point Names

== Paint Name List Description:
—3 Components
— Resufacing Display All Components
(3 Milling
(£ Overbuild
— Overay
= Left - 2" Depth ME
b
(£ Widening
== PPM EXHIBIT TYP-5
3 Comidor Templates
f=q RRR38
*={ 5R&1
3 End Conditions
] Parts
3 Linear Templates
== Curb Type E
»={ Outside Paved Shoulder
>={ Outside Type F Curb 2% w/Sidewalk
— Surface Templates
= Right Pavement,/Travel Lanes 2%

©2016 FDOT
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Chapter 5 TEMPLATE DESIGN - Creating a Resurfacing Template

3. Repeat this step to place the Pvt Overlay Left Component on the small magenta square.

Display

Template Library: Current Template
@ Components Constraints

2l Ce'projects' 2204355520 T\symb' Name: RRRS2
== Point Name List < .
=3 Components Description: | Display Point Names

— Resurfacing (Milling. Overby Display Al Compenents
(£ Miling
(£ Cwverbuild
— Overday
=
>={ Pvt Overlay Right
(£ Widening
= PPM EXHIBIT TYP-5
3 Comidor Templates

b=J RRRZE
= 5RE1
[C1 End Conditions ] LT -PVT- OLAY. -QUT-
LT_PVT_OLAY_BOT_OUT

[ Linear Templates
3 Surface Templates

4. Fit View by selecting the Fit icon below the Active Template window.

5. Drag and drop the Resurfacing/Milling/ Pvt Milling Right Component and connect it to the bottom
side of the Overlay Component in the Template. The cursor will turn white when it is lock on the

location.
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TEMPLATE DESIGN - Creating a Resurfacing Template Chapter 5

6. Repeat this step for the Left Milling Component.

g IR ' ' ' y

7. Drag and drop the Resurfacing/Overbuild/ Pvt Overbuild Right Component and connect it to the
bottom side of the Overlay Component in the template. The cursor will turn white when it is lock on the
location.

F=o-to . g ' ' T

8. Repeat this step for the Left Overbuild Component.

e R A )
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Chapter 5 TEMPLATE DESIGN - Creating a Resurfacing Template

9. Check Apply Affixes on the Dynamic Settings dialog.

Dynamic Settings

¥ -1.737602 Step: (100000

Y.  |0.284752 Step: (100000

Point Mame: -

Point Style: [ TemplateMisc_pr |

| Set Dynamic Crigin |

10. Drag and drop the Linear Templates/Outside Lane w/ Paved Shoulder Component and connect it to
the top side of the widening template. While dragging Right click and turn On Mirror.

Mirror Ctrl-M
Reflect Ctrl-R
Cancel ESC
Set Dynarnic Origin Ctrl-D

gEVT_EOP_IN
LT PVT_OLAY OUT PVT_OLAY _BOT_IN RT_PVT_OLAY_OUT

O BOT OUT RT_PVT_OLAY BOT OUT
LT_RT_PVT_EOP OUT RT_RT_PV

T RT ESHDBS R HER ST o o T-FVT-ADS1.BOT.OUT FTRT-PVTADIBOT.OUT  op ooy

LT_RT, BSREORS VIR B QUTER BOT OUT
V'RT_UPSHIDR ROLLOVER-OUT

AT NS AR RGO 95 67

LT_RT_PSHLDR_ROLLOVER_BASE_BOT_OUT

BT RT PR AGEE SRR @YT_out

\T_RT_PVT_ADJ1_BASE_BOT_OUT RT_RT_PVT_ADJ1_BASE BOT QUT

11T FETT FRNT ERSSEEBOR@OT OUT R RIT AWIT BAESE BEXTIOW0T OU
5]

R oy s [k ]12.000000 Step: 0100000 >
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TEMPLATE DESIGN - Creating a Resurfacing Template Chapter 5

11. Modify the Widening lane Width and Slope,

a. Edit the Point RT_PVT_EOP_OUT, double click on the Point to open the Point Properties
dialog.

b. Change the Horizontal Constraint Value to 1 and Slope Constraint Value to -2%.

Point Properties.

Mame: RT_PWT_ECP_OUT
Use Feature Name Overide: |RT_PVT ECQP OUT | Close | l
Feature Definition: PavementAsphalt_pm v| |m| I
Superelevation Fag S
Meadt >
Altemate Surface: - |7|
| Help |
Member of:
RT_PwtOut
RT_ShidrPvtOut
Constraints
Constraint 1 Constraint 2
Type: | Harizontal - | | Slope - |

Parent 1 [RT _.i’\fT_OLAY_OUT | ﬂ |HT_F}'JT_O|_AY_0UT - ﬂ

Value: 1.0000 BIGEL =

Label: EOP_WidthOut - EOP_SlopeOut -
/| Horizortal Feature Constraint:  Pavement Asphalt(EOPA) -

Range:  50.000000

12. Repeat for the Left Side Widening Pavement, LT_PVT_EOP_OUT, use Horizontal value -1, and Slope
value 2.0%.

» Add End Conditions to the SR61 and RRR98 templates

1. Drag and drop the End Conditions/Parts 6:1 Cut and 6:1 FILL TO 5> Components to both sides.

2. Select File > Save to save the Template changes.

Note The undo icon is also at the bottom of the view.
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Exercise 5.6  Editing Templates
1. Onthe Create Template dialog, check On the Display Point Names option.

T e e T T N T

File Edit Add Tools

Template Library: Cumrert Template Display
3 C'e'projects’ 2204955520 1'symby | Name: RRR58 @ Components Constraints
E‘E Poirt Name List Description: | Digplgl Poirt Mames
(] Components
—4 Comidor Templates || Display All Components

=] RRR92
» Change End Condition Point Properties

1. Double click on the RT 6:1 Cut Point to launch the Point Properties dialog.

Name: RT_6:1Cut

V] Use Feature Name Ovemide: RT_CLIT
Feature Definition:

Cut_pm v‘
Superslevation Fiag
Atemate Surface -
End Condition Fropetties
7] Check for Interception Member of
RT_1ECUT

] Place Poirt at Interception
End Candiion is Infinite
Do Nt Construct

Constraints
Constrairt 1 Constraint 2

Type: [ slope | [ Horizontal |

Farent 1 [RT_LT_UPSHLDA_OUT v\ﬂ |RT_LT_UPSHLDR_oUT vlﬂ
Parent 2

RT_Wr BURL QR ouT | Value: 16.67% [s)  30.000000
Label

Horizontal Feature Constraint:

= oH-toa

2. Check the End Condition is Infinite box and change Constraint 2, Horizontal Value, from 30 to 5 feet.
Click Apply and then Close.

V| Use Feature Name Ovemide: RT_CUT Close

Featurs Definition P =) [ <Provos |
Superelevation Flag
Atemate Suface .
End Condtion Properties
7] Check for Interception Member of:
Place Point at Interception RT_16CUT
gXondition s Infinte

[7] Do Mot Construct

Constrairts
Constraint 1 Constraint 2

Type: | Slope: ~| | Horzontal M

Parent 1 [RT_LT_UPSHLDR_OUT v\ﬂ [RT_LT_UPSHLDR_OUT v|ﬂ
Parent 2:

Value 16567% (=K 500000

Label.

Horizortal Feature Constraint:

=55+-t0 M
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FDOT Roadway Design and 3D Modeling

Chapter 5

3. Repeat these changes for the remaining End Conditions; RT 6:1Fill, LT 6:1Cut, RT 6:1Fill.

Hint  Use -5 for left side points. To edit consecutive points, click the pick icon next to the point name and select

the next point.

RT _6:1Cut]
[¥| Use Feature Name Overide: RT_CUT

C 4

| RS RPN B RE 7T [

4. Select Fit View the Active Template and changes.

_F"u'T EOP_IN

| CRMAL @PT

LT R
LT_PVV_EOP_OUT PVT_OLAY BOT_IN

LT_LT_PSHLDR_ROLLOVE]

BOT OUT
H BOTTP_ OUT
LT_LT_PSHLDR P‘ T, TOP nu%[ N

et uPbHLwLﬁﬂfﬁ@ﬁm P\,&ﬁg Qr-Rut

.
LT_UPSHLDR OUT ) 1) ¢TopwToa@E OXMN_TOP_OUT

L%TL#Tpgﬁﬂbﬂﬁﬁg%Egj#—é%% Wlor TP out

LT LT_PSHLDR RGAOYERBASE BET OUT
| CTPRY ' BASEEERTN 80T OUT

LT TR HRRERAREERTN-BBT ouT

T I I

RT_PUL BUAY OB T
RT_PVT_EOP_OUT

RT. LT FSHLDR ROLLOVER_OUT.

RT_PVT _OLAY BOT (
RT_LT_PS HLDF! I"v’T BOT TP QU
VT TOP_OU
RTPTBOTIN RTL’IF‘HLDF’F‘TTF‘ uT

mﬁﬁ%&"ﬁﬁﬁh%ﬁ AYPVER_OUT

RT SHLBF’ F'VT BAS TP U‘J PSHLBDR OUT
P TLETPRVTBEA: i) e u

BT LT puT BASEEHD E“#gﬁﬁ SRR ror our

RT PVT BASE BHILINPSHLDR ROLLGVER BASE BOT OUT
FRTPFTTERSEEBRATOWOT OUuT

R LT rPBE PR BAREEBEITR WoT ouT

5. Rich click on the each Fill components and choose edit properties. Change the Priority Value to 2

Name: [T

V| Use Name Ovemide: LT FILL

Description:

Feature Definition:

Parent Compaonent:

Display Rules:
BExclude From Top/Bottom Mesh

End Condition Properties
Target Type: | Temain Model .,l Priority:

Terrain Model: -

Horizortal Vertical

0.000000 Rounding Length

©2016 FDOT

Benching Col

Close

€ Prewou

D
urt:

0.000000
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Chapter 5 TEMPLATE DESIGN - Editing Templates

6. Turn OFF the Horizontal Feature Constraint on the middle point, PVT _EOP_IN Point.

Point Propertie I]
MName: - ﬂ Apply

Use Feature Name Ovemide: |PYT _EOP_|N | Close |

| Feature Definition: PavementAsphalt_pm

| < Previous |

Superelevation Flag [
| Nex > |
Altemate Surface: - | ——
| Help |

Member of:

LT_PwtOveday

ABFCES TR ouT RT_PvtOveray

BOT OUT
Constraints

Constraint 1 Constraint 2
Type: None

BABBTRBHT TORTOoUT
BASE SHLDR_TP. OUT

BASE .BOT.-OQUT

Horizonjel Feature Constraint:

7. Select File > Save to save the Template changes.
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Chapter 5

» Change the Overlay Depth Properties

1.

2.

3.

Change the bottom tab on the left side of the Create Template dialog to Active Template.

B ' Create Template

File

Edit

Add Tools

=-{C7 Points

{:l Components

-2 End Condition Branches
-2 Parametric Constraints

{:l Altemate Surfaces

{77 Poirt Feature Definitions
{:l Component Feature Definitions

ltem

Value

1|

1 | »

Librany H Active Template ’

Preview:

Open the Parametric Constraints folder, double click on the OLAY_PvtThick Label and change the
Default Value from -.25 to -2/12. Click OK.

F

ile Edit Add Tools

=45 Parametric Constraints
-~ EQP_Base ThickLt
f--f% EOP_BaseThickRt
-“f EQP_ExiBaselt
-~ EOP_ExtBaseRt
F-“f EOP_PwtThicklt
it EOP_PvtThickRt

/—Iﬁ‘\tﬂmmmmmm

[l OLAY_Pvi Thick Rt
-1 OLAY_PyvtWidthlt
[T OLAY_PytWidth Rt
- PSHLDR_BaseBdWidtl

S LN Tl TI o) o T TR BPRT YN

FDOT Roadway Design and 3D Modeling

m

Curent Template
Name: RRRS8

Description:

OLAY_PvtThick

——
Default Value: .g, 15555?

Repeat these steps for the OLAY_PvtThickLt and OLAY_PvtThickRt Labels.
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» Change the Milling Point Properties

1. Zoom in the Active Template View to the Right Widening side.

RATVEMT EMALY CFUT

RT_PVT_EOP OUT

RT_LT_PSHLDR:ROLLOVER CUT

RT_PVT_OLAY_BOT_OUT

RI, LT_PSHLDR_EVT_BOT_TP_QUT

T R = IR

2. Right click on the RT_PVT_OLAY_OUT and select Edit Point.

Add New Component

Template Documentation Link...
Check Point Connectivity...
Delete Components

Change Template Origin

Delete Constraints from All Points.

Add Tonstraint RT_LT_PSHLDR:ROLLOVER_OUT

Delete Both Constraints
Delete Slope Constraint

Delete Horizontal Constraint

Delete Point
d=E oD L] Delete From Components (Make Null)
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a. Change the Constraint 1, Horizontal Value from 12 to 5 feet.
b. Change Constraint 2, from Slope to Project to Surface.
c. Setthe Constraint 2 Value to Active.

d. Click Apply and then Close.

Mame: RT_PWT_OLAY_QUT A ﬂ

["] Use Feature Name Ovemide: RT_PWT QLAY OUT

Close
Feature Definition: PavementMiling_pm *] -
< Previous
[ Superelevation Fag
-_Next b3
Atemate Surface: -
Help
Member of
RT_PuwtOut
RT_PwtOverday
Constraints
Constraint 1
Type: [ Horizontal A ]
Parert 1: [pw_EOp_m v] ﬂ Any Direction
Value: 5 0000 E] <Active: -
Label: OLAY_PutWidthRt - - M
[ Horizontal Feature Constraint:  Pavement Miling{ML) -

Range:  50.000000
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3. Repeat these steps for the LT _PVT_OLAY_OUT, change the Horizontal Value from -12 to -7 and
Slope to Project to Surface.

Point Properties IJ

Name: LT_PVT_OLAY_OUT - ﬂ
Use Feature Name Ovemide: LT PYT QLAY QUT |W|
Feature Definition: PavementMiling_pm T| |M|
Superelevation Flag I
Mext =

Altemate Surface: - |—|
| Help |

Member of

LT_PwtOut

LT_PwtOveray

Constraints
Constraint 1

Type: | Horzontal

Parent 1: | pyT_EOP_IN

Value: 7.00000
Label: OLAY_PvtWidthLt - -
/| Horizontal Feature Constraint:  PavementMiling{ML) -

Range: .50 000000

4. Zoom out of the Active Template to view the results.

gRVT_EOP_IN

LT _PVT OLAY_QUT
LT PVTIEOP_OOT

LT_LT_PSHLDR ROLLO'

1" OLAY_BOT_QUT
LT LT-FSRLDRPVT BOT TP-OUT
vi TOP.O
LT_LT_PSHLDR_PVI TOP OUT | "o

o vrsog aouelHEEIRLRTSn0N

LT_UPSHLDR_OUT LETLETROYTRASE OUR_ TOP OUT

k 'LTL*TPBﬁEbRRERSFT ﬁ?f’ﬁ%ﬂi&\g EH LDR TP OUT

LT LT PSHLDR ROELBVERAASRHOTNOUT
LETERFYTERSEEERDN_BOT CUT

LETLHTRBRTBRARRAEEEREN_BYT out

*=hoH-t0 ul- ]

5. Select File > Save to save the Template changes.
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RT_PVT_QLAY OUT
RT_PVT_EOQP QOUT

RT_LT_PSHLDR_ROLLOVER_QUT
RT_PVT_QLAY BQT OUT
RPN BR Py ot TP
BT LT PHLDR AVT TOR OUT
RT_PVT BOT | ’ or.o

N
RATPPVT BH LOVER_QUT
e e A

RATLTTPFVIBBASEURTN TOP mL; UPSHLDR f“*
RT LT PvT_BASE SHTOH TR BRSO ouT

RT PVT BASE BcRTWLT PSHLDR ROLLOVER, BASE_BOT OUT
RRIPPVIESREEBEATALHOT OUT

RATLTTPPYLPHRBARSEBEXTRWHoT ouT
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» Change the Widening Point Properties

1. Double click onthe RT_PVT_EOP_OUT to edit the Point Properties.

PVT EC
& T_ECP_IN

RT_PVT_EOPOUT

| PavementAsphat_pm

Superelevation Flag

RT_PVT_OLAY_ OUT
PVT_OLAY. BOT.IN R ] PVT_EOP_Ol

Atemate Surface:

Member of

RT_LT_ShidPviOut
RT_Pvilliden

RT_PVT OLAY BOT_OUT Constraints
RT LT_PSHLDR Coretrael] =
Type:

| Slope - | Horizontal M

Parent 1 = =
RT PUT BOT iN are [RFviotavour  +| #| [RTPviolavour  «| +|
Parent 2 Rollover Values

RTERVEVBOBASH _
Value -200% (&) 2000000
RT_SHLDR_P| e - WideningWidihFt
V| Horizortal Feature Constraint
RTRHT \AVEAAOR Pavement Asphak(EOPA)
Range: 50000000

RE_LT_PVT B~

2. Change the Constraint 1, Horizontal Value from 1 t0.01 feet and Horizontal Feature Constraint Range
from 50 to 100 feet. Click Apply and then Close.

Point Properties I 3 1

Name: RT_PVT_EOP_OUT - #|f
Use Feature Name Overmide: |RT _PVT _EOP OUT | Close | I
Feature Definition: PEVEI’I’IEI’ITASD"IE“J]H'I ‘r| |m|
Superelevation Flag S
| MNex |
Altemate Surface: |
| Help |
Member of ;
RT_PwtOut
RT_ShidrPwtOut
Constraints
Constraint 1 Constraint 2
Type: | Haorizontal - | |5I|:.|pe - |

Parent 1 [RT_pvT OLAY OUT =] 4| [RT_PvIOlAY OUT | 4]

vaive: (" 0.010000) E 20z (=]
Label: EQOP_WidthOut - EQOP_SlopeCiut -
/| Horizontal Feature Constraint:  PavementAsphatt{ECQPA) -

Range”  100.0000
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3. Repeat these steps for the LT_PVT_EOP_OUT, change the Horizontal Value from -1 to -.01 and
Horizontal Feature Constraint Range from -50 to -100 feet. Click Apply and then Close.

Point Properties "“

Mame: LT_PWT_ECP_OUT

- 4

Use Feature Name Ovemide: |LT PYT EOP_OUT | Clase | I
Feature Definition: PavementAsphakt_pm v| |—f Previous |
Superelevation Flag I
Meat
Altemate Surface: - |—|
| Help |
Member of
LT_PwtOut
LT_ShldrPvtOut
Constraints
Constraint 1 Constraint 2
Type: | Horizortal - | | Slope - |
Parent 1. (LT pvT OLAY OUT  ~| 4| [LT.PvTOLAY OUT  ~| 4]

Value: { _[;._[;.1[:.[:.[:.[:., |E| 2.00% |E|
Label: -EOP_WidthOut - -EOP_SlopeQut -

| Horizontal Feature Constraint :

Rangey” -100.000

PavementAsphalt(EQPA)

4. Fit View the Active Template to view the results.

gRVT_EOP_IN

LT_PVT_OORYOQDITT
PVT_OLAY_BOT_IN

LT_LT_PSHLDR_ROLLOVEI \
EHAYRBOVIOROT TP_OUT

/LT LT_PSHLDR_PVT_10P_OUT

L LT_UPSHLDR_ROLEONEHL BT IHBART I HOROBAUT

- LT SHLD?%T E;%g TQL%U
LT_UPSHLDR_OUT 1T LTRRYTRESHE ©OUN TOP OUT

ERE sHioR TR oOT

CHLTREARRRYE BT I

LT LT _PSHLDR_ROLLOVER -BASE- BOT -OUT
LLTEPYTREBASEEROT_BOT oUT

LETLHTRERTRFRRSEERAN B ouT

5. Select File > Save to save the Template changes.
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RT_PVT_BORYODIT

RT_LT_PSHLODR_ROLLOVER_OUT,

RT_PVIPESHRFRBEVIOBOT TP OUT
RT_LT_PSHLDR_PNT_TOP_OUT

REIPYTIBEFEBLEY TFvERSHbE RROLLOVER OUT

e ]
RT_SHLLA_PVT BASE TP
HT_LT_UPSHLDR_OUT

Rﬁﬂ-'[TPVGTEQILﬁxF‘{rN TOP_OU T oUT
- Y| '% ~ -
RT_LT_PVT_BASE_SHIEK prOTEE BRSECERRNTTOP OUT

RT_LT_PSHLDR- ROLLOVER -BASE BOT QUT
RRIPPTIBASEEBEXTRUEOT ouT

RAT-TPPYHPBRBARBEREX TN UAOT oUT

FDOT Roadway Design and 3D Modeling



TEMPLATE DESIGN - Editing Templates Chapter 5

» Check the Milling Component Properties

1. Double click on the bottom line of the RT_PvtOverlay to open the Component Selection dialog and
select the RT_PvtMilling option to edit the Component Properties.

gfvVT_EOP_IN

T_PT_ERAYOODT TR @Oy QT
RT_LT.PSHLDR_ROLLOVER_OUT,

Q‘Lru AY ROT IN
e
Component Selection

ADBPIOBDT TP OUT

!
LT'LT_PSHLDR_PVT_i0P e RT_[T_PSHLDOR. PYT TOP OUT

(T UPSHLDR N Y 4 { B / LLOVER OLT
IE‘OLW'LT'SHLDFVTPP g g TFERSELP ROBPLLOV

{T_UPSHLDR_OUT | e y Ui T0p OuT-LT_UPSHLDR oUT
LT+ TREREBRABRY " ARt L PEHiBR ERSEOEXPH TTor ouT

RT_LT_PVT_BASE SHLDR

LT_LT_PSHLDR

LT-LT- PSHLDR_ROLLOVER -BASE-BOT GQUT RT_LT_PSHLDR ROLLOVER -BASE. BOT_ _OUT
| A TEROTE B IO0_GWT ouT FRRIPPBERESERINUE0T ouT

LT+ TREREBRFRSEERAT BHT ouT RET-T1PRYHRBREARS B RXTRUoT ouT

2. Change the Overlay/Stripping Properties / Bottom option from Follow Surface to Follow Component.
Click Apply and then Close.

Note This is the appropriate setting for constant depth milling to match existing pavement slope between
two points.

MName:
Use Name Ovemide: |RT Pyl

Description:

Feature Definition: | PavementMiling

Parent Component:

Dizplay Rules:
[] Bxclude From Top/Bottom Mesh
Cweray/ Stripping Properties

RS |F':'"':"""' Surface '| Altemate Bottom Suface:

Bottom option: | Follow Component  + |

Component Depth: 0.000000 Label:

Surface: |:}-‘u:‘ti'-:e> ,| | Stripping Companent

Surface Depth: 0.000000 Label: pyt MillingDepth
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Repeat these steps for the LT _PvtMilling Component, change the Overlay/Stripping Properties / Bottom
option from Follow Surface to Follow Component. Click Apply and then Close.

i

Name: LT Puibliing
[] Use Name Overmide: LT_PwtMilling

Description:

+|

Feature Definition: [Pavernent Milling

Parent Component:

—

v] Mext =
F

Display Rules:
[7] Bxclude From Top./Bottom Mesh

Chweray/Stripping Properties

Top option: [Fnlluw Surface

Bottom option:

Companert Depth: 0.000000

Surface: [ <Actives

Surface Depth: 0. 000000

4. Select File Save to save the Template changes.

©2016 FDOT

[  —

'] Atemate Bottom Surface:
[Fnlluw Component v]
Label:

v] Stripping Component

Label: Pyt MilingDepth
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» Insert a Milling Slope Break Template Point

1. Rightclick onthe RT_PvtOverlay Component and select Insert Point.

gBVT_EOP_IN

ht click h Add New Component
right click here
9 Template Documentation Link...
LUT FRNIT EDIFROQ DU T Check Point Connectivity...
PVT QLAY BOT i Delete Components

Change Template Origin

{ Delete Constraints from All Points
T_PSHLDR_ROLLOVER_OUT RT_LT_PSHLDR_ROLLOVER OUT

Edit Component...
Tnsert poin

MEALERBVT GOT TP OUT Unmerge Component Points hOVOWDT TP OUT

Set Component Display Rules i} )
oUT RT LT PSHLDR PVTT|

Delete Component

: Tl ! )ﬁWTDP out igi BETEXTN. TO| T
T_PSHLDR nohcﬁm oot SR E D EXTN TR B4 br_RoLLOVER
LT SHLDR PVT BASE TP IN RT SHLDR PVT BASE TP IN

2. Data point in the Active Template View to store a point. Right click and select Finish.

data point here

LT FRNT EQIFA QWD T FRTRUTEGF OUT
PVT .QLAY-BOT N

T_PSHLDR_ROLLOVER_OUT RT_LT_PSHLDR_ROLLOVER_OUT

TrSALE BOT BT TP QUT BT AVT F8HO0ROTVO WDT_TP_OUT

oUT RT LT PSHLDR PVT-T|

‘ ] T10P.C T TR \
T _PSHLDR RGkT {gm\f E‘ﬁw TOP_OUT - EXT%J\E? QEJLDR ROLLOVER_BOT_O¢

LT SHLDR_PVT_BASE TP_IN RT_SHLDR_PVT_BASE TP_IN
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3. Double click on the new Point to edit the Point Properties. Change the Point Constraints as shown.

Point Properties
Name: - ﬂ Appiy

IUse Feature Name W RT_ML_BREAK | Close |
M Feature Definition: |Pavemen‘tC_rc|WnJ:lm

v
| < Previous

Superelevation Flag

Altemate Surface: -

|
[ Net> |
e |

Member of:
RT_PwiCveray

Corstzints
Constraint 1 Constraint 2

Tﬂj‘\. |Hu:uriznrrta| vl Project To Surface
Parert 1: N, [pyT_EOP_IN ~| 4| " Any Direction
WValue: 0.100000

Label:

Horizontal Feature Constraint:

4. Click Apply and then Close.

_ﬁ‘u’T, EORMIN BREAK

2

PYT- OLAY BOT-IN

T = I Z P -
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5. Repeat the steps above to insert Points on the bottom of the PvtOverlay, PvtMilling, and PvtOverbuild
Components.

Hint  [finsert point option is not available for the last component, use add point

_£VT, EOAMIN BREAK

[

PYT- @AM LBBRENK BOT

T = I Z P -

6. Setthe Point Properties as shown.
Point Properties l]
Mame: - ﬂ Aoply

Use Feature Name 0‘% RT_ML_BREAK_BOT | Cloge |
Feature Defintion: |B|:|’rt0m4:|ﬂ'l

v| | « Previous
Superelevation Flag

Altemate Surface:

|
[ Nex> |
_ Hep |

Member of -

RT_PwtMiling
RT_PwtOverbuild
RT_PwtOveray

Constrgirts

Constrairt 1

Constraint 2

Type: \l Harizontal

Vertical

Parert 11 "|RT_ML_BREAK

RT_ML_BREAK

Value: 0.000000
Label:

Horizontal Feature Constraint:

-0.166667
OLAY_PwtThick Rt

Hint ~ When inserting the point on the PvtMiling and PvtOverbuild components, data point on the
RT_ML_BREAK_BOT point to save from setting any other Point Properties edit steps.
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7. Merge the three points into one final point.

VT EOP IN RT_ML_BREAK

PYT_OLAY BOT IN

ane final point on
all three
components

8. Select File > Save to save the Template changes and then close the Create Template dialog.
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BASIC CORRIDORS MODELS

CORRIDOR MODELING OVERVIEW

As defined in the Bentley Civil Help:

“The Corridor Modeling toolset is a group of highly interactive commands to create new design
surfaces that represent a new roadway or other type of surface. Tools for creation, modification,
management, and report functions are supported.

Corridor Modeling tools aggregates a variety of civil data. The geometry is created with the
Horizontal and Vertical Geometry tools, while the existing ground is defined by a MicroStation
mesh or Civil Terrain Model. Plan view elements, such as edges of pavement, shoulders, curbs,
etc. can be 2D or 3D. Superelevation information is defined within a design file using standards
or imported data. Templates are utilized from one or more template libraries.

Reference files can be used extensively with Corridor Modeling. On a simple project, the data
may be all in one file; larger projects may have geometry in one file, plan view graphics in a
second, terrain in another, superelevation in a fourth and the actual model in a fifth. All files
can reference the others, to present a complete picture of the project.

When working with Corridor Modeling, you can draw in 2D or 3D. When using 2D (such as for
plan-view graphics), a 3D view is automatically created and maintained. For example, when a
vertical geometry element is initially defined for a horizontal geometry element, the Default-3D
model is created, if there isn’t one already. The 3D baseline (combination of horizontal and
vertical element) is drawn into the 3D model. As template drops are added, and progressed, they
are added to the 3D model automatically.

When starting to create a corridor, basic information can be used. A single template can be
used, along with preliminary geometry and a high level terrain model. As the design progresses,
more detail can be added. Instead of a single template drop, perhaps more templates better
define the roadway. Transitions can be added to smoothly move from one template to another.
There may be multiple roadways all interconnected using the target aliasing tools. All the while,
as changes are made, the corridor model is updating, so you see up-to-the minute results. Simple
projects may not require all the tools, and a basic corridor model may be sufficient. But all the
tools are available to handle basic to complex, small-scale to large-scale projects.

The following are minimum requirements to use Corridor Modeling.
o  Civil horizontal element
o  Civil vertical element
e Template stored in a template library

A terrain model is not required for corridor modeling. If the template includes end conditions and no terrain
model is defined, the software generates as much of the model as possible, but will not complete the end condition
that ties to ground and no error message is given.
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EXERCISE OVERVIEW

6.1 Prepare to Create Corridor Model for SR61
6.2  Create Corridor, SR61

6.3 Variable Medians, SR61 Templates
6.4  Add Corridor References, SR61

6.5 Add Corridor Point Controls, SR61
6.6  Add Corridor Key Stations, SR61

6.7  Change Corridor Design Stage, SR61
6.8  Review Corridor Objects, SR61

6.9 Create RRR Corridor Model, BL98
6.10 Create Template Drop, RRR98

6.11 Add Corridor References, RRR98
6.12 Template Point Control, RRR98

Exercise 6.1  Prepare to Create Corridor Model for SR61
1. (Optional) Extract the 22049555201(6).zip file in the c:\e\projects folder.

2. Open the DSGNRDO1.dgn file of the c:\e\projects\22049555201\roadway\ folder in the FDOTSS4
Workspace in MicroStation.

3. Use the Terrain Model, Set Active Terrain Model tool.

#™ Terrain Model BEEA

o o o 22 Ay Oy B R B O,
B B B

B *_] Set Active Terrain Model L%

T I f f

RREA T

4. At the cursor prompt, select the Terrain Boundary green dashed line from the attached GDTMRDO01
reference file. This will set the terrain model as Active.
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5. Move the cursor over the SR61 Centerline Feature and verify an Active Profile.

Complex Elernent: 5RE1
Feature: Centerline{CL)
Active Profile: SRG1_PR
Level: CLConst_dp

6. Use the Corridor Modeling, Create Template tool.

ffl corrider Modeling R

Qe V) A
w l_f_.u | TJ' . |_.H.H Ell \N Create Template |
= mEE WY &

A v W g

T © s - - O €6 1 g

F ] ——

HinT  Use the F12 function key to access the Create Template Dialog.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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7. Verify that the correct Template Library is loaded Close the Create Template dialog.

File Edit Add Tools

Template Library:
23 Ce'projects' 22049555201 roadwa\ 22049555201
"=Z Point Name List
1 Components
— Comidor Templates
»= RRR38
E SRE1
7] End Conditions
7 Linear Templates
7 Surface Templates

8. Tosetup the Views for viewing the 2D Plan and 3D Model simultaneously in the FDOTSS4 Workspace,
Select the F2 Function Key on the keyboard. This will open an Isometric View of the project.

) Element Selection | = X
20§ Element Selection [ -] || a View?, Default-30 e

=) Flozo ) S | oY R @ -~ AQRHBHPpO| YR HvE 6
Ele-ae L |
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Exercise 6.2 Create Corridor, SR61
1. Use the Corridor Modeling, Create Corridor tool.

ffl corridor Modeling
Ul VN A=
"TEwyEwY g

e R A e N b~ el |
R o5 & 33 IR d

H
i
n
>

S L -

rmay

2. Enter the Corridor Name, SR61, in the Create Corridor dialog and then select the SR61 Centerline in
the Plan View.

Locate Profile Element
Caorridor Name SR&1

Dlezign Stage 1TPRELIM

Level: GradeLine_pg
_ ATLIC

e
Attribute = CLC

3. Reset to accept the Active Profile. This profile resides with the SR61 Civil Feature Centerline.
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BASIC CORRIDORS MODELS - Create Corridor, SR61

4. Data point to accept the Name of the Corridor, SR61. The corridor is created AND the integrated Create

5.

Template Drop dialog launches.

Note

Once a Corridor is created, a shape boundary is placed in the Plan View representing its outline.

This shape is initially placed on the CorrHndIStg1_dp level. It has several properties which can be
seen by clicking on the shape and choosing first icon. One of the properties is the Design Stage.

.. Create Template Dro

Lock To Start
Start

Lock To End
End

Drop Interval

0.000000

0.000000
10.000000

Minimum Transition Before Drop 0000000

Minimum Transition After Drop

Template

0.000000
Comidor Templates*SRE1

Once the Create Template Drop dialog is opened, first select the corridor template to be placed on
the corridor. Either use the icon on the dialog <OR> select ALT down arrow to pick a template.

Lock To Start
Start

Lock To End
End

Dirop Interval

£98+30.82 R1

726+42 21 R1
10.000000

Minimum Transition Before Drop  0.000000

Minimum Transition After Drop

Template

0.000000

Comidor Templates®\SH

©2016 FDOT
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6. Find the SR61 template in the Corridor Templates folder of the active Project Template Library.

e R T — i
= C_:"'-.e"'-projects"'-.22[:~455552ﬂ'| haymb SRET il
+- Components
- Comidor Templates
- RRRS3

+- End Conditions
+- Lingar Templates
+- Surface Templates

0K | ‘ —

7. Data point to accept the Template and move to the next setting.

8. Continue to define the Create Template Drop dialog information entering and accepting the following
for the SR61 Corridor:

a. Start - snap click to the ML line on 98, Station 700+23.62.

Lock To Start

Start 700+23.62 R1

Lock To End

End 726+4221R1

Dirop Interval 10.000000

Minimum Transition Before Drop  0.000000

Minimum Transition After Drop  0.000000

Template Comidor Templates\SRE1 [
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b. End - snhap to the beginning of the milling, Station 715+73.20. Complete dialog as shown below.

Lock To Start

Start 700+23.62 R1
Lock To End

End 715+73.20 R1
Drop Interval 10.000000
Minimum Transition Before Drop  0.000000
Minimum Transition After Drop  0.000000

Template Coridor Templates’SR61 [

End Station
<Ali> Lock Ta End

9. Upon completion of the Corridor Processing bar in the lower right hand side of the MicroStation status
bar, the 3D model will be displayed in View 2.
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Note Once a Template Drop is created, a shape boundary is placed in the Plan View represent its outline.
This shape is initially placed on the TmpDrpHndIStg1_dp level. It has several properties which can
be seen by clicking on the shape and choosing firsticon. One of the properties is the Design Stage.

Template Drop: SR61-Corridor Templates\SRE1-700+23.62 R1-715+73.20 R1
Level: TmpDrpHndIStgl_dp
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» Turn 3D Reference File Display Off in the Plan View

At times the line work in the Plan View can become confusing with 3D lines over top of the 2D lines. This View
can be simplified by turning the 3D Model Reference file display Off.

1. Data Point somewhere in View 1 to make it active.

2. Onthe MicroStation Level Display dialog, navigate to the Ref. DSGNRDO01 Default-3D file.

|Level Display - View 1

E‘-nl-_li Eﬁ] [View Display  ~ |
N || P Aeve (Lovels =] [&A ~

=8 DSGNRDO1.DGN, Defautt

v Ref, DSGNRDO1.DGN, Default-30
o GDTMRDOZ2.DGN

3. Right click on the file and un-check the Display option.

Level Display - View 1

Ly B} (ViewDispiy ~]
% [ [ teve [omsv) [ -

=Hvy DSGNRDO1.DGN, Defautt

3 [EFEEGEY  Open Didog

v GDTMRDO2.DG Attach...
Detach

Dizplay
Snap
v Locate

MName Update Levels |Jsed

Select Al
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Exercise 6.3 Variable Medians, SR61 Templates

The FDOTSSA4.itl file contains some PPM Exhibit Templates which are delivered with variable medians included.
The median can vary with the following conditions or component sets:

o  Curb Median with or without Left Turns
o Crossovers at Intersections
o Traffic Separators with Left Turns

To properly operate the median condition templates consider the following:

e The various median component sets have a parent end condition search lines that targets plan features; e.g.
CurbType E, Traffic Separator.

e Each of the median components sets are displayed ONLY if the target is found. This is by the Parent/Child
relationship of the Template components.

e The LT and RT PGL Handles control the overall width of the median and can be modified to fit any project.

e Many of the median components have Horizontal Feature Constraints (HFC) defined to locate the 2D civil
features and the horizontal range will need to be modified to fit the project.

» Add Parametric Constraint for Variable Median, SR61 Template

The templates used have variable median conditions built within that needs to be set in place for the corridor.

1. Use the Corridor Modeling, Create
Parametric Constraint tool. ffl corridor Modeling = A

A e VN A
i delt o HJEIN 7 @ 6
E @— % _% ]:% 1 Create F'aramet;u::JCcnrtramt l

R o & i'—”i“’(l‘-ll?l Q

T ©) o i - 06 d 15 4

2. ldentify the Corridor Boundary handle. Continue to define the Create Parametric Constraint dialog

information.
3. Enter and accept the following for the SR61 Corridor: [ ¢ Create Parametric Clacala=alie i |
e ——
o Start Station Alt for Begin —
o Stop Station Alt for End Lock To Start
o Constraint Label V_Offset Start
o Start Value 0.0
o Stop Value 0.0 Lock Te End

Stop ] /
Constraint Label V_OFFSET El
Start Value 0.000000
Stop Value 0. 000000

A

4. The variable median conditions are placed at the correct location vertically. This will ensure the median
is at the correct elevation for the next exercise.
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Exercise 6.4 Add Corridor References, SR61

Corridor References are related to the template points having a Horizontal Feature Constraint to control the
location of the point on the corridor. They are 2D graphical Civil Features that need to be added to a corridor.
For the SR61 corridor the Civil Feature references added are on the following levels:

O O O O O

CurbFace
PavtAsphalt
SidwalkBack,
SidewalkFront
TrafSeparator

1. Use MicroStation Edit > Select by Attributes to create a Selection Set of each Level, one at a time.

h Select By Attributes

Tools  Settings
Levels T
Name R Cm""‘) —
U BTE -
CECJ.Ierace B-spline Suface
T FEwLine_pm @ Cell -
Cut_pm Complex Shape
Fil_pm Complex Chain
GradeLline_pr Cone o
N | MedianCrown_pm Curve
Miscelaneous

Dimension

PavtAsph_ep
4 1 3 o
Symbology Mode
[0 Color:  [IE 4 v Inclusive -
[ Style: OB~ |
] Weight: | OB~ |

P Execute s [ Properties ] [ Tags ]

2. Use the Corridor Modeling, Add Corridor References tool.

fﬂ Corridor Modeling BHEEA
afffe | i SAE

s |4 o B2 T @
TRy g

A 8w B El e

| © e € T 1 Vg

A ﬂ +o Q@ [ Add Corridor Reference ]

3. Identify the Corridor handle and then data point to add the selected lines as listed above to the corridor.

4. Once the Reference Lines have been added, the Corridor will automatically process to include the new
Horizontal Feature Constraints.

6-12
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5. Repeat these steps until each Level has been added.

Hint  When adding the TrafSeparator level, subtract out the Nose Radius Element from the Selection Set.
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Exercise 6.5 Add Corridor Point Controls, SR61
This exercise defines the LT and RT PGL to be a fixed distance from the centerline, 11 feet.

Hint  On projects where the PGL lines vary from parallel to the centerline, use the linear option and select the
feature lines that represent the varying PGL's.

1. Use the Corridor Modeling, Create Point Control tool.

ff corridor Modeling iE=E A
fﬂ+ WA =

Sl f o7 H- RN O @
@. /?Eﬂ Cﬁfeglnicnﬁzl E‘,' %,

K G RE

2. ldentify the Corridor Boundary handle. Continue to define the Create Point Control dialog
information.

Lock To Start

Start

Lock To End

Stop

Control Description

Paint RT_PGL_HANDLE=]
Mode Horizontal El

Control Type Linear Geometry El
Plan Element El
lse as Secondary Alignment [

Priarity 1

Horizontal Offsets

11.000000
11.000000

3. Enter and accept the following for the SR61 Corridor:

o Start Station Alt for Begin
o End Station Alt for End
o Control Description RT_PGL
o Point RT PGL _HANDLE
o Mode Horizontal
o Control Type Linear Geometry
o Start Value 11.00
o EndValue 11.00
Note At the prompt to select an element, choose the SR61 centerline
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4. Repeat the previous steps to add the Point Control for the LT_PGL.

Lock To Start

Start

Lock Te End

Stop

Control Description

Point LT_PGL_HAMDLE
Mode Horizontal

Control Type Linear Geometry

Flan Element
lse as Secondary Alignment [

Pricrity 1

Horizontal Offsets

-11.000000
-11.000000

5. Enter and accept the following for the SR61 Corridor:

o Start Station Alt for Begin
o End Station Alt for End
o Control Description LT_PGL
o Point LT _PGL_HANDLE
o Mode Horizontal
o Control Type Linear Geometry
o Start Value -11.00
o EndValue -11.00
Note At the prompt to select an element, choose the SR61 centerline
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Exercise 6.6  Add Corridor Key Stations, SR61

Create Key Station tool is useful to add stations that are not coincident with the template interval. When the
median conditions change abruptly, it is desirable to include the station for processing.

1. Use the Corridor Modeling, Create Key Station tool.

ff corridor Modeling = A
ITErY
el I O 02

E @ /;E E‘ Create KEﬂ Eta‘ticn F; %7
A © & & RS

T © s | - € € T Yy

2. ldentify the Corridor Boundary handle.

3. Use AccuSnap to locate the Plan View CurbMedian / Traffic Separator division line.

snap to a point
on this line
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4. Repeat these steps for both Traffic Separator locations in the Plan View.
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Exercise 6.7 Change Corridor Design Stage, SR61

The FDOTSS4 Workspace defines Corridor Stages to help with various tasks for Design and 3D Modeling.
Depending on the Active Stage, processing the Corridor will take longer.

1. Open the Project Explorer dialog, select the F11 Function Key.
2. Select the Civil Standards tab and expand the Libraries option list.
3. Locate the Corridor Design Stages under Project Settings > FDOT_CivilFeatures_RD.

4 Project Explorer =

% Links Fle | [ Survey | < Civil Model | “¥ Eivil Standard

—---‘g Civil Standards
+- DSGNRDO1.DGN, Default

T~

4. Select the Boundary of the Corridor and locate the Properties icon when the menu displays.
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5. Select the Properties icon and change the Design Stage from 1 PRELIM to 2 DESIGN.

Name SRE1
Haorizontal Name SRE1

Use Active Profile True
Frofile Mame SRe1-PR1

2 DESIGN

6. The Corridor will re-process and the 3D Model will re-draw with a tighter interval.
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Exercise 6.8 Review Corridor Objects, SR61

The Corridor Objects dialog is a summary of all Corridor Modeling objects and provides an excellent method
of managing data.

1. Use the Corridor Modeling, Corridor Objects tool.

H Corridor Modeling 1 EE ~

A il SRE
W[4 o H- 12 02 [
]9 1 %% Yy & dCoridor Objects
A o X,/ ik q
T © s it - 0 T 15 Yq

2. Identify the Corridor Boundary handle to open the Corridor Objects dialog.

p : _ _
B Corridor Objects - SR61 ‘ [E=EE= )

N X %R * 8 4 | Key Station ~
Station ==
71243762 R1

Template Drop
Station

fary Ali

Key Station

Parametric Constraint
Point Control
Curve Widening

End Condition Exception review the
added corridor

External Reference

objects

Clipping Reference

Row: [4 4 |1 of2 [ b M |

» Additional Template Edits, SR61

1. Change the sidewalk buffer from 3 feet to 0 feet on both roadways.

2. Either change the sidewalk width to 6 feet or add the sidewalk back lines to the Corridor as References
for the template HFC.

3. Add End Conditions 2:1 Cut & Fill components to each side with Mirror and Affixes checked ON.
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Exercise 6.9 Create RRR Corridor Model, BL98

1. Continue in the DSGNRDO1.dgn file.
2. Optional: Use the General Geometry, Set Active Terrain Model tool.

i1 General Geometry H

4D %, % @ 8 P O
w & 71
E 53t 3 off
R ;'.-’?IE‘ .|

| Set Active Terrain Model |-

v

£ Horizon

Note This tool can also be found on the Terrain Model Workflow Task.

3. At the cursor prompt, click on the Terrain boundary line from the attached GDTMRDO02 Reference
file. If the Terrain Model is Active, a message will display, Terrain Model Already Active.

Lecate Terrain Model to set as Active

Terrain Model Already Active

4. Move the cursor over the BL98 centerline Feature and verify an Active Profile.

Complex Element: BL98

Feature: Baseline(BL)
Active Profile Exists
Level: BaselineSurvey
DDB FEATURE
Attribute = BL
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5. Toset up the Views for viewing the 2D Plan and 3D Model simultaneously in the FDOTSS4 Workspace,
select the F2 Function Key on the keyboard. This will open an Isometric View of the project.

HinT  Use the Shift Key and Middle Button to rotate the 3D view.

{) LIEMEnt selection L=

=N R View 2, Default-3D o |[@ (=

View 1, Default

@-a%- Al Booo
BEle=a9

B-HE-[ARINHOOVEE|HTEE

6. Use the Corridor Modeling, Create Corridor tool.

=
Il
n
>

ffl corridor Modeling

diffl VM SAE

wl| § Create Corridor | |i| }\ @ ﬁ
e Bl wwY @
rull

L B 5 —
RS 7 & b o [ IK e d

R " w

T ) o it - - 4 12 o

7. Enter the Corridor Name, RRR98, in the Create Corridor dialog and then select the BL98 centerline
in the Plan View.

8. Reset to accept the Active Profile. This profile resides with the BL98 Civil Feature Centerline.
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9. Data point to accept the Name of the Corridor, BL98. The corridor is created AND the integrated Create
Template Drop dialog launches.

") Create Corridor SR

Locate Profile Element

Corridor Name BLS8

Design Stage 1PRELIM

Note Once a Corridor is created, a shape boundary is placed in the Plan View representing its outline.
This shape is initially placed on the CorrHndIStg1_dp level. It has several properties which can be
seen by clicking on the shape and choosing first icon. One of the properties is the Design Stage.
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Exercise 6.10 Create Template Drop, RRR98

1. Once the Create Template Drop dialog displays, first select the corridor template to be placed on the
corridor. Either use the icon on the dialog <OR> Select AL T down arrow to pick a template.

Lock To Start

Start 18+15.67 R1

Lock To End

End 46+11.26 R1

Drop Interval 10.000000

Minimum Transition Before Drop  0.000000

Mimmum Transition After Drop  0.000000

Template Comidor Templates'.S

=- Che'projects 22045555201 roadway 22045555201 it
+- Components
= Comidor Templates
¢ i-blank

rl- Ditches

rl- End Conditions

- Linear Templates
i) Surface Templates
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3. Data point to accept the Template and move to the next setting. Continue to define the Create Template
Drop dialog information entering and accepting the following for the SR61 Corridor:

o Start Station 28+00

o End Station Alt for the end station
o Drop Interval 10.0

o Min. Tran. Before 0.0

o Min. Tran. After 0.0

Lock To Start

| Start 28+00.00 R1
Lock To End i
End 46+11.26 R1
Drop Interval 10.000000
Minimum Transition Before Drop  0.000000
Minimum Transition After Drop  0.000000

Template Comidor Templates "RRA38

Interval

Drop Interval | [OININE | &
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4. Upon completion of the Corridor processing bar in the lower right hand side of the MicroStation status
bar, the 3D Model will be displayed in View 2.

Note Once a Template Drop is created a shape boundary is placed in the Plan View represent its outline.
This shape is initially placed on the TmpDrpHndIStg1_dp level. It has several properties which can
be seen by clicking on the shape and choosing firsticon. One of the properties is the Design Stage.
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Exercise 6.11 Add Corridor References, RRR98

Corridor References are related to the template points having a Horizontal Feature Constraint to control the
location of the point on the corridor. They are 2D graphical Civil Features that need to be added to a Corridor.
For the RRR98 Corridor add the following Civil Feature References:

e PavementMilling(ML)
e  Widening PavementAsphalt(EOPA)
1. Select the lines as listed above to add to the Corridor.

HINT  Use the Selector Tools with in MicroStation to assist.

2. Use the Corridor Modeling, Add Corridor Reference tool.

Tl corridor Modeling H- P
s ] 41 A

idult LHEN L O
E@”%%%%@

K i \||*>—<-|_~»_<:

P A

T @i“—&?—“@lifﬂ- ffﬁ 0 100 Ygg

Yy X (3] Add Corridor Reference |

R S =

S

3. At the prompt, select the corridor handle or boundary, data point to accept the selected elements as

corridor references.

"F"_'_
Data Point to Apply References to 26 selected
elements.
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4. Once the Reference lines have been added, the Corridor will automatically process to include the new
Horizontal Feature Constraints.
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Chapter 6

Exercise 6.12 Template Point Control, RRR98

The template used has milling slope break points built within meant to follow normal slope breaks in the existing
pavement. These lines add Point Controls for the Corridor.

1. With View 1 active, turn Off all Levels in the TOPORD file and turn On the Pavemk_ep Level.

ol Oy Wewbeey )
\Eﬂ" P AlLeve [Levels ¥] [&4 ~

W

=8 DSGNRDO1.DGN. Defautt
Wy Acrials.dgn

ALGNRD_50

w8 Ref, DSGNRDO1.DGN, Defautt-3D
vl GDTMRDO2 DGN

Name

Used ~

DummyChains_ep
Fence_ep
HoodLight_ep
Gates_ep
GroundShot_ep
Handrail_ep
Hole_ep
Mailbox_ep
MiscEquip

PavtConc_ep
PavtCrown_ep
PavtMisc_ep
RipRap_ep

ChldeD—aernd e

2. Use References, Merge Into Master tool to copy the Pavemk_ep lines into the DSGNRD file.

lools  bettings

BH-Bxo ¢2¢ @200 0 DI @ % wevee

Hierarchy

=l DSGNRDO1.DGN, Defautt

FDOT Roadway Design and 3D Modeling

[+] ¥ 4 FileName Model Desc
Aerials.dan Default Masts
RWODTRNM NGN Default Masts
+ TOPOR  Attach.. Default Masts
v ALGNRI  Detach AGNRD_50  Glob
DSGMR| Eel 4 Default-30
vy GDTMR &°® Defaut Mast:
Exchange
Qpen in New Session
Activate
Deactivate
Move
Copy
Scale
Blotate
Scale [ 1.000000 | Merge Into Master Botation | 00
EISM@ER "=t [ 0. Neted s

©2016 FDOT
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3. Create a Selection Set of the middle Pavemk_ep lines.

4. Use Horizontal Geometry, Set Feature Definition tool.

==
1l
n
>

£ Horizontal Geometry

a1 ' gl

Set Feature Definition |

w*‘;*

E S T |—
RO /76 20

T2 ™

.3

5. Select the PavementCrown Feature Definition and pvtcrown Name.

6. Data point to accept the Feature Definition to selected elements.

) Set eature Defind aln=a s

Feature -~

Feature Type Linear El
Feature Definition  PavementCrown El

Mame putcrown|

7. Use the Corridor Modeling, Create Point Control tool.

==
]|
]
>

ffl corridor Modeling

At 3 o=
il H- 12 7 @ 2
857 HCembomconial 3 gy

RS 7 W 3k o 17 |">?'|3<§/

R

T © s - - 46 @l 1 Y4
Y BN
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8. Identify the Corridor Boundary handle. Continue to define the Create Point Control dialog
information entering and accepting the following for the RRR98 Corridor:

o Start Station 28+00
o End Station Alt for End
o Control Description GradeBreak
o Point RT_ML_Break
o Mode Horizontal
o Control Type Feature Definition
o Feature Definition Pavement Crown
o Range 10
o Priority 1
o Horizontal Offset Start 0.0
o Horizontal Offset Stop 0.0
@ Create Point Control |. = £2 .|
Lock To Start [l
Start 28+00.00 R1
Lock To End
Stop 46+11.26 R1
Control Description GradeBreak
Point RT_ML_BREAK [=]
Mode Horizontal El
Control Type Feature Definition El
Feature Definition PavemertCrown El
Range 10.000000
Use as Secondary Alignment [
Priarity 1
Horizontal Offsets L3
Start 0.000000
Stop 0.000000
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» To validate the model verses the plan, Complete the Following

1. Open Project Explorer, Civil Standards, DSGNRDO1.DGN, Feature Definitions, Corridor Lines(3D)
2. Select the PavementAsphalt_pm and then right click to select the properties

3. In the Properties dialog, change the Linear Default Setting, Create Template Geometry setting to True

Linear Default Settings L

Automatically Create 30 Elements True
Corridor Template

Terrain Model Feature Type Break Line
True (=
Plan Falze

4. Re-process the Corridors

ffl corridor Modeling
3l V) 5
S [f o HR 2
&

E & Process Comdor |7 §

5. Verify that the construction lines in magenta, line up with the plan lines.

6. Repeat the steps for the Milling_pm lines
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7 OPEN CROSS SECTION VIEW

INTRODUCTION

This section will cover the Cross Section View tool. This is a single Cross Section View tool and is not for
producing final plan cross sections to print or other production needs. Refer to the FDOT Plan Development
Workflows training manual.

The Cross Section View tool creates a single section plane through any displayed elements in the “default- 3D
model” of the DGN file, thus having the ability to see a true slice or cross section through the model. The graphics
can be created from a Roadway Corridor, Drainage Network, Bridge Structure, or any other 3D solid element in
the design file or reference file.

The cross section view created is dynamic and will change as the model elements in the design file or reference
file changes.

This Cross Section View tool will also display a location line in the plan view, profile view and 3D model view.
This line is also tied to an element or alignment for specific location identification and navigation. The Cross
Section View tool is essential to evaluate the design and to make design decisions.

EXERCISE OVERVIEW

7.1 Opening a Cross Section View

7.2 SR61 Corridor Cross Section View

7.3 BL98 Alignment Cross Section View

7.4  SR61/BL98 Turn Lane Cross Section View

7.5  Create a Drive-Through Animation

Exercise 7.1  Opening a Cross Section View

This exercise teaches the user to open a View and set it to a Cross Section Model View.
» Corridor Modeling Tool Used

1. (Optional) Extract the 22049555201(7).zip file in the c:\e\projects folder.

2. Open the DSGNRDO1.dgn file of the c:\e\projects\22049555201\roadway\ folder in the FDOTSS4
Workspace in MicroStation.

Hint  Check on the Reference file display for the TOPORD, and GDTMRD files
3. Select the Function Key F2 to open View 2 the 3D Model. Click on the View 2 window to make it active.

FDOT Roadway Design and 3D Modeling ©2016 FDOT 7-1



Chapter 7 OPEN CROSS SECTION VIEW - Opening a Cross Section View

4. Use Reference Display to attach the GKLNRD Default-3D file. This is the file with the Existing Feature
model elements.

Tools  Settings
[ = . ) e n o oR(y ¥ ¥, T i .. =
BB o g6 A5 30 83 D %@ % e
Hierarchy | ] ¥ |4 FileName Madel Diescription Presentation .5 & :ﬁ
& [DSGNRDO1.0GN, Defaut-30 v GRKLNRDOT.DGN Default-3D | Global Origin aligne... Wirsframe

“ RWDTRDO1.DGN Defautt-3D Master model Wireframe N

s GDTMRDO2.DGN Default Master Model Wireframe +

-

»
Reference Attachment Settings for GKLMRDOL.DGN

File Name: GKLNRDO1.0GN
Ful C:\e'projects\ 22043555201 \roadway\GKLNRDO1 DGN
Default-30 -]

Logical Name: | Ref
Description: | Global Origin aligned with Master File

Orientation:
View Description
Coincidert Aligned with Master File
Coincident - World Global Origin aligned with Master File
Standard Views

5. Click in View 2 to make it Active. Use Level Display to toggle Off the DTM Level in the GKLNRD

Reference file.
| Level Display = View
RRREHON W= & 2

‘E_’; L):I.»C\.IILe\nEv @

=8 DSGNRDO1.DGN, Default-3D
v GDTMRDAZDGH
KLNRDO1.DGN, Defautt-3[]

View Z,_DefauIl—B )

MName Used ™

ep

zcellaneous(

6. Select the Function Key F4 to open Views 1-4.

7. Use the MicroStation Select tool to select the SR61 centerline. Click the Open Profile Model icon on
the Context Menu and select View 3 to place the Profile View of SR61.
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Exercise 7.2 SR61 Corridor Cross Section View

1. Use Corridor Modeling, Open CrossSection View tool.

ffl corridor Modeling =R A
affie \f b SAE
s |4 o B BN O @

T mhRthEwY @

e ey W IR e
R O

i Open CrossSecti View
T 0 r’EIT ro e ICI'ICH:IE ,E I- lﬂﬂ

Firee)

2. Select the Corridor: SR61 by the handle or near the boundary and click in View 4 to display the Corridor
Cross Section.

Locate Corrider or Alignment

Corridar: SRE1

Plan: SRE1

Profile; SRE1-PR1
Lewvel: CorrHndl5tg2_dp

B View 4, Cross Section - Corridor: SR61 Plan: SR61 Profile: SRE1-PRL = R

| View Properties ||| |4 = || 700+50.00 R1 [=]| »
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Note When used on a Corridor, the Cross Section View tool will determine the following from the corridor
properties:
o Left Offset
o Right Offset
o Interval
o Start Station

3. For the SR61 Cross Section View 4:
a. Notice many of the MicroStation Zoom, Pan, etc. commands will operate as normal.

b. Use the Cross Section View Navigation tools to examine the Corridor Model.

rid
< || ) 700:71.00R1 =] » »

c. Select View Properties and change the Vertical Exaggeration to 10 and then click the View to
see the changes.

efu;ﬂukon SRE1 Plan: SRE1 Profile: SHJ!E};P
.1

B Viewd, Cross Section - Corridor: SRE;

| View Propetes ) |4 < !

@) Fit Section
Center Backbaone
Center on Cument Cffsets
Backbone Screen Width: | 0.80
Vertical Exagageration: 10
Display Mull Poirts
Display Cut and Fill Graphics
Display Cut and Fill Values

d. Select the Station pull down menu and change to Station 715+00.

B View 4, Cross Section - Corrider: SR61 Plan: SR61 Profile: SREL-PRL =[]

| view Properties | »| |« <« || 715+00.00 R1 = > »

15+00.00 R1
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4. Use Corridor Modeling, Locate Station Via Datapoint tool;

Tl corridor Modeling =R A
Al V] A A
VIPNRNER T

T EwY @

RN 27 W ke 157 Il el

R

||

=
m
=

T Z:IO:: & i - H’g ﬂ’§ Iz q Locate Station Via Da{ar;cint.

Y RO

e

Chapter 7

5. Select the Corridor boundary to see a dynamic locater line perpendicular to the Centerline. Data point

at any station along the alignment, and click in View 4 to see its Cross Section.

B View]l, Default
Brad- AQRQREHO O BIL| LD &

Station

o]l sl

dynamic
locator line

HinT  Another way to access the tool is to hold down a Right Click in the Cross View to select the Locate Station

via Data Point
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Exercise 7.3  BL98 Alignment Cross Section View

1. Use Corridor Modeling, Open Cross Section View tool.

+
I
]
>

Tf corridor Modeling

3 e Y ) A
k|t SHEN D @
Ty WY g

S i gl T R B o Bl oy e
R % Ry \‘%"wlv"m \'T,.— L @

A

T -I:‘;.Oper: CI'CEESEEtiEﬂ‘-'-\-:Pi’E'r‘.-&& I- lﬁﬂ
ML Qr—

Free )

2. Select the Alignment BL98 and enter the following:

Left Offset -75
Right Offset 75
Start Station 28+00
Interval 20

o O O O

=
v e 0] A

| Left Offzet  -75.000000
¥| Right Offzet 75.000000
]t Sdstien 28+00.00 R1

I
B tervai| 20000000 hgr!  20.000000

Complex Element: BLS2
Feature: Baseline(BL)
Active Profile Basts
Level: BaselineSurvey
DDE FEATURE
Attribute = B

e
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3. Leftclick in View 4 to display the Corridor Cross Section.

B View 4, Cross Section - Complex Element: BL98 E\@
[V Popenes ]« <[ ziowonr | > ~

=AY

r'lP‘ r'[-l rl:;' r'?—' .._Ej .\r" :L._.l' r

Hint  Hold down a right click to Turn Off the Baseline cell level.
4. Evaluate the RRR98 Model using the Cross Section tool.

Note The Cross Section View tool works with Corridors, Civil Geometry, MicroStation Line or Line String
Elements.

Exercise 7.4 SR61/BL98 Turn Lane Cross Section View

1. Use Corridor Modeling, Open CrossSection View tool.

H
i
n
>

Tf corridor Modeling

2 e ) M SR
il |4 o B3N B @
T EEEEEYY @

RN K ;é.rf 5 Pl =

. T S

T -I@.Oper: CI'CEESEEtiEHT\;i'E'.-‘-.-&ﬁ I- lﬁﬂ
ML Qr—

Free )
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7-8

OPEN CROSS SECTION VIEW - SR61/BL98 Turn Lane Cross Section View
2. Select the PavementAsphalt(EOPA) line on the SW turning lane at the SR61 Intersection with BL98
and enter the following:
o Left Offset 20
o Right Offset 20
o Start Station 0+00
o Interval 10
B VYiew 1, Default = = || B3
B AQQRBHO DL HFELE
Complex Element: ECPLAZ2
Feature: Pavementisphalt(EOPA)
Mo Active Profile
Referenced By Corndor: RRR58
Level, Pavtfsphalt
3. Leftclick in View 4 to display the Corridor Cross Section.

B View 4, Cross Section - Complex Element: EOPA22 E\@
< < oo | > >

38

4. Evaluate the Model along the Curve Radii using the Cross Section tool.

Note Since the intersection model is not yet built, there is no widening or shoulder drawing in the cross
section around the radius.
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OPEN CROSS SECTION VIEW - Create a 3D Drive-Through Animation Chapter 7

Exercise 7.5 Create a 3D Drive-Through Animation

Creating a drive through along the project requires a 3D view and a 3D path to follow. This exercise explains
how to use the new Drive Through tool in SS4 along the proposed SR61 3D Model.

» To Setup the Animation Drive Through

1. Maximize View 2 Default-3D model to set it as the Active View.
2. Turn OFF the ConstLines and XSMisc_px levels.
3. Use Analysis & Reporting, 3D Drive Through tool.

Tasks v |
[ Civil Toaols |'

j ri‘rJ :I?rJ'ri_l‘Jj(ﬂ*rd'r/_

= analysis & Reporting = A

31'- |_r-/,ff
s hapassy ¥ ¥ 4 F

| 3D Drive Through |

ﬂ_ﬁ. General Geometry
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Chapter 7

OPEN CROSS SECTION VIEW - Create a 3D Drive-Through Animation

4. At the prompt, Select a 3D view, left click inside View 2.
a.

C.

At the prompt, Select the center line of the road, pick the 3D line in the view shown below.

[Select center line of the road |

Current Active 30 Linear Element: SRE1
By Profile Name : SR61_Pr e
Level: ConstLines_pm
/
b. On the 3D Drive Through dialog, change to the tab Camera/Target Controls and enter the
values as shown below.
H 3D Drive Through - SR61.5R61 [ = éj
| General Controls I Advanced Controls KCarnercu’Target CDI'ftI'CdSS
Camera Cortrol Target -
Wertical Offset Height
12.00 = feet ; fest
Horizontal Offset Distance
D.00 2 feet 100.00 2 fest

Change the tab back to the General Controls and Select the play button.

h 3D Drive Through - SR61.5R61 =t =

General Controls | Advanced Controls I Camera/Target Controls |
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8 SUPERELEVATION

OVERVIEW

Superelevation rotates the pavement cross slopes through a curve so that vehicles can maintain stability and speed
while on a turning roadway. Elevation banking is applied to help offset centrifugal force. Superelevation
standards also define the transition length required to rotate from a normal crown to a fully banked curve and
back again.

Superelevation can be calculated in two ways:

e Rules-based — using a set of preferences (SEP or SRL files) the station and associated cross slopes of the
transitions are based on design speed, curvature, and other design parameters. As the design progresses and
parameters change (i.e., design speed exceptions) superelevation can be reprocessed to the revised
parameter(s).

e Import — using a comma separate values (CSV) file to import the station and associated cross slope of each
transition. In this option, the rules are not utilized; the data is simply applied to the superelevation lanes.

The result of superelevation is a DGN file of graphic superelevation lanes with cross slope attributes. This file
can be referenced to a corridor model and associated, so the superelevation transitions are incorporated into the
corridor model. The superelevation data can be in its own DGN file, or can be drawn into any of the other project
DGN files with geometry, corridor, etc.

EXERCISE DESCRIPTION

In this workshop, the SR61 Centerline has a single curve to define superelevation. Once the required
superelevation is determined from a predefined FDOT rule file, it will be assign to the SR61 corridor the results
will be reviewed in the Cross Section View. Also, the results will be reviewed in the table editor and generate
reports will be generated as other methods to review data.

As an alternative to calculating supers with rules, we’ll also import a dataset from a FDOT Curve Table (csv file
generated from Excel).

The general workflow for superelevation is listed below.
o Create RDXSRD File to draw superelevation lane shapes
e Reference the ALGNRD File
e Create Superelevation Sections
e Create Superelevation Lanes
e Calculate Superelevation Based on FDOT Tables
e Project Explorer Edits, Graphical Edits
e  Assign Superelevation to Corridor, Associate Points
e Special Template Point, Superelevation Flag Box
e Template Inside Lane Vector Offset Constraint

e  Superelevation Diagram and Reports

FDOT Roadway Design and 3D Modeling ©2016 FDOT 8-1



Chapter 8

SUPERELEVATION - Create Superelevation Model

EXERCISE OVERVIEW

8.1  Create Superelevation Model

8.2  Create Superelevation Sections
8.3  Create Superelevation Lanes

8.4  Calculate Superelevation

8.5  Graphical Edits

8.6  Project Explorer Edits

8.7  Assign Superelevation to Corridor

8.8  Superelevation Reports and Diagram Editing

Exercise 8.1  Create Superelevation Model

1.
2.

3.

(Optional) Extract the 22049555201(8).zip file in the c:\e\projects folder.

Open the DSGNRDO1.dgn file of the c:\e\projects\22049555201\roadway\ folder in the FDOTSS4
Workspace in MicroStation.

From the FDOTSS4 Menu, select Actions > Create/Edit File.

E Standard | CellApps || Actions | Design Apps | Drainage Roadway | % ul |.:g DI

8-2

Create/Edit File

Set Geographic Coordinate System

Set Plot Scale of File

Sheet Mavigator

Sheets 4
Label Shapes with ID

Linked Data Manager

QOO OO0 OV O

Trnsport 2
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SUPERELEVATION - Create Superelevation Model

a.

Chapter 8

From the Create File/Project dialog, locate the ROADWAY CROSS SECTIONS from the

Roadway Design Files File Group and click Create.

[#) Create File/Project ==
Project: [C:\e\prniect$\22ﬂ495552ﬂ1 v] Project Settings
Workspace: [ FDOTSS54 - ]

Contral File: [ ROADWAY.CTL -

File Group: [Hnadwa_l,l Design Filzs [DGMN) "]

File Type:

PROFILE SHEETS -

PROJECT LAYOUT SHEETS

PROJECT MOTES

PROJECT PROFILE LAYOUT

PROPOSED DESIGM

PROPOSED DIGITAL TERRAIMN SURFACE MODELS
PROPOSED PROFILE

QUANTITY COMPUTATION DETAILS

QUANTITY COMPUTATION SHAPES/CALCULATIONS
RIGHT OF W&y DETAILS FOR ROADWAY
ROADWAY CROSS SECTIONS

SELECTIWE CLEARING &MD GRUBBING SHEET
SPECIAL DETAILS SHEET

STORM WATER POLLUTION PREVENTION PLAM
SUmMMARY OF DRAINAGE STRUCTURES
SUMMARY OF PAY ITEM SHEETS

sUMMARY OF QUANTITIES SHEETS

SUMMARY OF VERIFIED UTILITIES [2D)

m

SURVEY OF VERIFIED UTILITIES (201
S1RAWEY MFWERIFIFD LITITIES (30 WERSION NF HTEXRM MEK

Output File: RO=SRDO|

Output Folder;  Foadway
Seed File: fdotzeedss. dgn

Seed Path: resources seed/

Action: mdl | platscale;plotscale set Apply Action

[ Create ] [ Open File ]
Active File for Open/Edit; RD=SRDO0T1.DGN

Scale: 1.0000

Units; [English = |

[] Process File List

File List:

| OK | | Cancel |

Click OK on the Set/Update Plot Scale dialog. Click OK on the CreateFile/Project dialog.

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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Chapter 8 SUPERELEVATION - Create Superelevation Model

4. Locate the View Group toggle on the bottom left of the MicroStation window and change the View
Group/Model to Xsshrd Views.

Mame Maodel
't Pattrd Views Pattrd
'L Rxsrd Views Rdxsrd
: Views Rdxsrd_shg
¥ashrd

-]/ & [1[2[3[e[s[s[7]s

[ Civil Message Center li!"
5
Q-O-M°-

5. On the MicroStation References tool, attach the DSGNRDOL1 file.

It ¥sshrd Views

Tools Settings

Bl , 20 20 AN o R N

F:'E%@j x > ¢ ﬁa_‘:jjjﬁu:hﬁﬂd@

Hierarchy [=] ¥ 4 FleName

@DSGNHDUTDGN.SUDEFEIE?EIHGH o . DSGNEDO]DGN
Note The Superelevation tools utilize the active MicroStation symbology.

6. Window into the Proposed Roadway in the DSGNRDO1 Reference file.
7. Set the MicroStation active Level to ConstLines and select File > Save Settings (Ctrl +F).

Units=Unknown, AS= 1.0000, TX= 2.8000, L5= 1.000{

¥ )

L]
=
4
il

7 AlLev~ | [Default

Cone
Constfrea_dp

— .
( Constlines
_dp

Contourindex ep

L

m

AL L Y
o000 000

EEENCO
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SUPERELEVATION - Create Superelevation Sections Chapter 8

Exercise 8.2  Create Superelevation Sections

1. Use Corridor Modeling, Create Superelevation Sections tool.

-
]|
]
>

Tl corridor Modeling
Aok ] 4} SR
il |t o BN 2 @
‘it mw? @

R \I Create Superelevation Sections k‘| = @

b s S T

T © fu i 1 T €6 1 b

LML Q0T
2. Onthe Create Superelevation Sections dialog, enter as shown below:
o Name SR61
o Start Station Alt to lock to Begin
o End Station Alt to lock to End
o Minimum Tangent 0

Mame

Lock To Start

Start Station

Lock To End

End Station T26+42 21 R1

Minimum Tangent Length 0 .000000

Enter the minimum tangent length between
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Chapter 8 SUPERELEVATION - Create Superelevation Sections

3. The Superelevation Sections are drawn and the Create Superelevation Lanes dialog is launched.

Superelevation Section: SR61-1
Level: Default
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SUPERELEVATION - Create Superelevation Lanes Chapter 8

Exercise 8.3  Create Superelevation Lanes

1. Use the Corridor Modeling, Create Superelevation Lanes tool.

==
]|
]
>

Tl corridor Modeling
Afieh ] 4 SR
it o 2N [ @
- @7 [l e o ¥ &

. reate Superelevation Lanes ?%
P G Al
- o o an, oo A AT las

2. Define each of the Super Elevation Lanes as shown below, following the prompt to enter and data point
to accept data:

MName Left1
Type Primary El
Side Of Centerline  Left (=]
Inside Edge Offset  11.000000

‘nfidth 24.000000

Mormal Cross Slope -2.00%

Name Leftl Left2 Rightl Right2
Type Primary | Primary | Primary | Primary
Side Left Left Right Right
Inside Edge Offset 11 35 11 35
Width 24 16 24 16
Normal Cross Slope | -2.00% | -3.00% | -2.00% | -3.00%
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Chapter 8 SUPERELEVATION - Create Superelevation Lanes

3. The Superelevation Lanes are drawn and the Calculate Superelevation Lanes dialog is launched.
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SUPERELEVATION - Calculate Superelevation

Exercise 8.4  Calculate Superelevation

1. Use the Corridor Modeling, Calculate Superelevation tool.

affie ) 4 SRE
Wl |4 o H- 2N\ [ @

E@@ Y
R\J\’\% =

N

Yo 8 a2

]

Calculate Superelevation

T O s {ﬂilE :

AMLQO

Import Superelevation

Open 'Calculate Superelevation’ as Toolbox

2. On the Calculate Superelevation dialog:

Standards File Name C:\FDOTSS4_server\GEOPAK\s_tables\FDOT Urban_esep [

& Selection 5% e max
2484 Lane
Design Speed 30
Transition 1D

Mumber Of Lanes 1

L Selection

Facility Divided

Open Editor E

Chapter 8

3. Select the Browse button and navigate to select the FDOT_Urban_e.sep file from the
\FDOTSSA\GEOPAK\e_tables\ directory.

& Selection 5% e max

L Selection 2484 Lane
Design Speed 0 )
Transition 1D Linear |

Mumber Of Lanes 1
Facility Divided

Open Editor [l

-

7] H Select File - C:\FDOTSSAﬁ_serveF\GEOP.-’-‘«K‘\e_t‘g

Look in: , &_tables
I MNarme :
he 4 |FDOT_Rural_e.sep

Recent Places | F_DOT_Urban_e.sep

4. Enter the necessary dialog information as shown at the prompt and data point to accept data:

e Selection

L Selection
Design Speed
Transition ID
Number of Lanes
Facility

Open Editor

O O 0O 0 O O O

FDOT Roadway Design and 3D Modeling

~

5% e max
2&A4lane
50

Linear

4

Divided
Yes, check

©2016 FDOT
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Chapter 8

SUPERELEVATION - Calculate Superelevation

5.

. . Calculate Superelevation

Standards File Mame CA\FDOTSS54_server\GEOPAK e _tables'\FDOT_Uban_e sep -
e Selection 5% e max
L Selection

Design Speed

Transition ID

2&4 lane
R0

Mumber Of Lanes 4

[ ] [ B B ]

Divided
v

Facility
Open Editor

The Superelevation Lanes are now applied with Superelevation and the Superelevation Editor dialog

is launched.

B Superelevation Editor - SR61

il R A= R

SR61-1 QX

W O R EHO

Superelevation

Name Station Curve Set Cross Slope Transition Type Pivot Edge Non Linear Curv... Point Type Ignore Distance Constr...  Distanc

Rgu s sma ISR W e e emdGom  fwe e
ht1 - 704436 -2.0000%

Rigt 704+96.6927 R1 1 -2.0000" Linear Left Edge Mormal Crown In False Mone
Right 1 706+53.4427 R1 1 -5.0000% Linear Left Edge Full Super In False Mone =
R T12+40.4873 R1 1 -5.0000% Linear Left Edae Full Super Out False Mone
R 713+87.2373 R1 1 -2.0000% Linear Left Edge MNormal Crown Out | False Mone
R 726+41.0673 R1 -2.0000% Linear Left Edge Mormal Crown False Mone
Ri 698+53.7915 R1 -3.0000% Linear Left Edae Mormal Crown False Mone
R 705+48.9427 R1 1 -3.0000% Linear Left Edge MNormal Crown In False Mone
706+53.4427 R1 1 -5.0000% Linear Left Edge Full Super In False Mone
T12+41 7T12+40.4873 R1 1 -5.0000% Linear Left Edas Full Super Out False Mone
713+44.3873 R1 1 -3.0000% Linear Left Edae Mormal Crown Out | False Mone
Right2 Right2 - 726+42 726+41.0679 R1 -3.0000% Linear Left Edge Normal Crown False Mone i
Row: 1 of24 | b bl
6. Review the data and Close the Superelevation Editor dialog.
7. Open the Civil Message Center to review the Superelevation Notes.

8-10

Civil Message Center
Hide All |jl 50 MicroStation | |® 0 Errors | |_LED Warnings | |0I:I Messages

Elemert Message Description

I Superelevation Calculation Complete. I
Mo trangition conflicts were found.
Checking for transition corflicts . . .
Length of 417.5104 has been round...
Transition Length adjusted to 417.5...
Curve SRE1-1: Super rate of 5.000...

ERERRE
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SUPERELEVATION - Graphical Edits Chapter 8

Exercise 8.5 Graphical Edits
» Superelevation Sections

1. Use the MicroStation Element Selection tool and select the Superelevation Section. The graphic
handlers now display.

2. Change the Begin Station to 70000.

Superelevation
Section

Change the Begin
Station to 70000

» Superelevation Lanes

1. Using the MicroStation Element Selection tool, select the Left2 lane of the Superelevation Lanes. The
graphic handlers now display.

2. Change the Left2 Lane width to 4 feet, repeat for the Right2 Lane.

FDOT Roadway Design and 3D Modeling ©2016 FDOT 8-11



Chapter 8

SUPERELEVATION - Project Explorer Edits

Exercise 8.6  Project Explorer Edits

1. Open the Project Explorer, Select F11 and select the Civil Model tab. If this tab is not shown click on
the small arrow in the top right corner of the dialog.

-

% Project Explorer 1w —

| % Links [ M3 Fie | [ Survey || < Cwvil Model | 9 Civil Standards |
=] ; Dw‘l Data

-« RDXSRDO1.DGM, Xsshrd

- DSGMNRDO1.DGM, Default

A

2. Expand the RDXSRDO1.dgn data tree and navigate to Superelevation > SR61-1 > Superelevation
Objects > Left 1. Right click and select Properties.

-

-
& Project Explorer

|EEE Links I Flel 5] Surve:,.r| £ Civil Model |EE Civil Standards|

[ o G\nl Data
L__| «_ RD¥SRDO1.DGN, Rdxsrd_shg
" Linear Elements

¢ Poirt Bements
- 3D Linear Blements
% Temain Models
| J:f [_: Comidors
I =7 Superelevation
S SRE1-1
B- H:?' Superelevatlon Objects

T Insert Superelevation Station/Cross-slope

Remove Superelevation

g
-l Civil Cells Delete

' Civil Objeds Proper‘hﬁ
- Referenced ’\Lmu

Bl DSGNHD 1.0GN, Default
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SUPERELEVATION - Project Explorer Edits Chapter 8
3. Inthe Element Information dialog, review the Superelevation Lane Properties.
4. Change the Leftl Lane width to 28 feet, repeat this for the Rightl Lane Width.
- ™y | I
(i) Element Information Euﬂ (i) Element Information = 28
EI---“F.JD Selaction

(G Lo )

General ~ General LS
Description Superelevation: Left 1 Description Superelevation: Right 1
Level ConstLines Level Constlines

Colar E=] Bylevel (1) Calar E= Bylevel (1)

Line Style =1 ByLewvel (0) Line Style E= Bylevel (D)
Weight =1 ByLewvel (0) Weight E= Bylevel (D)

Class Primary Class Primary
Template None Template None
Transparency 0 Transparency 0

Pricrity 0 Priority 1]

Extended Y Extended S
Model X=zzhrd Model K=shrd

Last Modified 82772014 7-32 AM Last Modified 82772014 7-33 AM
Snappable Snappable Snappable Snappable

Meodified Modified Medified Modified

MNew MNew Mew New

Locked Unlocked Locked Unlocked

Display Style 1] From View Display Style 1] From View
Superelevation » Superelevation LS
Mame Left1 Mame Right 1

Side Of Centerline Left Side Of Centerline Right

Inside Edge Offset Inside Edge Offset

Wfidth 28.

Start Station FU.0000 R1 Start Station 0000 R1

End Station 726+41.0679 R1 End Station 726+41.0679 R1

Mormal Crozs Slope -2.0000% Mormal Cross Slope -2.0000%
Type Primary Type Primary

Note For this project template, there is no slope break or outside lane so Left2 and Right2 will be remove

from the Superelevation design.

FDOT Roadway Design and 3D Modeling
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Chapter 8

8-14

» Delete Lane Shapes for this project template

SUPERELEVATION - Project Explorer Edits

1. Inthe Project Explorer dialog, right click on the Left2 Lane and select Delete. Repeat for Right2 Lane.

p
4 Project Explorer

~

|EE‘S Links I F|Ie| B Sunreyl <. Civil Model |£E Civil Standards

- Civil Data
S+ RDXSRDO1.DGN, Rebxsrd
----- " Linear Elements
----- + Point Blements
--f= 30 Linear Elements
% Temain Models
‘_“_: Comidars
B Superelevation
B SRE1-1

E-# Superslevation Objects
i-fr Left]

(e

r Ri T Insert Superelevation Station/Cross-slope

iy Rl Rermove Superelevation
- Civil Cells

----- § CviObjects | %% Delete

(- Referenced M| @2 Properties

B DSGNRDD1.DGN, meveme

2. Close the Project Explorer dialog.

©2016 FDOT
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SUPERELEVATION - Assign Superelevation to Corridor Chapter 8

Exercise 8.7  Assign Superelevation to Corridor
1. Return to the Default Model of the DSGNRDOL1 file.

'ﬂa_mﬁ__ Model
(' Default Views ) Default
Coil c 3 Default-3D Views Defautt-30
[ il Message Lenter l It Superelevation Views Superelevation
-0~ _}_.@De{ammews j@ 1|2]3]|s]e]7]el i X
Hlement Selection > |dentify element to add to set B [Plat :

2. Attach the Superelevation Design from the RDXSRDO1-Xsshrd Model as a Reference file.

GDTMRDOZ.DGN Default Master Model Wireframe Chynamic

GKLNR DGN Master model Wirsframe
DXSRDD1.DG Xsshrd Cross Section Shapes Wireframe

Reference Attachment Settings for RDXSRDO1.DGN

[f] Referel
Tools  Settings
L EDE A0 D g B2 0 0 etk Bame o)
Hierarchy ] ¥ 3 File Name Mode! Description Presentation Visible Edges 4 & & |
DSGNRDO1.0GN, Defautt Aerials dgn Defautt Master modsl Wirsframe v
DSGNRDO1.DGN Default-3D Wireframe Dynamic s
RWODTRDO1.DGN Default Master model Wireframe ¥
ALGNRDO1.DGN ALGMNRD_50 Master model Wireframe A s
VW
¥ W
¥

LA A

File Name: RDXSRD01.DGN
Ful Fath:  C:\e'projects'22049555201\roadway\RDXSRD01 DGN
[Xsshrd -]

Logical Name: | CrossSections
Description: ' Cross Section Shapes

FDOT Roadway Design and 3D Modeling ©2016 FDOT 8-15



Chapter 8 SUPERELEVATION - Assign Superelevation to Corridor

» Check the Active Template for Superelevation Flags

1. Use Corridor Modeling, Create Template tool.
a. Setactive the SR61 Template.
b. Open each of the 4 Pavement Edge Points Properties, and check ON the Superelevation Flag

option.
BN mEnes
File Edit Add Tools
Template Library: Curent Templats Display [ o=
3 C\e'projects\2204955520 1\symp|  Name: SR61 ©) Componerts Constraints
“EE Pont Name Lt Description Display Foint Names lmiieh

(23 Componerts
3 Comidor Templates

B
SR61
litions

2] plates
(2] Surface Templates

Display All Components

PavementBreak_pm

¥TSuperslevation Flag

Atemate Suface:

Member of:
LT_PuOut

2. Use Corridor Modeling, Synchronize Template tool.

Tf corridor Modeling = A

ke U] 4 A

4 F SHN [ 94
T oW &

AN O & & I d
T (© [ e et 06 € 1 Yo

4 lY| Synchronize Template |

Aol

I

3. Select the SR61 Template Drop Handle, the Corridor will begin to Re-Process.

=
Ao [r—
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SUPERELEVATION - Assign Superelevation to Corridor, Chapter 8

4. Use Corridor Modeling, Assign Superelevation to Corridor tool.

ffl corridor Modeling HERA
Aok ) § DA

Wi | o H BN 2 @
7 i wlblm WY

IQ 7 & 3 Assign Superclevation to Corridor )
T © ofe e - 4 0 1 Ygg
Ao~

a. Select the Reference Superelevation Section boundary.
b. Select the Corridor Boundary for SR61.

¢. The Associate Superelevation dialog displays. Review the Pivot Point and Superelevation
Point assignment and then click OK.

P T A=
Superelevation Object Superelevation Point Pivot Pairt Start Station Stop Station Pricrity
» Left1 - |LT_PVT_EOP_OUT * |LT_PGL_IN ¥ | 638+53.79 R1 T26+4107 R1 1
Right1 > |RT_PVT_EOP_OUT ~ |RT_PGL_IN > | 698+53.79 R1 T26+41.07 R1 1

5. The Corridor will begin to process and display the new model.
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Chapter 8 SUPERELEVATION - Assign Superelevation to Corridor

6. Select the Function Key F4 to open 4 Views. Use the Open CrossSection tool to display and review the
Superelevation on the Corridor.

ffl corridor Modeling mE=EA

gk i RV
Rt ANIES .
Tt EwY &
S ¥ ¥ EEd
T iq Open CrossSection View E I lﬂﬁ

o AP Lo Q=

LEL

7. Follow the cursor prompts to display the cross section in View 4.

B View1, Default = |[@ ][ 58| | = view2 Defauit-30 o @)=
; @ ¢ E-RuE-ARIREHYO VO HT.2E

[ -

J_/Q
EEEE )

View 3, Profile - SR61 S (== B View 4, Cross Section - Corridor: SR61 Plan: SR61 Profile: SR61-PRL =N R

r; - AQQRIEEBE VEE|H - View Properties || |« = 712+00.00 R1 | > »

HinT  Use the Locate Station via Data point tool to navigate to the curve area of the alignment with
superelevation.

Tl corridor Modeling BRERA
a e i H S=
I RNEX T
TR EwY &
T U W BRI
1 0 # - Et- g& g& Im l@ Locate Station Via Datapoint
AL Qo
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SUPERELEVATION - Superelevation Reports and Diagram Editing

Exercise 8.8

Superelevation Reports and Diagram Editing

» Create a Superelevation Report

1. Use the Corridor Modeling, Superelevation Report tool.

ﬂ:ﬂ Corridor Modeling

o e ] 41 DA

lt o

g
R S’ e

TR EN @
T Ew¥ &

==
i
n
>

ol

H 7,.-f 1 kzl Superelevation Report

@ sfe - 0 0 1 Yy
O A

2. Select the SR61 Superelevation Section and right click to accept.

File Name:
Input Grid Factor:

Superelevation Data Report

Report Created: 9/28/2015
Time: 8:11am

Note: Allunits in this report are in feet unless specified otherwise.

Chapter 8

»

Section Name: SRE1-1

Base Horizontal
Name:

Standards Filename:

SR61

C:A\FDOTSS4_server\GEOPAK\e_tables\FDOT_Urban_e sep

m

Design Speed: 50

Pivot Method:

Transition Type: Linear

Number Of Lanes: 4

Facility: Divided

E Selection: 5% e max

L Selection: 2 &4 Lane

Superelevation: Left1
Station Cross Slope Point Type Transition Type
700+00.00 R1 -2.00% Normal Crown
703+09.13 R1 -2.00% Mormal Crown In Linear
T03+93.13 R1 0.00% Level Crown In Linear
T04+77.13 R1 2.00% Reverse Crown In Linear
T06+03.13 R1 5.00% Full Super In Linear
T12+39.77 R1 5.00% Full Super Out Linear
T13+65.77 R1 2.00% Reverse Crown Out Linear
714+49.77 R1 0.00% Level Crown Out Linear
FDOT Roadway Design and 3D Modeling ©2016 FDOT
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Chapter 8 SUPERELEVATION - Superelevation Reports and Diagram Editing

3. Inthe Civil Report browser, select File > Save As.

4. Change the path folder to C:\e\projects\22049555201\Roadway and the File Name to
SR61_Superelevation, use the Save as type HTML.

Save As 52 |
Save in:d || roadway ’ j = EF B~
= Mame Date mﬂdTified Type
-
Hec;:wﬁaces . projdbs 8/26/2014 1030 AM  File folder
. aerials 8/260/2014 10:30 AM  File folder
" . | eng_dats 5/12/2014 343 PM  File folder
Deskdop
IJElElriEE
A
Computer
Metwork <
File name:
Save as type:

5. Close the Civil Report browser.

6. Locate the html file in the Roadway directory and open it in the Internet Explorer or other browser.
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SUPERELEVATION - Superelevation Reports and Diagram Editing Chapter 8

» View and Edit the Superelevation Diagram
1. Change the design file back to the RDXSRDO01-Xsshrd Model
2. Use the Corridor Modeling, Superelevation Editor tool.

ffl corridor Modeling H S

@ e ] Y 5

Bl P

-MM;HJ\LUE
7
o4 %%EE &
e - Superelevation Editor

FE\‘--J"‘..J ﬁlr’l’l‘j/%‘? S |

T © s - - 6 A8 1 4

o AP Lo Qe =
3. Select the SR61 Superelevation Section and right click to accept.
» Set the Point Constraints on the Diagram
1. Use the Row Navigator to locate the Full Super In Point Type row.
2. Change the Distance Constraint Type column to Distance Offset.
3. Change the Slope Constraint Type column to Cross Slope.
4. Repeat these steps the Full Super Out Point Type row, close the Superelevation Editor.

B4 Superelevation Editor - SR61 = [t

L A= I

R X » QB Bk IEHO
Cross Slope Transtion Type  Pivot Edge Non Linear Curv...  Point Type lgnore Distance Constr..  Distance Transit.. Distance Transt... Offset Slope Constraint...  Superslevation
-2.0000% Linear Left Edge Normal Crown False None None
-2.0000% Linear Left Edge Nomal Crown In | False Nane Nane
-5.0000% Linear Left Edge Ful Super In False Nane Nane
-5.0000% Linear Left Edge Full Super Out False Nane Nane
-2.0000% Linear Left Edge Normal Crown Out | False Nane Nane
-2.0000% Linear Left Edge Normal Crown False Nane Nane
-2.0000% Linear Right Edge Nomal Crown False None None
-2.0000% Linear Right Edge Nomal Crown In | False None None
5 Linear Right Edge Full Super In False 0.000000
5 Linear Right Edge Full Super Out False 0.000000
-2.0000% Linear Right Edge Nomal Crown Out | False None None
-2.0000% Linear Right Edge Normal Crown False Nane Nane
3 m v
Row: 4 4 |9 o2 | b M|
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9 DETAIL MODELING

SR61 CORRIDOR DESIGN DETAILS EXERCISES

e Intersection Design

o Build Intersection Terrain at BL98
o Including TS Nose and Turn Island

OTHER DESIGN DETAILS

e Build Intersection Terrain at School Entrance

e Transition Template for the End of the Project

e Build Intersections for Friendship Road

e Add 3D Urban Driveway

e Add 3D Sidewalk Ramps

e Add 3D Rural Turn Out

e  Superelevation Vector Offsets for the Median Widening and Curb Gutter Points

e  Superelevation Vector Offsets for the Traffic Separator Widening
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Chapter 9 DETAIL MODELING - Superelevation Reports and Diagram Editing

INTERSECTION DESIGN

The intersection can be built in parts as shown in the diagram:

u
\

The following exercises provide instructions on how to model these with Civil Tools other than the Normal
Corridor Templates. The steps to design the SR61 intersection have been detailed in the Chapter, Exercises 9.1
through 9.12. Once completed follow the same methodology to add further design details 9.13 and 9.14.

EXERCISE OVERVIEW

9.1 Plan to Build Intersection Terrain at BL98

9.2  Adda Component Switch to the RRR98 Template

9.3  Constructing Vertical Profiles from 3D Model Elements

9.4  Construct 3D Radius Lines

9.5  Construct 3D Intersection Limit Lines

9.6  Build the Intersection Terrain from 3D Elements

9.7  Create an Intersection Pavement Surface

9.8  Traffic Separator Nose

9.9 SR61 Corridor Clipping References

9.10 Model Curb and Sidewalk around Radii

9.11 Right Turn Island

9.12 RRR98 Corridor-Build Intersection Terrain at School Entrance (On Your Own)
9.13 SR61 Corridor-Build Intersection Terrain at Friendly Road (On Your Own)
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DETAIL MODELING - Plan to Build Intersection Terrain at BL98 Chapter 9

Exercise 9.1

Plan to Build Intersection Terrain at BL98

The general methodology for building intersection design come from the concept of creating new 3D model
boundary lines from profiles on the corridor surfaces and 3D lines. Transition profiles are easily produced with
the civil tools for the radii.

These are the general steps to follow:

a.
b.

c
d.
e.

f.
g.
h

J-

Develop a seam line between corridors through the intersection,

Create a switch or trigger line on the crossing corridor templates,

Remove outside corridor component elements through the limits of the intersection,
Construct 2D elements around the perimeter of the intersection,

Develop/design the profiles for each of the perimeter line,

Build an intersection terrain boundary using the 3D perimeter elements,

Add break lines if necessary to the intersection terrain,

Add surface templates to the intersection terrain,

Use linear templates along the perimeter edge lines to help transition corridors,

Use corridor clipping tool to clean overlaps between corridor and linear templates.

1. (Optional) Extract the 22049555201(9).zip file in the c:\e\projects folder.
2. Open the DSGNRDO1 file and zoom into the Intersection of SR61 and BL98.
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Chapter 9 DETAIL MODELING - Plan to Build Intersection Terrain at BL98

» Turn OFF the Automatic Corridor processing of SR61.

1. Select the SR61 Corridor handle to display the Context Menu and select Lock - Deactivate Rule.

1

Lock - Deactivate Rule

» Turn the Radius Trim Lines back on for easy selection (optional)

2. Select the SW EOPA element, PavementAsphalt(EOPA).

a.  When the Context Menu displays, select the Properties icon.

Properties
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DETAIL MODELING - Plan to Build Intersection Terrain at BL98 Chapter 9

b. On the Element Information, change the Fillet Rule, Hew New

. Locked Unlocked
Tr|m/EXtend to None. Line Style Paramete

Display Style 1] From View

m

Note This will draw the parent PavementAsphalt(EOPA) lines

back into view. They can be trimmed again later. Back Transition _
Ahead Transition v
Ahead Taper 4
Fillet Rule -~
Radius 110.000000
Back Offset 0.000000
Ahead Offset 0. 0

None] ] [=]

Back Taper v -

3. Repeat these steps for NW EOPA element, PavementAsphalt(EOPA).
4. Select the Function Key F7 to toggle Off Construction Elements.

5. Select the Function Key F2 to open the Plan and Model Views together. Zoom into the Intersection in
both Views 1 and 2.

B View1, Default [f=e|[-=-|mEsa] | w View2, Defauit-2D o |[®@ ] =
Brpialh @0 RS eE %GR -~ |AQQREBOWEE g
— | N

J_/\J,
EEETE)
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Chapter 9 DETAIL MODELING - Add a Component Switch to the RRR98 Template

Exercise 9.2  Add a Component Switch to the RRR98 Template

This exercise adds a Component Switch to the RRR98 template to be used across the limits of the intersection.
This switch is implemented using a Parametric Constraint on the BL98 corridor to turn off all the outside

components for the corridor through the intersection.

1. Use Corridor Modeling, Create Template tool.

ffl corridorModeling ERE = A

2. Set Active the RRR98 template.

B " Create Template

File Edit Add Tools

[Z1 Components
3 Comider Templates

==

SRE Set Active
(23 End Cor|
23 Linear T Cut
23 Surface Copy
Paste
Delete
Rename

Template Library: Cumrent Template
{23 C\e'projects' 2204955520 1\roadw|  MName: RRRS38
== Point Name List Besaypion:

Template Decumentaticn Link...

Ctrl-X
Ctrl-C
Ctrl-V

Del

3. Using the Template Library Organizer, locate the SWITCHES template in the FDOTSSA4.itl file

[Z1 End Condtions
—_ R

9-6 ©2016 FDOT

i ' Template Library Organizer l E] eS|
Puailable In: Puailable In:
23 Ce'\projects" 22049555201 \roadway 22049555201 it 23 CAFDOTSS4 _server\GEOPAK comidor\FDO TS S4 it E]
EE Point Mame List 'EE Point Name List
{3 Components {5 Components
[Z1 Resurfacing (Miling, Overbuild and Oveday) [Z] Bamiers & Retaining Walls bl
g (Millng ay) g
== PPM EXHIBIT TYP-5 1 Berm

(27 Conidor Templates [Z7] Bridge Examples

(=3 End Condtions [Z Buffer

27 Linear Templates (= Curb & Gutter

[T Surface Templates [Z7 Ditches
[Z7] Driveways
(2] Guardrail
(= Handrail
2] Median Slopes
S5 NULL

PGL Divided

[Z] Pavemernt
(21 Shoulder
2 Sidewalk
23 Traffic Separators
[C7 Uity Strip
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DETAIL MODELING - Add a Component Switch to the RRR98 Template

Chapter 9

4. Drag the SWITCHES template to the project Components folder

3 Linear Templates

2= Qutside Lane w/ Type F Curb
=3 Surface Templates
= Pavement Asphalt

5. Choose OK and choose Yes to Save the data to the project template library, 22049555201.itl.

B | Template Library Organizer l E] &J
Available In: Available In: oK
- projects\ 22045555201 voadway 22045555201 il 3 CAFDOTSS4_server\GEOPAK comidor\ FDOTSS4 1 [ —m——
oirt Name List *ZZ Point Name List | Cancel |
3 Components i C‘Umpunerrls |T|
—3 Resurfacing (Miling. Overbuild and Overlay) [ Bamiers & Retaining Walls =
3 Miling ] Berm
] Cwverbuild [ Bridge Examples
(£ Overay [ Buffer
[C1 Widening 1 Curb & Gutter
= PPM EXHIBIT TYP-5 (] Ditches
= ] [ Driveways
=3 Comidor Templates (£ Guardrail
=< RRR%2 -3 Handrail
= SRE1 >={ Handrail
-3 End Conditions 3 Median Slopes
9 Pars >=={ Median Depressed & Flat Combination

= Outside Lane w/ Paved Shoulder

== Median Raised & Flat Combination
=9 NULL
== PGL Divided
#% SWITCHES
[ Pavement

6. With the RRR98 template active, drag the SWITCHES template onto the center of the RRR98 template.

1 Create Template ||
File Edit Add Tools
Template Library: Cument Template Display ‘Y‘
=1 C\e'\projects 2204955520 1'roadw|  Name: RRR38 @ Componerts Constraints —
‘= Pt Name List Description: /| Display Point Names ‘&‘

23 Comporents
[ Resurfacing (Miling, Overby
= PPM EXHIBIT TYP-5
7= SWITCHES

‘=l Conidor Templates
f=q RRR38 |
> SRE1

1 End Conditions

[Z] Linear Templates

[ Surface Templates

L¥-0

[ »

4
Lbrary  Active Template |

Note

Display All Compenents

LT SWITEMWITCH 1 RT. SRNTEMITCH1

R _BOFBREAK

RIAT BLABREAR BOT
-RT_PVT_BORYOUTT

AT_PERIRAERERERTHE GFROUT

LT_PVT_BORYCDIT
LT PSHIGRRE ; 5
LT PSHLOR, OR QT Er ‘B
L?UPSHLDF&‘%SS%@%%Z?#}J'ER BOT_DUT
PSHTBEPNRR SR RRRENGR NN TGP GUT
LT-PSHLDR_RCLLOVER BASE, BOT_OUT

T R_RO NER
| ETPRBHRREASBEERDR 8ET oUT L

LETPRYTERBSE BRASE GRITT (R

BT PRV BBSECRERT BT 00T T

RT_PSHEIR R MER BER S Ver ou
AT AR 2% PO R BRRRCER NI ToP O

BASE_BOT_OUT
FATPSEN DFR BREEEBEATO 0T "oU

FDOT Roadway Design and 3D Modeling

The switch template consists of two simple components left and right of the centerline. A label has
been assign to the horizontal constraint value. Also, display rules have been created for when the
value is 1,2,3,4, or 5. By assigning one of the rules to a component, the display of that component
and all related components can be controlled based on the value of the switch.

©2016 FDOT 9-7



Chapter 9 DETAIL MODELING - Add a Component Switch to the RRR98 Template

» Create a Parent /Child relationship of all the Left side components.
1. Open the Component Properties dialog for the Left Cut Component.

a. Set the Parent Component by using the “pick icon” J , select the LT_PvtOut.

Note Use the wheel to zoom into the Left Widening LT_PvtOut component or select it from the list

Mame: LT 1:6CU

Use Name Ovemide: LT CcUT
- Close
Description:
-_< Previous
Feature Definition: Slopes
= -_Next >
Parent Component: T PutOut )
e

Display Rules:

[ Exclude From Top/Bottom Mesh

End Condition Properties
Target TyPe: Terain Model v | Prorty:

Temain Model: - <Actives [ Benching Court: |0

o Latum

Horizortal Verical
0.000000 Rounding Length  0.000000

b. Choose Apply and Close the Component Properties dialog.

c. Repeat this procedure for the Left Fill, and Left Shoulder components. The Unpaved Shoulder
and Base components should already have a parent relationship which can be used.

2. Use the Active Template Tab to view the Component Relationships to the LT_PvtOut.

-] Points
=21 Component

*

m

Bz LT_ShldrPyvtOut
.tz |T_PviBaseBEdOut
--Bezg | T_ShidrBaseOut
-...hegy LT_UPShidriout

- Bamg LT _PwtOverbuild

Rone | T DhdiThsmd—nr

ltem Value
Name LT_PwtOut
Description

Feature Defintion  PavementAsphalt

Included in Top/B... True
End Condition False

Librany || Active Template

Prewview-
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DETAIL MODELING - Add a Component Switch to the RRR98 Template Chapter 9

3. Inthe Active Template Component List, Right click on the LT_PvtOut Component and uncheck the
Display option,

4. All of the left side components should turn off, Right click on the LT_PvtOut Component and toggle
the Display back on.

5. Inthe Active Template Component List, Right click on the LT _PvtOut Component and choose Edit.
6. From the Component Properties dialog, Select Edit on the Display Rules: field

Name: LT_PwtOut #| Apply
[[] Use Mame Ovemide: [T Pwout
- Cloze
Description:
-< Previous
Feature Definition: [Pavemerrt.ﬁsphaft v]
exd =
Parent Component: [ v] ﬂ
) . S Help
[ Exclude From Top/Bottom Mesh Close Shape

e, A

a. Select the Template Display Rule LT_SWITCHLI1 rule from the list

b. Build the Conditional Expression NOT LT_SWITCHL1 by clicking the NOT button and then
Selected Rule button

Conditional Expression for LT_PvtOut Component
NOT LT_SWITCH1

(o] Cor JGor) i ) () (Goeanaid)

Template Display Rules e

MName Type Expression
LT_SWITCH1 Horizortal LT_SWITCHT - LT_SWITCH
1T CVANTEL Y L[ PSP | 1T CIUANTSL A 1T CVRNTE

c. Choose OK, then Apply, then Close to save the display rule to the component.

Note Adding the rule NOT SWITCH1 is telling the template left side “Not To Display If The Horizontal
Distance Of The Switch Is The Value 1

7. Choose Close and Yes to save change to exit the Create Template dialog.
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Chapter 9 DETAIL MODELING - Add a Component Switch to the RRR98 Template

8. Use Corridor Modeling: Synchronize Template tool;

fﬂ Corridor Modeling = A

a e V) N D&
| o B 2NN [ @
T EEEEWY &

RSr o7 K 3 o TRl 4

"\./'H.f R

T © || - (€8 € 1 Ygg

] ’1 Synchronize Template
M -

9. At the prompt, select the BL98 Template boundary. The corridor will re-process with the updated
RRR98 template.

» To implement the Switch, Add the Parametric Constraint

1. Use Corridor Modeling, Create Parametric Constraint;

fﬂ Corridor Modeling = A

@ e N N A=

v |t o HAEN [ @
B @ W % % “LEreate F'arametrlc Constraint
T W

T © s (i - T € 1 g
Y A C

a. Atthe prompt, select the BL98 Corridor boundary.
b. Snap to the SW Radius for the Start Station.
c. Snap to the NW Radius for the End Station.
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DETAIL MODELING - Add a Component Switch to the RRR98 Template Chapter 9

d. Pickthe LT_SWITCH Constraint Label from the list.
e. Enter 1 for the Start Value.
f.  Enter 1 for the Stop Value.

( '
) Create Parametric C.. E@Q

Lock To Start &

] Start 31=42 B0 R1
Lock To End &
] Stop 33+50.80 R1

Constraint Label LT_SWITCH El
Start Value 1.000000
Stop Value 1.000000

L= A

g. The corridor will re-process with the updated RRR98 Template.

2. The left outside components of the BL98 corridor are now turned off though the limits of the intersection.
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Chapter 9

Exercise 9.3

Constructing Vertical Profiles from 3D Model Elements

DETAIL MODELING - Constructing Vertical Profiles from 3D Model Elements

This exercise calculates a Curb Profile between the two EOP Lines, from which it is constructed, in order to
construct the Intersections Corners. However, first it’s necessary to add the Model Line Profiles back onto the

2D elements.

IMPORTANT FDOTSS4 — with the MR2 release, we have implement 2D Lines from the 3D model. In
Project Explorer change the PavmentAsphalt_pm feature property to True as shown below. Then re-
process each corridor to see the resulting construction lines. These lines have profiles and can be used in
lieu of the steps outlined in the exercise.

'@ Project Explorer

o | =]

Fle: | Uity Model | ) Survey | 2 Givi Model | ¥ Civil Standards [« [ » |

.

Civil Standards

{fl DSGNRDD1.DGN, Defautt
Civil Cells

Design Standards
Feature Definitions

FIVINILRLT

I Project Settings
-8 Temain Fiters

Conmidor Components
Conmidor Lines(30)
Bottom_pm

" Curb_pm

" CurbBase_pm

" CurbFlowLine_pm
" Cut_pm

" Driveway_pm
Fill_pm

" MedianCrown=pa
F‘avememkphahjm
" PavemertBreak_pm
PavementCrown_pm
 PavementMiling_pm
" Railing_pm

" ShoulderBase_pm

" ShoulderPavBreak_pm
"/ ShoulderPaved_pm

" ShoulderUnpavBraak_pm
" Sidewalk_pm

" TemplateMisc_pm
 TemplateNullPoint_pm
 TrafficSeparator_pm
Plan{2D)

Temain Display

m

9-12

1.

=1hE &3
=%
i@ PavementAsphal_pm

Feature Definitiol\ -~ General -~
MName Prefix \. Asphalt_pm ‘ ‘ Description ion Data
Extended \ ~ Survey ~
Model ault Is Survey False
Last Modified 10K19/2016 8:43 AM Native Style
Locked Unls Alpha Codes

Numeric Code 0

Default Zone 1

Terrain Model Atfribute  Not Set
Linear Default Settings -~ Plan -~
Automatically Create 30 Elements Auto Annotate False
Corrider Template Auto Export False
Terrain Model Feature Type Break Line Native Style
Create Template Geometry True - Element Template Coridor Point Features\Consl
Profile -~ Intersected Profile -~
Auto Export False Native Style
Native Style Element Template Crossing Feature Points\inter
Element Template F (2D\F |_pri\Mis
Projected Profile ~ Cross Section ~
Native Style Native Style
Element Template F (2D)\F |_pri\Mi Element Template Crossing Feature Points\T:
3D -~
Native Style

Element Template

Comidor Point Fﬂu&s\PavJ

Use the Vertical Geometry, Project Profile by 3D Element tool.

HH vertical Geometry

Q

BB s - e (R P AV 12

= - A

W

N

E [ | |5 O

v WY P Do

L L [ = = |RY

| o+ il maoa

©2016 FDOT

| Profile By 3d Element
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DETAIL MODELING - Constructing Vertical Profiles from 3D Model Elements Chapter 9

2. At the prompt select plan Line PavementAsphalt(EOPA).

Locate Element To Profile

3. From the Model, select the PavtAsphalt_pm Line representing the outside RRR98 EOP in the Model.

—

Locate 3D Element Defining Profile

RRR98: LT_RT_PVT_EOP_OUT

Level: PavtAsphalt_pm

FDOT Roadway Design and 3D Modeling ©2016 FDOT 9-13



Chapter 9 DETAIL MODELING - Constructing Vertical Profiles from 3D Model Elements

4. Repeat for all 4 lines shown below.
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DETAIL MODELING - Construct 3D Radius Lines Chapter 9

Exercise 9.4  Construct 3D Radius Lines
1. First: Use the Horizontal Geometry Simple Arc tool to create new Construction Line Blue Dash
features between the two PavementAsphalt EOP edges on both corners. Use 110° and 60.

Note Note that these will be used to help create automatic profiles for the 3D lines on the Radii.

Trim'Extend  Mone N Trim/Extend  None
V| Radius :

: ¥| Radius
Loop 5

Feature

.
- A Feature
Feature Definitio ConstLinesBlueDa: A '

o Feature Definition(” ConstLinesBlue Da
Name Constlines 3 F

Name Constlines

2. Use Vertical Geometry, Quick Profile Transition tool.

HH vertical Geometry a8

W[~ 7

—rs

.3

E |~ @ & B

R W A [\ | [
AL 18 = = =2

In 'r| Quick Profile Transition |

Quick Transition Method Parabolic

Feature

MName NWEOQP

Element Template Mone

Quick Transition Method
Quick Transition Method [=]
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Chapter 9 DETAIL MODELING - Construct 3D Radius Lines

3. Accept the Parabolic Quick Transition Method, enter SW_EOP-Pr and select the construction line
Radius Line create from above. A 3D element should display.

4. Open the Profile View for the SW EOP Curve Radius.

B View 3, Profile - SWEOPA41 = ECh <"
Ed-AQRQRHEBE MG H| e

-

new profile created

e g
e L T e
i e
-
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DETAIL MODELING - Construct 3D Radius Lines Chapter 9

5. Repeat the same steps above to create a Profile for the NW_EOP-Pr Line.

.

B View3, Profile - NW EOPA =N EEh <
B~ AQRHEBEE NEE H| e

-

create the NW EQOPA
profile

ﬂ--;

—_———————— -
i

create this 3D
element
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Chapter 9 DETAIL MODELING - Construct 3D Radius Lines

6. (Alternative to using the Parabolic Option) Follow the next steps.
a. Open the Profile Model of the Radius Element.

b. Use Vertical Geometry, Profile Intersection Point tool.

HH vertical Geometry BEEE A
Q BB [ [ [ [2 [0 jow]| 2
- ~ | Profile Intersection Point
[y al i Y AN
El— & |60

c. Select the NW PavementAsphalt(EOPA) Radius Line as the Element to Show Intersections.

Locste Element to Show Intersection

Fillet: EOPAZE
Feature: Pavementisphalt(EOPL)
Active Profile: Nw EOPPr

Level: Pavtisphalt

DDE FEATURE

Attribute = FOIPA

d. Select the Right SR61 EOP and Right Turn Lane PavementAsphalt(EOPA) Lines respectfully.

pick these two line

Locate Element Which Intersects
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DETAIL MODELING - Construct 3D Radius Lines Chapter 9

e. Two white location points will display on the Profile View.

B View 3, Profile - EOPAZ2G EI@
G- AQREHEBE OBL|H| s

f. Use Vertical Geometry, Profile Line between Points tool and snap to the two Intersection
Points on the NW Profile View.

g. Select the new Profile Line. Select the Set Active Profile from the Context Menu and the 3D
Line will display.

create this 3D
element
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Chapter 9 DETAIL MODELING - Construct 3D Intersection Limit Lines

Exercise 9.5 Construct 3D Intersection Limit Lines
1. Use Horizontal Geometry, Line between Points tool.
a. Use the Feature Definition ConstLinesGreenDash.

b. Construct a line perpendicular to the Traffic Separator lines and ends at the Radius EOP across
both Roadways left and right.

07 Line e =

Distance 31.500000
Line Direction 00°00°00"

Feature -~

Feature Definition  ConstLinesGreen Dalel

Name Constlines

FON

2. Use the Vertical Geometry, Open Profile Model and select the newly constructed line.

B View3, Profile - Constlines25 = lFE ==
2-%-|AQQ REHBEE O
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DETAIL MODELING - Construct 3D Intersection Limit Lines Chapter 9

3. On the Profile window, hold down the last icon until a drop down menu displays.

a. Select the Quick Profile from Surface command.

' B View 3, Profile - ConstLines20 EI@
B-%-AQQRMHEBE x| b

Quick Profile From Surface |
Profile Line Between Poirts
Profile Line To Bement

Profile Line From Elemert
Profile Line Between Elements
Profile Curve Between Poirts
Profile Curve To Hlement

Profile Curve From Blement
Profile Curve Between Hlements
Profile Complex By Elements
Profile Complex By VPI

Define Profiles By BestFit

Profile Insert Curve

Profile Reverse Transition

UH TRERE>RBRPAREFIE R
M S D D KD 1 I e e e =

(=]

pen as ToolBox

Locate Refer: Surface

LT_PuiOut.
Level: PavtAsphalt_px
g

c. Thenselectthe LT _PvtWideneln Surface.
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Chapter 9 DETAIL MODELING - Construct 3D Intersection Limit Lines

d. Continue to add the TSWidenlIn Surface.

Locate Reference Surface
TSLWidenln
Level: PavtAsphalt_px

e. Data point to accept.

" m View3, Profile - Constlines20 el E- | ]
4~ A IRHBE MBS

these three
lines appear

4. On the Profile window, hold down the last icon until a drop down menu displays.

a. Select the Profile Complex By Elements command.

B View3, Profile - Constlines20 [f=e- =
- 4] QREBE M= R S| |

Guick Profile From Surface
Profile Line Between Points
Profile Line To Element

Profile Line From Element
Profile Line Between Elements
Profile Curve Between Points
Profile Curve To Element
Profile Curve From Element
Profile Curve Between Elements
Profile Complex By Elements
Profile Complex By VPI

Define Profiles By BestFit
Profile Insert Curve

Profile Reverse Transition

DM = (0 2 ke e 1 e o e e

Open as ToolBox
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DETAIL MODELING - Construct 3D Intersection Limit Lines Chapter 9

b. At the prompt, select the first segment and data point to accept Profile.

B View 3, Profile - ConstLines20 IEIIEI-
B-E-AQRQREHEBE OB N

Accept Complex

5. Use Vertical Geometry, Set Active Profile.

| TEISITRNL SEET

this line will
View 3, Profile - ConstLines25 o || E R appear

G- ARQREHBE NDE| H| .

create complex
profile line
between points

Current Active 30 Linear Element: Constlines25
By Profile
Level: Default
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DETAIL MODELING - Construct 3D Intersection Limit Lines

6.

Repeat these steps for the other Intersection Li

iew 3, Profile - ConstLines26

A} RE BB

r g M & B |

’v

>

7.
the NW corner of the Intersection.

mit line.

l

A
!

/7 this line will
v appear

Current Active 3D Linear Elernent: ConstlLines2
By Profile
Level: Default

Construct an element across the Right Turn Lane from the EOP to the ML line at the Radius Point on

Surface tool and select the Right Turn Pavement

a. Use Vertical Geometry, Profile from
Component.
b. Use Vertical Geometry, Set Active Profile.

ofile - ConstLines27

AQQRMEBE OBL| K .

9-24
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DETAIL MODELING - Construct 3D Intersection Limit Lines Chapter 9

8. Repeat these steps to create the 3D line on the opposite side.

|l

Lines36 o [ £
R EE O)EE| -

~

o

» Add Profile to Traffic Separator Lines in Plan

1. Open the profile view for the Traffic Separator line

2. From the profile view, select the Vertical Geometry, Quick Profile from Surface tool.

B View 3, Profile - TS TYPET4FTS

G- ARQREHBE ML | -

0 -

Quick Profile From Surface |I
Profile Line Between Points
Profile Line To Element

Profile Line From Blement
Profile Line Between Elements
Profile Curve Between Points
Profile Curve To Blement

Ao~ - -

LI o I T B E R R R B

3. At the cursor prompt, select the pavement surface, TSWidenT1OptlIn, in the 3D model, view 2.

Locate Reference Surface
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Chapter 9 DETAIL MODELING - Construct 3D Intersection Limit Lines

4. Repeat this for the opposite Traffic Separator element.

5. Construct lines using Horizontal Geometry, Single Offset Partial on either side of the Traffic Separator.
Use .08 feet Offset, 1 inch.

a. Start the line at the end of the Traffic Separator and Stop at the Intersection Limit
Construction line.

b. Repeat this for both sides.

create lines here

6. Use Vertical Geometry, Project Slope from Element tool.

HH vertical Geometry =R A

QHH 5 - e (DD |2
W o

El— & 56,
R A 2 (o | [
1L L E=D= 2y

& Terrain Model | Profile By Slope From Element l v
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DETAIL MODELING - Construct 3D Intersection Limit Lines Chapter 9

a. Project a Profile on the lines from the Traffic Separator Profile. Use 0% Slope.

b. Select the line and select Set Active Profile from the Context Menu.

floco s @&
Bler=a9 n

create these
lines

. Profile - Constlines29 EI@

- A QHEHBE OGS

*v

Level: Default

7. Delete the Traffic Separator Nose Radius Line. It will be created later with a Civil Cell.
Note It may need to be dropped from the Left Turn with TS Civil Cell.
8. Construct a Line across the Traffic Separator Offset Ends.

9. Create a Profile from the elements that intersect. Set the Profile as active.

w 3, Profile - Constlines35 = | = || 2

v AS QREHBEER

@ B B | 7| e,

profile

between
points
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Chapter 9 DETAIL MODELING - Construct 3D Intersection Limit Lines

10. Create a 3D Line across the Intersection from Radius to Radius. This will close the Intersection
boundary.

11. Construct the Line across the Intersection.

Hint  Use Single Offset Partial for the Horizontal, and Profile from Element for the Vertical.

create this line
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DETAIL MODELING - Build the Intersection Terrain from 3D Elements Chapter 9

Exercise 9.6 Build the Intersection Terrain from 3D Elements

1. Use Terrain Model, Create from Elements tool.

4 Terrain Model S

%A AR A&
w A & @ % /E_rfete From Elements |
I Y

R A R B8 3 4

2. Select the 3D Model View to set active and using the Project Explorer, Civil Standards: Turn OFF
the Corridor Components and Corridor Lines(3D)

|iject Explorer

|"E‘g Links | [ File | ) Survey | < Givil Model | “# Civi Standards
U Civil Standards

=Ml DSGNRDO1.DGN, Default

-8 Civil Cells

4 Design Standards

-
=
3
=
E

L1

R
a’

o

c

a

[wr)

4,

=

[=]

G

Comidor Components
Comidor Lines{30)
F‘Ian{ED}

] E F‘mjeu:t Seftings

-p8 Temain Fiters

-8 Utility Fitters
- Librares
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Chapter 9 DETAIL MODELING - Build the Intersection Terrain from 3D Elements

3. Select the boundary elements for the intersection.

_, Create Terrain I'.‘!l::del...]. = ﬁ

Feature Type Boundary
Edpe Method MNone

Feature

Feature Definition CimProposed

Naime DTM_INT

4. Data point to accept.

\','”J‘, Add/Remove Te... =

2
Terrain Model El
EY

Feature Type Break Line
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DETAIL MODELING - Create an Intersection Pavement Surface Chapter 9

Exercise 9.7 Create an Intersection Pavement Surface
1. Use 3D Geometry, Apply Surface Template.

2. Select a Pavement Surface Template from the Template Library and select the Intersection Terrain to
create pavement.

DTMTemp Surface Template
Level: Default
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Chapter 9 DETAIL MODELING - Traffic Separator Nose

Exercise 9.8  Traffic Separator Nose
1. To add the Traffic Separator Nose use the Civil Cell.
2. Select the TSNose Civil Cell.

3. Select the Right Side of the Traffic Separator in the Plan View, then select the Left Side of the Traffic
Separator.

4. Change the Reference Line direction arrow on both elements until it fits on the lines.
5. Data point to accept.

o

Civil Cell Name TSNose

Locate Reference Element:
TrafficSeparatorTypel(4 feet) (12)
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DETAIL MODELING - SR61 Corridor Clipping References Chapter 9

Exercise 9.9 SR61 Corridor Clipping References
1. Use Corridor Modeling, Add Clipping Reference tool.

Tl corridor Modeling

4 ) 1 S
W[ o H 12\ L2 @
B mwY @

RV O W 3% Gl K e d
T ;@:;&&m&&-@ﬂﬁ I Yf

Al AL Q0= | Add Clipping Reference |

Lot

H
i
n
>

2. Atthe prompt, select the SR61 Corridor handle.

Select Corridor To Be Clipped

Corridor: SRE1

Plan: SR&1

Profile: SRE1-PR1
Level: CorrHndIStg2_dp
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Chapter 9 DETAIL MODELING - SR61 Corridor Clipping References

3. Select the Intersection Terrain Boundary.

pick on the
intersection DTM

P Terrain Model: DTMTemp
B Triangles

Elevation 34 6795171

Slope 1.67
Aspect 314.57
Level: DTM

4. Reset and the SR61 Corridor begins re-processing.

SR61: TS_COMP_BEG

Level: Constlines

T

5. Repeat to add the Intersection as a clipping reference for RRR98 Corridor.

Note Later the shoulders and sidewalks will be clipped with the Linear Templates added around the radii.
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DETAIL MODELING - Model Curb and Sidewalk Around Radii Chapter 9

Exercise 9.10 Model Curb and Sidewalk Around Radii
1. Use the Corridor Modeling, Create Template tool.

EH{ Corridor Modeling iR =M

affle VY A S
w 8, | H o - |£.| N[ Create Template |
TRt EwY &

R o7 K& %,ffl‘—'lr“z'l e

R

2. Openthe SR61 Template Library.

B | Create Template

File Edit Add Tools

Template Librany: Cumrent Template
ﬁ C:'e'projects 22049555201 \roadway S RE1 itl L SRE1
== Point Mame List Description:

[ Components
[ Comidor Templates
[ End Conditions

8] Linear Tempiates|

[ Surface Templates

3. Navigate to the Linear Templates folder.

5 Che'projects' 22045555201 roadway 22 0455¢
'=Z Point Name List
[ Components
[ Comidor Templates
[ End Conditions
&
={ Curb Type E Inside
>=-< Outsu:le Lane wf F‘aued Shu:uulu:ler

4. Double click on the Outside Lane w/ Type F Cub Template to make active.
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Chapter 9 DETAIL MODELING - Model Curb and Sidewalk Around Radii

5. Make the following edits:
a. Delete the Pavement and Base.
b. Change the Template Origin to the Curb PVT_EOP_OUT Point.
c. Change the Utility Strip Horizontal Value to Zero.
d. Change the Back of Sidewalk to 6 feet.
e. Add the 6:1 Fill and Cut End Conditions, set the End Points to Infinite.

- S

B ' Create Template

File Edit Add Tools

Template Librany: Cument Template Display ‘ Close |
=5 C\e'\projects' 22049555201 \roadway" 220495  Name Outside Lane w/ Type F Curb @ Components Constrairts 7|
"= Point Name List ) ! Help
== Description: Display Poirt M
=] Components pt isplay Poirt Names
[] Display All Components

[ Conidor Templates
[C7 End Condtions
3 Linear Templates
= Curb Type E Inside
3= Outside Lane w/ Paved Shoulder
B Outside Lane w/ Type F Curb
(7 Surface Templates

4 mm 3

Library  Active Template I . ) By

Preview:

6. Close the Create Template dialog and click Yes to Save Changes.
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DETAIL MODELING - Model Curb and Sidewalk Around Radii Chapter 9

7. Use 3D Geometry, Apply Linear Template tool.

1
i
0
>

= 3D Geometry

IS+ [
w S iEQ Apply Linear Template |

a. At the prompt select the SW_EOP Construction Radius Line in the Plan View.

Lock To Start

Start Station 0.000000

Lock To End

End Station 0.000000
Exterior Corner Sweep &ngle  1°0°0"

Mirror

Reflect v

Template Outside Type F Cub =)

Design Stage 1 Lines and Components El

Fillet: S\WEDPA41
Feature: PavementAsphalt(EOPL)

dl L evel: PavtAsphalt
DOE FEATURE
Attribute = EOPA
ADOHOC ATTRIEUTE

Pavement Thickness (Numeric) = 0.250000
Base Thickness (Mumeric) = 1.000000

Base Extension \Width (Numeric) = 0.333000
Extend Base Under Curb (String) = N
\widen_Side (String) = LEFT
ECP_‘widening_Profile (String) = none

b. Select Alt down arrow to select the Template, Outside Type F Curb. Data Point to accept the
Template.
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Chapter 9 DETAIL MODELING - Model Curb and Sidewalk Around Radii

c. Select Alt to lock the Start Station and data point to accept.
d. Select Alt to lock the End Station and data point to accept.
e. Data point to accept the Reflect Orientation.

f. Data point to accept the Exterior Corner Sweep Angle.

sidewalk and curb

8. Repeat the steps above for the NW EOP Construction Radius Plan Element.

;}

Hint  To turn off the Blue triangles, toggle off the DTM and DTM Triangles.

9-38 ©2016 FDOT FDOT Roadway Design and 3D Modeling



DETAIL MODELING - Model Curb and Sidewalk Around Radii Chapter 9

9. Use Corridor Modeling, Add Clipping Reference tool.

Tl corridor Modeling
Qe V4 A=
Wb |4 o B~ 8NN [ @
b EwY g

R K iﬁ,r;" 57 Pl =

o R

T © s i - {66 1 Yy

AL Qo= | Add Clipping Reference |

e

n
]
n
>

a. Atthe prompt, select the SR61 Corridor handle.

‘ dd C _l___I:I_ X

Clipping Reference |Ditem

Sel;'bc:t Corridor To Be Clipped

Corridor; SRE1

Plan: SR61

Profile: SRE1-PR1
Level: CorrHndlStgZ_dp
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Chapter 9 DETAIL MODELING - Model Curb and Sidewalk Around Radii

b. Select the 2 Linear Template Boundaries as Clipping References.

c. Data point to accept the Corridor clipping.
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DETAIL MODELING - Right Turn Island

Exercise 9.11 Right Turn Island

1. For this exercise, an Island Curb will need to be retrieved from the FDOTSSA4.itl file.

Chapter 9

a. Use the Create Template, Template Library Organizer to add the Curb Type E Inside to the

project .itl file.

-

B ' Template Library Organizer l G x
Available In: Available In:
{23 Ce'projects\ 22049555201 roadway' 22049555201 il 23 CAFDOTSS4_server\GEOPAK \comidor\FDOTSS544 =« [:]
"ZZ Point Name List "ZZ Point Name List
{25 Components {25 Components el
= Curb Type E Inside |23 Barmiers & Retaining Walls P

23 Resurfacing (Milling,
=3 Miling
23 Overbuild
23 Oveday
23 Widening
== PPM EXHIBIT TYP-5
|23 Comidor Templates
23 End Conditions
[Z3 Linear Templates
23 Surface Templates

rbuild and Overay)

23 Bem

[Z7 Bridge Examples

|23 Buffer

25 Curb & Gutter
Z7 Base
= Curb Asgphaltic Concrete
= Curb Type A

M = Curb Type B

\ = Curb Type D

= Curb Type E

Curb Type F
= Curb Type F_Drop
= Curb Type RA

et Pl (1 sk

m

Preview:

Preview:

E vertical Geometry as

QI@|M b~

Use Vertical Geometry, Open Profile Model tool.

== A

L[N

|_| Open Profile

Model |

SN

R Ay
PR

FDOT Roadway Design and 3D Modeling
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Chapter 9 DETAIL MODELING - Right Turn Island

a. Select the Turn Island shape and select View 3.
HINT  First toggle off the PavtAsphalt(EOP) level

b. Inthe Profile Model View 3, select the Quick Profile from Surface command.

[ View 3, Profile - =n =N =<
R AQQIRHBE| O G|

Guick Profile From Surface |
Profile Line Between Points

Profile Line To Element

Profile Line From Bement

Profile Line Between Elements
Drmfilm (Timem Dedrnmmem Dniedn

LN LS R i S [ B

c. Atthe prompt, select the Intersection Terrain Surface DTMPrInt in the 3D Model View 2.

Note It may be necessary to tab over the surface features in intersection in order to select the terrain
element.
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DETAIL MODELING - Right Turn Island Chapter 9

d. Data point to accept. A new Profile will display.

B View 3, Profile - =] =] 3

E-4-AQQRHBRE O b

e e e o e P g e iy

Locate Reference Element

new constructed
profile from

e. Select the Profile and select Create Best Fit Profile.

B View 3, Profile - MedianLine (o[- s
G-% - AQQRHEBE OGS

|

Create Best Fit Profile
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Chapter 9 DETAIL MODELING - Right Turn Island

f.  Enter the Best fit Parameters as shown.

Best Fit Make Complex Element El
Best Fit Parameters LS

pper Envelope 0.020800

Lower Envelope -0.020300

Desirable Crest Curve Length 5000000
Desirable Sag Curve Length  5.000000

Minimum Curve Length 5.000000

Feature -~
MName Island
Element Template Profiles{ZD}\Pmpnsedjr\GladeIJneEl

g. Create the Best Fit Profile, select the new Profile and select Set As Active.
h. The Island Boundary is created in the 3D Model.

island boundary
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DETAIL MODELING - Right Turn Island Chapter 9

3. Use 3D Geometry, Apply Linear Template tool.

= 3D Geometry
A2« [z
W ;.E{r}.; ﬂ Apply Linear Template |

=
]
([
>

a. Atthe prompt select the Island Line in the Plan View.

Locate Element To Apply Template

Complex Element: MedianLine

Active Profile: |sland
Level: Miscellansous(

b. Select Alt down arrow to select the Template, Curb Type E. Data point to accept the Template.

=+ Che'projects 22045555201 roadway" SRE1 itl
= Components

- RRR

M Cirh Type E

- Curb Type F

- Curb Type F_Drop

- Dirop Curb

- RampCurb

- RampSW/

- Traffic Separator Mose

- WariableMedian

+]- Comidor Templates
- End Conditions

- Linear Templates

¥ Surface Templates
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Chapter 9 DETAIL MODELING - Right Turn Island

c. Select Alt to lock the Start Station and data point to accept.
d. Select Alt to lock the End Station and data point to accept.

e. Data point to accept the Reflect Orientation.

f. Data point to accept the Exterior Corner Sweep Angle.

g. To create the sod within the Traffic Island, Use Terrain Model, Create from Elements tool.

#™ Terrain Model 1

R A & Ty
w Ay ﬁ @ £y 9 Create From Elements |

HePpn-y ¥ B

R AR [ o 4
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DETAIL MODELING - Right Turn Island Chapter 9

h. Create a Terrain from the 3D Top Back Curb line.

# View 2, Default-3D =N =
B~ ARIRBII|NELE|FAVRE

"} Create Terrain Model.

Feature Type Boundary
Edge Method None

Feature

Feature Definition DtmProposed

Name DTMPr_lsland

Clip the

4. To change the Terrain Triangles display,
a. Select the new Terrain DTMPr_Island and open the properties, Element Information dialog.

b. Change the level for the Calculated Features Display Triangles to ShidUnpaved_px and change
the class from construction to primary.

i '
(i) Element Information I. — ﬂ_hj

=% Selection . -
=4 Temain Model| DTMPr_lsland I ‘:‘
B—ﬂ-} Calculated Features Display i
Copt
ices -
General -~
Display —
w@. =
Color
Line Style ByLevel (0)
Weight ByLevel (2)
Transparency ]
Thematic Display Style E‘ From View
| Material L
Description Temain Model: DTMPr_lsland
MName DTMPrint 1
Level DTM_px
Color E= Bylevel (1)
Line Style E= Bylevel {0)
Wnieight =3Byl evel (0)
Class
Template
Transparency 0
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DETAIL MODELING - Right Turn Island

5. Use the Terrain Model, Create Clipped Terrain Model tool

& Terrain Model

YT IY
th

S

il

AR &

[ Create Clipped Terrain Model

T L Ve TR

ey V. R
RARES TS

—
B View 3, Pre

R

a. Select the Intersection terrain and then select the island boundary and choose Internal

948 ©2016 FDOT
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DETAIL MODELING - RRR98 Corridor-Build Intersection Terrain at School Entrance (On Your Own) Chapter 9

Exercise 9.12 RRR98 Corridor-Build Intersection Terrain at School Entrance (On Your Own)
1. Create a shape boundary of the perimeter of the School Driveway pavement to be resurfaced.
2. Use the Create Clipped Terrain Model tool to model the existing pavement.
3. Add a surface template to the Terrain in step 2.
4

Use the RT_Switch parametric constraint along the RRR98 corridor to remove the overlap components
between radius points.

o

Add Key Station to near the radius points to create complete components
6. Use Linear Template around the Radii to construct the curb, sidewalk, shoulder, etc.

a. Setthe Template Origin and Pavement Point as shown

Project to Surface constraint
and
Horizontal Feature
PavementMilling(ML)

Template Origin
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DETAIL MODELING - SR61 Corridor-Build Intersection Terrain at Friendship Road (On Your Own)

Exercise 9.13 SR61 Corridor-Build Intersection Terrain at Friendship Road (On Your Own)

9-50

1.

2
3
4.
5
6
7

Drop the Complex Chain that makes up the EOP Lines and Radius.

Create a Corridor Model of the Friendship Road.

Edit the Template Drop and delete all Components outside of widening.

Project Profile to Element on the Curve EOP lines <OR> Quick Profile from Surface.
Construct a Profile from the Projected Surface Lines for the Curve Radii.

Use Linear Template around the Radii.

Create a Terrain from the 3D elements.

Hint  For the Traffic Separator to Pavement Crown Cross over median, set the LT_XOVER_CTL,

RT_XOVER_CTL, and PVT_CROWN Properties as shown;

ol Y
Point Properties @
Name: LT XOVER CIL > 4| [ Aoply
[7] Use Feature Name Overmide: LT_¥0OVER_CTL m
Feature Definition: [ ,] _
-f. Previous
[7] Superelevation Flag
Meat =
Altemate Surface: -
.
Member of:
LT _¥OwerPwt
Constraints
Constrairt 1 Constraint 2 i
Type: [ Horizartal - ] [Slope - ]
Parert 1 [LT_PGLIN | #| [LT_PeLIN -| #|
o Rollover Values. ..
Value: 0.100000 (=] 200% (=]
Label: - -
Horizontal Feature Constraint:  PavementSlopeBreak -

Range: 12000000
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DETAIL MODELING - SR61 Corridor-Build Intersection Terrain at Friendship Road (On Your Own)

i Point Properties wj
Name: RT XOVER CTL - 4| [ Aoply
[ Use Feature Mame Ovemde: RT_XOVER_CTL Eloze
Feature Definition: [ v]
< Previous
[7] Superelevation Flag
Altemate Surface: -
Hel
e [ b ]
RT_¥OverPwt
Constraints
Constraint 1 Constraint 2 I
Type: [ Horizortal - ] [5|0DE - ]
Parert - (RT_PGLIN - 4| [RT_PGLIN ~| +|
o Rollover Values...
Value: 0.100000 E 20m B

Label: -

Horizontal Feature Constraint:  Pavement SlopeBreak

Range: 18000000

- Y
Point Properties ﬁ
Name: PVT_CROWN - ﬂ
[T Use Feature Mame Ovemde: |PyT CROWN
vi_ ! Close
Feature Definition: PavementBreak_pm "] -
< Previous
[7] Superelevation Flag
-Next >
Altemate Surface: -
Member of
LT_¥OwerPvt
RT_¥0werPwt
Congtraints
Constraint 1 Constraint 2 I
Type: | Horizontal - | Slope -]
Parert 1:  [LT_XOVER_CIL -] 4| [_xovErcT -] +|
O Rollover Values...
Value: = S{LT_XOVER_CTL}FS(RT_ B =/S[RT_XOVER_CTL}S(LT_ E]
Label: - -

|| Horizontal Feature Constraint;

FDOT Roadway Design and 3D Modeling ©2016 FDOT
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9-52

—

Value Equation @

DETAIL MODELING - SR61 Corridor-Build Intersection Terrain at Friendship Road (On Your Own)

= §(LT XOVER_CTL)-(RT XOVER. = 10.9
[Hurizunml Difference - ]
|LT_xovER_cTL - ﬂ
|RT_xOVER_CTL -| #]
Multiplier: 0.5

L

—

Value Equation @

=($(RT_XOVER_CTL)-6(LT_XOVER_ = 0
Slope

|RT_XOVER_CTL v ﬂ
|LT_XOVER_CTL v ﬂ
Multiplier: 1

©2016 FDOT
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10 3D MODELS FOR CONSTRUCTION

INTRODUCTION
This chapter will provide detailed instructions for producing the specific output files used by contractors for
Automated Machine Guidance (AMG). Specifically:
e Controlling Geometry Files
e 2D CAD files
o  Existing and proposed features

e  Existing and proposed surface model files

3D DELIVERABLES SUPPORTING AMG FOR 3D PROJECTS

File Name (put in

\3DDeliverables) Description

Alignments and Profiles

Individual alignments(including profile) are extracted from the

AMG-ALGNXX.xml \Roadway\DSGNRD file

2D Existing Survey (Note these are being considered to merge into one survey file)

AMG-2TOPOXX.dwg/dgn 2D proposed existing Topography extracted from the .\Survey\TOPORD file

AMG-2DREXXX.dwg/dgn 2D proposed existing Drainage extracted from the \Survey\DREXRD file

AMG-2UTEXXX.dwg/dgn 2D proposed existing Utilities extracted from the \Survey\UTEXRD file

2D Proposed Break Lines

AMG-2DSGNXX.dwg/dgn 2D proposed Roadway design extracted from the .\Roadway\DSGNRD file

3D Proposed Break Lines

AMG-3DSGNXX.dwg/dgn 3D proposed Roadway design extracted from the .\Roadway\DSGNRD file

3D Existing Surface

AMG-3SURFACEEXXX.xml | 3D existing terrain to be exported from the \Survey\GDTMRD file

3D Proposed Surface

AMG-3SURFACEPRXX.xml | 3D proposed finish terrain to be exported from the .\Roadway\AMGMRD file
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Chapter 10

EXERCISE OVERVIEW

10.1 Exporting Alignments

10.2 2D Proposed Planimetrics
10.3 Exporting 3D Break Lines
10.4 Exporting Proposed Surface
10.5 Exporting Existing Surface

Exercise 10.1 Exporting Alignments

You can export Alignments and Profiles directly from the elements in the DGN file.

1.
2.

10-2

Open the DSGNRDxx.dgn.

Select and hover over an Alignment. Select Horizontal Geometry Report from the Context Menu.

In the Bentley Civil Report Browser select the Civil Geometry > AlignmentsToLandXML.xsl report.

3D MODELS FOR CONSTRUCTION - Exporting Alignments

Horizontal Geome

(] Bentley Civil Report Browser - C:\Users\rd964\rd\)'-‘~ppData\LDcal\Temp\RPTSrrmemm.xmn

File Tools Help

|C “\ProgramData“BertleyCivil"Report Browser'8.11 hen’.

(] Bridge

1 Civil Temain

— CivilGeometny

-Ai FDOT_CurveDataTable xsl

~4{] Horizontal Alignment Area xs|

4] Horizontal AlignmentCheck Integrity sl
~Ai] Horizontal AlignmentControlLine Data Table xs|
~4f] Horizontal AignmentCurve Data Table xsl
4] Horizontal Alignment Interval}YZ xs|
-Ai] Horizontal AlignmentLength xsl

~4{] Horizontal Alignment Review xsl

4] Horizontal AlignmentReviewASCIl xsl
-Ai] Horizontal Alignment ReviewWith Pl xs!

»

©2016 FDOT

<?xml version="1.0" encoding="isc
<LandXML =zmlns="http:/,/www.landxr
<Units>
<Imperial arealUnic="acre" linearl
</Unics>
<hlignments>
<Blignment name="SRE1" length="2"
<CoordGeom name="5R6l" state="prc
<Line length="50.000000037" dir="
<Start code="POE">
402583.597205489 2006936.977841:
</5tart>
<End code="PI">
402608.603926780 2006893.680452:
</End:>
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3D MODELS FOR CONSTRUCTION - Exporting Alignments

Chapter 10

4, Select File > Save As

a. Navigate to the 3DDeliverables directory. If it doesn’t exist, use create new folder.

- '1
H Save Az ﬁ
Savein: | 22045555201 - G@I
I Marme “ Datemol Create Mew Folder l“
ket | _meta info 10/18/2016 6:49 AM  File fol
Recent Places 77 3ppeliverables 10/24/2016 8:30 AM  File fol =
- T 10/18/2016 6:49 AM  File fol
) arch 10/18/2016 6:49 AM  Filefol
Desktop . brinspect 10/18/2016 6:49 AM  File fol
S ! cell 10/28/200911:16...  File fol
b. Enter the File name: AMG-ALGNSR61.
c. Select XML File (.xml) as the Save as type.
d. Click Save.

5. Repeat for the AMG-ALGNBL98.xml

Recent Places

Desktop

L] i
Libraries

A

€

i B
h Save As ﬁ
Savei , 3DDeliverables - @ ¥ £ @~
M= Mame : Date modified Type
""j Mo iterns match your search.

Note: Use

UL

— — ———

the text
format

{ AMG-ALIGNSRET xaml ) -

Save

J

[ Text File (d)

Cancel

Help

e

Note

FDOT Roadway Design and 3D Modeling

This will save both the Horizontal and Vertical (Profile) Geometry.
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Chapter 10 3D MODELS FOR CONSTRUCTION - 2D Proposed Planimetrics

Exercise 10.2 2D Proposed Planimetrics

Use the MicroStation Save As command to save copies of the Proposed Design files into the 3DDeliverables
directory with AMG-2 names in DGN and DWG formats.

For example: AMG-2DSGNRDxx.DGN, AMG-2DSGNRDxx.DWG.

» Simplify MicroStation Elements

1. Open the DSGNRDxx.dgn.

2. Select the Plan View to make it active. Select Function Key CTRL F1 to open a single Plan View.

3. Inthe View Attributes, turn Off Construction elements<OR> Select Function Key F7.

4. Turn Off reference file display Tasks MERa e
. % Civil Taals - 4.

5. Turn Off levels for Baseline, CLCor'15tr., and .Scrat.ch [1 [oienoy - |E

6. Place a Fence around all Elements in the design file. o L PlaceFence

7. Enter ff=.\3DDeliverables\AMG-2DSGNRDOL. B b= :d?f”c“

<Or> use the Copy Fence Contents dialog. mj 4 Delete Fence Contents
5. Datpoit 0 ascpt. sl e
9. Verify the file is in the 3DDeliverables directory. :;:,. 28l Open Fence o Toolbor

» Save as DWG(Optional)

1. Open the \3DDeliverables\AMG-2DSGNRDO1 design file.
2. Select File > Save As from the MicroStation menu.
3. Select Autodesk(R) DWG as the Save as type.

Note There is no need to set Options on the Save As dialog
4. Verify or Enter the File Name, AMG-2DSGNRDxx and click Save.
5. Select the Units Survey Feet and click OK.

Power GEOPAK requires that the file units be accurately specified in erder for "True” scaling to be
calculated correctly when working with cells and reference files.It is not possible to infer the units
for the DWG or DXF file: "C:h\e\projects’ 22049555201\ roadway\ TEST.dwg" for the following
reason:

The "Design Center Units" option has been selected, but Design Center units are not specified in
this file.

Units:
| ‘Do not display again (Use this setting for all DWG/DXF files of this type):

S

Note The file will open in DWG Work Mode, see the blue cross hairs icon in the bottom right of the
MicroStation window

w

=T

. N
DWG Work Mode

d=1EE)
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3D MODELS FOR CONSTRUCTION - Exporting 3D Break Lines Chapter 10

Exercise 10.3 Exporting 3D Break Lines

» Prepare View for Exporting

1. Open the DSGNRDxx.dgn file. Display 2D and 3D Views and select Function Key F2.
2. Turn OFF the Reference File display for:

o GKLNRDO1.dgn
o GDTMRDO02.dgn

Tools  Settings
BBy ¢D& 0 3 40 B8 @ X Hieliode] (Boundaies v]
(0] St ¥ 3 File Name Model Description Logical Crientati
e 6 GKLNRDO1.DGN Default-3D Master model Coincide.
i 7 GDTMRDO2 DGN Master Model Coincide
4 [T} 3
Mo Nesting > | Display Overides: |
Mew Level Display: |Corfig Varable = | Georeferenced: |No hd

3. Set the Corridor Design Stage to Final.

Name SRe1
Harizontal Name SR61
Use Active Profile True

Profile Name - -
TR  FvAD), =l

4. Maximize the View 2 — Isometric Default-3D.

5. Change the View Rotation to a Top view

i View 2 - lsometric, Default-3D
Rr-@E-AQ RREHRO NEE 496

-"J 1 Rotate View

|

2 Top View
3 Front View

% 4 Right View

| 3 Isometric View

Bottom Wiew
Back View
Left View

3
5
(]
2
5 Right-lsometric View

= Open as ToolBox

6. Use the Function Key F9 to turn OFF all Component Mesh Solid elements.
7. Use the Function Key F7 to turn OFF all Construction elements.

Note Use Level Display dialog to verify remaining levels to use for the 3D breakline surface.

FDOT Roadway Design and 3D Modeling ©2016 FDOT 10-5



Chapter 10 3D MODELS FOR CONSTRUCTION - Exporting 3D Break Lines

» Exporting 3D Break Lines.

1. Fence Elements in 3D View.
2. Enter ff= .\3DDeliverables\AMG-3DSGNRDO1. Or use the copy fence contents dialog.

Tasks > X

[ & Civil Toals

O 0 & .7 [FA] s ==

Place Fence

Meodify Fence
Manipulate Fence Contents
Delete Fence Contents

Drop Fence Contents

o [ = e o e

Copy/Move Fence Contents to File

DOpen 'Fence’ as Toolbox

3. Data point to accept.
4. Verify the file is in the 3DDeliverables directory.

» Save as DWG(Optional)

1. Open the \3DDeliverables\AMG-3DSGNRDO1 design file.
2. Select File > Save As from the MicroStation Menu.
3. Select Autodesk(R) DWG as the Save as type.
Note There is no need to set Options on the Save As dialog
4. Verify or Enter the File Name, AMG-3DSGNRDO1 and click Save.
5. Select the Units Survey Feet and click OK.

(s N

Power GEQOPAK requires that the file units be accurately specified in order for "True" scaling to be
calculated correctly when working with cells and reference files.t is not possible to infer the units
for the DWG or DXF file: "C\el\projects\ 22049555201\ roadway\ TEST.dwg" for the following
reason:

The "Design Center Units” option has been selected, but Design Center units are not specified in
this file.

Urits: [ Survey Feet -]

[7]:Do not display again (Use this setting for all DWG/DXF files of this type);

Note The file will open in DWG Work Mode, see the blue cross hairs icon in the bottom right of the
MicroStation window

| D'WIG Work Mode

@ |9

Note Open the dwg file and trim extraneous elements as necessary
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3D MODELS FOR CONSTRUCTION - Exporting Proposed Surface, Chapter 10
Exercise 10.4 Exporting Proposed Surface
1. Open the DSGNRDxx.dgn file. Display 2D and 3D Views and Select Function Key F2.
2. From the FDOTSS4 Menu,
a. Select Actions > Create/Edit File and create the MODLRDO1.dgn file.
(¥ Create File/Project — Elﬂlg
Project: [E:'\e'\proiects\22ﬂ495552ﬂ1 v] Project Settings
wiork space: [FDUTSS4 v]
Control Fle: [ ROADWAY CTL -
File Group: [Hoadwa_l,l Design Files [DGM) ']
File: Type:
INTERSECTION/INTERCHANGE PROFILES a
KEY SHEET
LATERAL DITCH CROSS SECTIONS
LATERAL DITCH PL&M / PROFILE SHEET
MITIGATION AREAS
MOTIF FILE FOR PLAM SHEETS
MOTIF FILE FOR PROFILE SHEETS
PLAN AND PROFILE SHEETS
PLAM SHEET
POMD DESIGM -
POMWD XSECTIONS PATTERM LINES & SHAPES 3
PROFILE SHEETS
PROJECT CONTROL SHEETS
PROJECT LAYOUT SHEETS
PROJECT MOTES
PROJECT PROFILE L&vYOUT
PROPOSED DESIGHN
PROPOSED DESIGN MODEL
PROPOSED DIGITAL TERRAIN SURFACE MODELS il
ERMPASEN PROFIFE
Output File: MODLRDM|
Output Folder,  Roadwayh,
Seed File: fdotseed2d.dan
Seed Path: resources/seed/
Action: mdl | plotzcale;plotzcale set Apply Action
[ Create ] [ Open File ]
Active File for Open/Edit MODLRDOT.DGM
b. Click Open File and click OK.
c. Click OK on the Set/Update Plot Scale.
3. Reference the AMG-3DSGNRDO1.dgn OR AMG-3DSGNRDO01.DWG File.
4. Select all Elements.
5. Use Civil Tools, Terrain Model, Create From Elements tool.
6. Define the following in the Create Terrain Model dialog:
o Feature Type: Break Line
o Edge Method: Max Triangle Length
o Max Side Length: (Enter a number wide enough to cross your widest component)
o Feature Definition: DTMProposed
o Name: AMG-3SURFACEPRO1
7. Data point through prompts to accept settings. A Surface is created.
8. External Triangles must be trimmed.
FDOT Roadway Design and 3D Modeling ©2016 FDOT 10-7



Chapter 10 3D MODELS FOR CONSTRUCTION - Exporting Proposed Surface

9. Turn Off the DTM Level in the 2D View.
10. Use Civil Tools, Terrain Model, Change Feature Type tool.
11. Set the Feature Type to Boundary.

12. When prompted to Locate Terrain Linear Features, select the Cut and Fill Lines defining the External
Limits of the Surface.

13. When all have been selected, data point to accept changes.
» Save Terrain to Land XML file

1. Select and hover over the Surface and then select Export Terrain Model > LandXML.

&2 TnRoads DTM

&f GEQPAK TIN

& LandXML
5

Select the Terrain.
Select the Export Format: LandXML
Enter the Project Name: AMG-3SURFACEPRO1.xml

Enter the Project Description: Proposed Surface

o g~ w D

Select the Export Options: Export Both

[ ¢ . =X
\} Export Terrain Model =2

| Select Terrain ~ AMG-3SURFACEPRO{»

| Export Format LandXML {xmi) -
l

|‘ Export Options ~
| ProjectName  AMG-3SURFACEPRD!

| Project Description Proposed Suface

| Export Options  Bxport Both >

7. Save the file to the 3DDeleverables directory.
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3D MODELS FOR CONSTRUCTION - Exporting Existing Surface Chapter 10

Exercise 10.5 Exporting Existing Surface
1. Continue in the DSGNRDO01.dgn file. Display 2D and 3D Views and Select Function Key F2.
2. Turn ON the Reference file display for GDTMRDO02.

3. Select and hover over the Existing Surface and then select Export Terrain Model > LandXML.

=

&8 InRoads DTM

£ GEOPAK TIN

Select the Terrain.
Select the Export Format: LandXML
Enter the Project Name: AMG-3SURFACEEXO01

Enter the Project Description: Existing Surface

o N o g &

Select the Export Options: Export Both

Export Terrain Mode

Select Terrain GDTMRDO1 =
Export Format Land XML (i) =]

Export Options Ed

Project Mame AMG-35URFACEEXD

Project Description Esdsting Surface
Export Options Export Both El

9. Save the AMG-3SURFACEEXO01.xml file to the 3DDeleverables directory.
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